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Introduction

In this chapter:
B The Road to Office 2010
B Who Uses Office 2010?
B What's in Office 20107
m  Office 2010 System Requirements
B What You'll Find in First Look: Microsoft Office 2010

You've probably noticed that part of living and working in the world today requires that you
do many things at once. For many of us, managing multiple tasks is our normal work mode.
You prepare a new presentation for a client while you're working collaboratively with your
team, corresponding with people through e-mail, and inserting Microsoft Office Excel data—
which might be changing moment to moment—into the slides you create.

And if you're like many people, you're multitasking when out of the office, too. You check
e-mail while you wait in line for your morning coffee, or you make a quick edit to finalize a
report when you're waiting for your luggage at the airport, Or perhaps you set up a group
meeting with teammates on three continents and trade documents just moments before it
starts so that you're all looking at the same plan.

Welcome to Office 2010. Whether you work primarily in the office or on the go, you'll find
smart tools in this release that enable you to get your work done easier, faster, and more
professionally than ever. All the freedom to multitask built into Office 2010 has an upside you
might not expect: being able to work anywhere, anytime means more flexibility, which trans-
lates to higher efficiency and effectiveness. And when your work is done quickly and well,
you have more time left over for the people, places, and possibilities that intrigue you.

The Road to Office 2010

Did you know that Microsoft Office celebrated its twenty-fifth birthday in 2009? Throughout
the last two and a half decades, Office has grown and improved dramatically—partially
thanks to developments in technology, but primarily thanks to you.

It's no secret that Microsoft places great importance on customer feedback. Users all over the
world continually provide comments and suggestions through various channels. Microsoft
gathers information through extensive beta programs, market research, the help systems,
and discussion forums. Focus groups galore provide veritable mountains of data for re-
searchers, program developers, and communications people to sift through. All this feedback

xi
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comes together to provide current, relevant pictures that show which features you want and
need most in the programs you use every day. No matter where you fit on the scale ranging
from new user to power user, the new features in Office 2010 give you the option of becom-
ing more productive, more collaborative, and more mobile as you work.

We live in interesting times. There's a major shift occurring in the way technology weaves
through all aspects of our lives. Limitations that seemed all but insurmountable a few years
ago—such as having your team divided among three different continents or needing to
access your data immediately when you're away from your desk—are now gone for good.

Office 2010 makes it possible to wark virtually anywhere—on the desktop, on the train, in
the carpool line, in the coffee shop—with almost anyone, on any continent. And no longer
are you tied to your desktop PC—now you can work on the go using Web-based and mobile
versions of your favorite Office applications.

The tools you use in Office 2010 on a daily basis are no longer just designed for creating
documents or spreadsheets—although the programs do help you accomplish those common
tasks, and with style. The Office 2010 applications also deliver features you've been asking
for—professional formats that are a breeze to apply, easy exchange of data among applica-
tions, and streamlined techniques that enable you to get more out of the time you invest in
the documents and presentations you create.

Worldwide, Office users demonstrate that they want reliable, easy-to-use applications that
enable them to produce professional results, work collaboratively in both local and global
teams, and work anywhere from flexible locations limited only by Web access or phone
reach. These three ideas—express yourself, collaborate, and work anywhere—are the key
visions behind the changes in Office 2010.

Fast, professional, collaborative, flexible. You're going to love this new release!

Who Uses Office 2010?

One fascinating result that emerges from Microsoft research is the picture of Office 2010
users. Think of one of those amazing mosaic portraits, which—when you look closely—you
see is actually made up of thousands of tiny, individual photos. Office 2010 users represent
an amazing, diverse, multitalented global group that uses Office to accomplish just about
every possible productivity task you can imagine. Their needs and interests vary greatly,
and their use of the different Office applications runs the gamut from the very simple to the
incredibly complex.
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Note The dramatic redesign of the Office interface, introduced in Office 2007, was due in

part to a desire to help Office users discover a wider range of tools in their favorite programs.
Customer research had shown that most users worked with specific tools in the applications they
were familiar with, but a larger percentage of users weren't getting the full benefit from the
programs they might have if they had been aware of the wider range of features and possibili-
ties. Data is showing that the redesign of Office really did reach this goal—Word 2007 and Excel
2007 users are now using four times as many features as they used in previous versions, and for
PowerPoint, the increase in feature use is a factor of five.

Today's Office 2010 users often move back and forth among applications, depending on the
tasks they're engaged in at any given time. Here are some typical scenarios:

B Meredith is a customer service representative in a large company. Her job includes
fast-paced communications: she receives and sends e-mail messages to dozens of cus-
tomers, prepares and sends proposals, updates Web information, and tracks campaign
results in the customer services database. Occasionally, Meredith gets to lead brain-
storming sessions for new campaigns (she loves that) and compiles the notes for the
team. Printouts of colorful SmartArt diagrams she created in Word and PowerPoint—as
well as her favorite "The Far Side" cartoon—are hanging on her cubicle walls. Her daily
tasks require a whole palette of applications: Outlook, Word, PowerPoint, Publisher,
OneNote, and occasionally, Access.

B lan is a mid-level manager in the communications department of the same company.
As team leader, he is in charge of planning, budgeting, and managing all reports and
support materials that are developed to support the company’s product line. He uses
Outlook for scheduling and task management, and works with Word, Access, and Excel
for reviewing and working with important data. lan's team also prepares company
reports and public relations materials using Word and Publisher.

B Dominik is marketing coordinator—she is responsible for messaging campaigns,
running budgets, hiring contractors, working with the board, maintaining a data-
base, conducting webinars, providing online training, and more. She uses Word, Excel,
PowerPaoint, Qutlook, Publisher, and Access, and she needs to be available for decisions
and updates continually. Because she manages a department of five, she uses Microsoft
SharePoint 2010 to keep the team organized and working efficiently.

B Kamil is an Office power user who has a long commute to and from his Washington
office each day. He has reduced the impact of his travel time by telecommuting two
days a week, but he also wants to be able to get a start on work—or wrap things up for
the day—when he's on the train. Whether he's working from home or he's in the office,
he uses Outlook, Excel, Word, and SharePoint to run his department, keep the team on
track, host meetings, review and sign off on documents, and make the calls that impact
the bottom line in his department.
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B Todd is the IT manager for the business. He is in charge of upgrading, deploying, and

training staff on Office 2010. He also secures and backs up all files, writes custom utili-
ties for the Web portal, and works in customer and staff support. He is a programmer
and power user of all Office applications, but he has a small staff, so he needs to be
able to offer training and support in a cost-effective and productive way.

Office 2010 includes a range of features that will support the daily activities of each of these
users. The consistent look and feel of the Ribbon helps ensure that users are comfortable and
confident working with any of the Office applications. Changes in each of the applications
make it easier to produce and share professional results in a variety of ways. And not only do
the Office applications work together smoothly as an integrated system, they provide easy
collaboration, anywhere access, and all the productivity tools users need as their work tasks
change and grow.

What's in Microsoft Office 2010?

Similar to earlier releases, Microsoft Office 2010 is available in several versions, each designed
with a specific group of users in mind, and each accessible via PC, browser, or phone. Here's
what you'll find in each version of Microsoft Office 2010:

m  Office Professional Plus 2010 is for the high-end user who collaborates with

others, manages data, and needs flexibility, mobility, and coauthoring capabilities. This
edition includes Word 2010, Excel 2010, PowerPoint 2010, OneNote 2010, Outlook
2010, Publisher 2010, Access 2010, SharePoint Workspace 2010, InfoPath 2010, and
Communicator 2010.

Office Professional 2010 is designed for the business user who needs all the power
of the traditional applications as well as access to data management tools. This ver-
sion includes Word 2010, Excel 2010, PowerPoint 2010, OneNote 2010, Qutlook 2010,
Publisher 2010, and Access 2010.

Office Standard 2010 removes Access 2010 from the mix. It offers users who work
with documents, worksheets, marketing materials, presentations, notebooks, and—of
course—e-mail and schedules just what they need: Word 2010, Excel 2010, PowerPoint
2010, OneNote 2010, Outlook 2010, and Publisher 2010.

Office Home and Business 2010 streamlines the suite to the basic applications used
by small business and home users: Word 2010, Excel 2010, PowerPoint 2010, OneNote
2010, and Outlook 2010.
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m  Office Home and Student 2010 is geared toward student and home users, offer-
ing the traditional applications for creating documents, worksheets, presentations, and
workbooks: Word 2010, Excel 2010, PowerPoint 2010, and OneNote 2010.

m  Office Professional Academic 2010 s designed for faculty members who
need access to all the core applications—Word 2010, Excel 2010, Outlook 2010,
PowerPoint 2010—as well as OneNote 2010, Access 2010, and Publisher 2010.

B Office Starter 2010 s for the beginning user who wants to work with only
Word 2010 and Excel 2010.

Office 2010 System Requirements

In keeping with green efforts to maximize efficiency on systems users already have, Office
2010 was designed for any system capable of running Office 2007. Here are the suggested
system requirements for Office 2010:

B Computer and processor: 500-MHz processor or higher.

B Memory: 256 MB (megabytes) of RAM or more.

B Hard disk space: 2 GB (gigabytes)*.

B Drive: CD-ROM or DVD drive.

B Display: 1024 by 768 or higher resolution monitor.

B Operating system: Windows XP SP3 (32-bit), Windows Vista SP1 (32-bit or 64-bit),
Windows 7 (32-bit or 64-bit), Windows Server 2003 R2 with SP2 (32-bit or 64-bit),
or Windows Server 2008 with SP1 (32-bit or 64-bit). Terminal Server and Windows on
Windows (WOW) are also supported. **

* Part of the used hard disk space can be released after installation is complete.

** WOW allows users to install 32-bit Office 2010 on 64-bit systems.

What You'll Find in First Look: Microsoft Office 2010

| hope First Look: Microsoft Office 2010 inspires you and gives you a good sense of the
exciting features coming in the release of Office 2010. This book was written while the
software was in development, so you may find some variance in screen illustrations and
procedures, but the overall story is the same: The key to the new features is freedom and
flexibility—you'll be able to see how to get more from your applications no matter how—or
where—you choose to use them. Office 2010 is designed to help you express your ideas
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clearly and creatively, work seamlessly with a group to get things done efficiently and on
time, and access and work with your files virtually anywhere with a similar look and feel
whether you're using your PC, browser, or phone. To showcase these key points, First Look:
Microsoft Office 2010 follows this organization:

B Part |, "Envision the Possibilities,” introduces you to the changes in Office 2010 and
shows you how you can make the most of the new features to fit the way you work
today. Chapter 1, “Welcome to Office 2010," gives you a play-by-play introduction to
new features; Chapter 2, "Express Yourself Effectively and Efficiently,” details the great
feature enhancements and visual effects throughout the applications; and Chapter 3,
"Work Anywhere with Office 2010," explores the flexibility factor by presenting a set
of scenarios that enable users to complete their work no matter where their path takes
them.

B Part Il, "Hit the Ground Running,” focuses on each of the Office 2010 applications in
turn, spotlighting the key new features and showing how they relate to the whole.
These chapters provide a how-to guide for many of the top features you're likely to
use right off the bat, and they offer inspiring ideas on how to get the most from your
favorite applications.

B Part Ill, "Next Steps with Office 2010,” zooms up to the big picture and provides
examples to help you think through interoperability. How often do you use the vari-
ous Office applications together? Customer research shows that people often don't
realize how well the applications work together as a complete system—which means
they might be laboring over items they could easily incorporate from somewhere else.
This part of the book provides examples for integrating the applications and explores
Office 2010 security and training opportunities, as well.

So if you're ready, let's take a closer look at the ways Office 2010 can help you express
your ideas, whether you work on your own or as a part of a team, and share your work
with the world.
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Part |
Envision the Possibilities

Office 2010 ushers in a new era in productivity software by making the reliable tools
you've come to expect from Microsoft easier to use and more powerful than ever. In this
part of the book, you'll get the big picture view of how Office 2010 improves the way you
work every day.

This part of First Look: Microsoft Office 2010 includes the following chapters:
B Chapter 1: Welcome to Office 2010

B Chapter 2: Express Yourself Effectively and Efficiently
B Chapter 3: Collaborate in the Office and Around the World






Chapter 1

Welcome to Office 2010

In this chapter:
B Features that Fit Your Work Style
B Changes in Office 2010
B Exploring the Ribbon
B New Backstage View
B languages and Accessibility

B Coming Next

This is an exciting time to be working with technology. Changes are occurring with what feels
like ever-increasing speed. The world is growing continually smaller, and far-away places are
more and more within our reach. Today our coworkers are almost as likely to be working on
a different continent as they are to be down the hall. Opportunities are possible now that we
couldn't envision a few years back—more of us are telecommuting, training by webinar, and
planning projects virtually, all of which is accomplished through Web and phone access to
the tools that make it all possible.

Office 2010 was designed with evolving workplace trends in mind. With Office 2010, you
can use familiar, reliable Office applications to work more efficiently, produce better-than-
ever results, collaborate in real time with peers in your office or around the world, and con-
tinue your work from any point on the globe with Web or phone access. And even though
these are big changes, they fit easily into what you're already doing. The tools you need to
implement these changes in your work efforts don't have a steep learning curve. By add-
ing to the functionality of your favorite features (Print, Paste, and Picture Effects, to name a
few examples), Office 2010 helps you get more done with less effort. And the collaboration
and anywhere access features make working with anyone, anytime, a natural and intuitive
process.

Features that Fit Your Work Style

For many of us, our long workdays of focusing on single projects have evolved into days with
smaller blocks of time dedicated to one of many things we have going on. We are getting
more done than ever—and Office 2010 can help you better enjoy the process.
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What's exciting about Office 2010 is that it's more than a set of powerful tools that help you
meet and manage the demands of your fast-paced workday. For example, if you do most of
your work at your desk, crunching numbers, answering e-mail, and preparing reports, Office
2010 helps you work faster, manage huge worksheets, design effective documents easily, and
present your work in new, visual, and flexible ways that help your diverse audience under-
stand your ideas.

If you work primarily in a team, you'll find that Office 2010 makes collaboration easy with
features that enable you to share files, co-author documents, and even contact teammates in
real time.

If you work predominantly on the road—and frequently need to get updates on projects,
add items to the calendar, or approve new documents and strategies—Office 2010 gives you
the flexibility to use the Office applications you know and love regardless of whether you're
logging in from your PC, your browser, or your phone.

In Part ll, "Hit the Ground Running,” you get a closer look at the new features in each of your
favorite Office 2010 applications.

Office 2010 at a Glance
With Office 2010, you can

B [ncrease your productivity with more effective, reliable tools
B Express your ideas creatively and effectively, for multiple audiences
B Produce and share professional results easier and faster

B Communicate—and manage communications—easily whether you work
independently, collaboratively, or remotely

B Gain more freedom and flexibility to work anywhere, with anyone

B Enjoy the consistent and high-quality Office experience from your PC,
browser, or phone

Changes in Office 2010

This section presents a look at the key ideas behind the development of the features you will
find in Office 2010. Working independently or in a group, at your PC or on the road, you'll
find new tools and techniques that help you create great-looking documents, worksheets,
presentations, and more, and enable you to share your work easily with others.



©

Chapter 1 Welcome to Office 2010 5

Tip One significant change that has a large impact on processing speed and power is that
Office 2010 is now available in a 64-bit version. This expanded capacity really shines in Excel,
where enormous spreadsheets require that kind of processing power.

Let Your Ideas Soar

Office 2010 shows that powerful programs don't have to be difficult to use. Program design-
ers know that users today need a great variety of powerful, flexible tools, and that it's impor-
tant that those tools and features be easy to find and use. For this reason, you'll find quick
access to style galleries, themes, and more that help you select professional designs, choose
from color schemes that work, and create a professional look whether you're creating docu-
ments, worksheets, presentations, notebooks, or database tables.

To help you take your ideas to the next level, Office 2010 offers artistic effects and picture
editing, video editing in PowerPoint, new data visualizations (including sparklines and slicers)
in Excel, and the ability to manipulate fonts professionally in Word. And this is just the begin-
ning—there's much more, as you'll see in the chapters in Part Il, “Hit the Ground Running.”

And not only will your output be better, but the whole document creation process is easier,
thanks to enhanced search features, simplified navigation, the contextual spell checker,
translation tools, and more.

Collaborate Easily and Naturally

Unless you've been living off the grid for the last couple of years, you've probably noticed
that the world has gotten substantially smaller, thanks to the continuing expansion of Web
technologies. Blogs, social media, and new online publishing alternatives have steeped most
of us in a culture that is always on, always connected, and always talking.

An increasing number of people are now working in teams, and those teams might be spread
throughout the office or located around the world. A writer in Omaha could be working with
a software developer in India who might have been hired by an administrator in Scotland.
This geographical diversity within a project team is no longer an unusual occurrence—an
increasing number of Office 2010 users need to collaborate with peers and clients all over the
globe.

Office 2010 includes powerful tools to facilitate easy and successful team collaboration
and management. Co-authoring features in Word 2010, Excel 2010, PowerPoint 2010,
and OneNote 2010 enable you to work with a variety of teammates on a single project in
real time. And, when you use these features, your changes are automatically tracked and
coordinated.
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Microsoft SharePoint Workspace 2010, included with Microsoft Office Professional Plus,
enables users to move files anline and offline easily. Team leaders and members use
SharePoint Workspace to create and update the team calendar, conduct project manage-
ment, assign tasks, create document libraries, and more. Team members can collaborate in
real time, and their documents show who is working on what so that duplication of effort
or trading outdated versions of files is no longer a problem when several users work on the
same document.

Presence information is available with Office Communicator throughout Office 2010,
enabling you to see which of your teammates are online and communicate instantly—via
instant messaging, e-mail, or phone—to clarify questions on the project. You don't have to
leave the application you are working in to ask questions you need answered right away.

Work Anywhere—and Everywhere

Laptop, notebook, desktop, kiosk—any place that gives you an on-ramp to the Internet is

a potential workplace in Office 2010. Office 2010 Web Apps let you work with the famil-

iar Office 2010 interface and work with your Word 2010, Excel 2010, PowerPoint 2010, and
OneNote 2010 files. You can share files with other users by using Windows Live or SharePoint
Workspace 2010 and then open and work with the files on your PC when you get back to the
office.

If you are a gadget lover, you might already have a smartphone with all the bells and whis-
tles you can get. Office Mobile 2010 gives you another way to work on the go, using your
Windows Mobile smartphone. You can write up an idea before breakfast, create a new docu-
ment, and share it with the team—all before you get into work in the morning. Later, on the
way to meet a vendor, you can add a few more details, insert a picture, and send the file for
review—all from your phone.

Office Mobile works with Word, Excel, Outlook, PowerPoint, and SharePoint Workspace. The
application windows have been customized to fit the small phone screen and browser so that
you can find what you need easily and enjoy the familiarity of the Office 2010 interface.

This flexibility in Office 2010 gives you the freedom to follow through on your creative ideas
in real time—whenever and wherever they occur.
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Exploring the Ribbon

At the top of the interface in all Office 2010 applications, the Ribbon brings you all the tools
you need—and only the tools you need—to complete specific tasks in the various Office
2010 applications. The Ribbon includes tabs that reflect the various tasks you perform within
each of the applications, and each tab contains tool groups offering the tools you need as
you work with the files you create, Every application has the same look and feel, which en-
ables you to learn the Ribbon once in your favorite or most often used Office program and
then easily find your way around any other Office program. The Ribbon was introduced in
Office 2007 and has been improved in Office 2010 to include some new tools and provide
more flexibility. You can use the Minimize The Ribbon button to hide the Ribbon so that you
have more room to work on-screen, and you can customize the Ribbon to create your own
tabs and tool groups specific to your needs.

The simple design of the Ribbon enables you to find the tools you need in the tab that re-
flects the task you want to perform. When you want to add a picture to your annual report,
for example, you look in the Insert tab and find Picture in the lllustrations group. Figure 1-1
introduces you to the Ribbon in Word 2010 and Excel 2010.
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FIGURE 1-1 Exploring the Office 2010 Ribbon.
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A Quick Look at the Ribbon

The Ribbon simplifies the way you find and work with tools and options in Office. With a
simple, easy-to-understand layout for your commands, the Ribbon helps you find the tools
you need:

B  Ribbon Tabs Each tab provides a set of tools related to an overall task you are likely
to be performing in a specific application. In Figure 1-1, the Word 2010 tabs are File,
Home, Insert, Page Layout, References, Mailings, Review, and View; the Excel tabs are
File, Insert, Page Layout, Formulas, Data, Review, and View. The File tab takes you to
Microsoft Office Backstage view, which gives you a central place to work with the files
you create in Office 2010 applications.

B Ribbon Groups Within each tab are groups that help organize common commands to
help you quickly find what you need for a specific task. For example, on the Insert tab
in Word 2010, you'll find Picture, Clip Art, Shapes, SmartArt, Chart, and Screenshot in
the lllustrations group.

B Galleries A down-arrow appears to the right of some options in groups. Clicking the
down-arrow display a gallery of options you can select or a list of additional choices.
(See Figure 1-2.)
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Contextual Tabs

In addition to the tabs, groups, and tools shown in the Ribbon during normal use, contextual
tabs appear when you perform specific actions in a file. The fact that they appear only when
you need them is part of the beauty of the Office 2010 interface—this keeps the number

of commands on-screen at any one time at a minimum and easy to navigate through. For
example, when you click a photo in a Word document, the Picture Tools contextual tab ap-
pears, providing options related to picture editing. (See Figure 1-3)
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FIGURE 1-3 The contextual tab provides options related to the task you are performing.

Backstage View

One of the major improvements in Office 2010 is Microsoft Office Backstage view, a kind of
one-stop shop for all tasks related to managing the files you create in Office 2010 applica-
tions. The round and colorful Microsoft Office Button in Office 2007 has been replaced by
the File tab. When you click it, you are taken to a screen outside the document where you
can manage file information and save, share, print, protect, and work with version informa-
tion for the document. (See Figure 1-4)
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FIGURE 1-4 Backstage view helps you prepare, manage, and share the files you create.

Backstage view is organized in three panels. The left panel includes the commands you'll use
to work with the files you create. The center panel offers related options, and the third panel
displays a preview image of the selection or additional options. For example, when you click
Print, the center panel shows print options, and the right panel displays a preview of your
document as it will appear in print. This streamlines the print process so that you can preview
and print your document in one step.

Managing Files in Backstage View

In Backstage view, you'll find the commands you traditionally found on the File menu: New,
Open, Recent, Close, Save, Save As, Print, and Exit. In addition to each of these basic file-
management commands, you'll find Share, which enables you to share the file in a variety of
ways. You can share your desktop directly from Backstage view by using Communicator inte-
gration, sending the file by e-mail or fax, or saving it to a SharePoint Workspace or to a blog.

Tip Another great option Backstage view offers is that you can customize it to include your own
workflows and procedures.
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Backstage view is designed to give you access to important tools users sometimes forget to
use. For example, you can run the Document Inspector by clicking Check For Issues in the
Info panel of the Backstage view and clicking Inspect Document.

Streamlined Printing

Another great time-saving feature in Backstage view is the new Print process. Microsoft re-
search shows that more than 60 percent of Office users print more than 60 times per month.
That's a lot of time clicking Print options! Now in Office 2010, Print Preview has been com-
bined with Print so that instead of working through multiple dialog boxes, you get a one-
page view of how the file will look in print. (See Figure 1-5.) You can choose your options
right on the screen and click Print—and you're done.

[El: -0 s Business Plan 2010 - Microsoft Word (Technical Preview) o & =
“ Home  Insert  Pagelayout  References Mailings Review  View > @
= save .
Print e
R savess @
I e Copies: |1 = '
pen 5
L Print
= close Business Plan 2010
Info Printer i Draftvd prepared Ostober 2009
J HP psc 2350 series = Heading 1
REEerk Offline on'the nzertnb, 4 tedgrei n
M e St gl e, b, Stars, B, et g, 1Mt a2
New Printer Propefies Wrhen yas crease frres, cherts, ar dugrums, theyalso coardiate with your wirent dsment ok
Heading 2
Settings 5 o il chags e Weheatng thesdested st
am the uick Styles gileryan the Home b, Yo gn il rywring the vtfer dovirals o she
sl Print A1l Pages . et e s Fus dng e mat tht yad ey
share | print the entire document S
_ 5 change th v ok sFyar dowsment,eheaia saw Tharms e an i e eyt b, T chunge the
Pages: ” Lrais wvalsblean the Quick St pllary, use e CHIge Cumert Quirk Ses S TN Erthths Themer
ol il e the it e pillry ol e s o e :
elp =21 Print One Sided Aamumart @ the ol mrcknedin yr werant et
i ne 2
g o = o - b Heading 3 L
) Options Only print on one side of the pa... s T reel . )
3] ‘s cnuse these giledes m ingaretibles, beaders, Baterr, dow, mver g, and ather dament Ridding Ha .
B3 et HE‘;C“”““‘ - whan yas raam irtaras, cherts, ar g, thayabo coarrat mith your wrrans dsmartiank,

123 123 123 s caly g e fematirg e e

3 i the dsmment text by cheacng alos ks the
|| Portrait Orientation - : spfiey e
e b, v st e Bty byuing
the other mmirals on the Hame &%, st cenwols
Lot o s chisr aSuing heleak Far thrwerent
= - thene o ieg 1 rmas s yau specdydeectly,
i oo aa
85"z 11 T shngs thn ever lsak eFyair dosmant, sheas
nepr Theme demens in the Fipe Luynit @b, Tu
g thelaale svliein the quisk Tiga gy,

Mormal Margins

- Left 1° Right: 1" Lt The Chnge current quirk sty ¥ ommind
= 20th the Themes galary ind vhr quisk srles pillary -
- T podtsrestommng ot on ey H
1Page Per Sheet - T heren ety toniret s o sl
S cnselin yue durent tempiate

Page Setup

4 of2 p 61% (=—0— e

FIGURE 1-5 Now you can preview and print in one smooth process.

Languages and Accessibility

In keeping up with the reach of the global workforce, Microsoft Office 2010 has more robust
language tools than ever, including a choice of translation tools. According to Microsoft re-
search data, more than 1.6 million words have been translated using the Microsoft Language
tools—plus more than 6.2 million words online—into more than 100 languages. Office
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Online, which provides all kinds of content for Office users—including tips and tricks, how-to
articles, and video tutorials—provides content in more than 90 languages.

You'll find the Translate tool, which enables you to translate words or phrases, in the Review
tab of Word 2010, Excel 2010, PowerPoint 2010, and OneNote 2010. Or you can use the Mini-
Translator tool for on-the-spot translations. (See Figure 1-6.) The Editing Language feature
enables you to choose the language used by the dictionary for the proofing tools you select.
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FIGURE 1-6 Translate words or phrases on the fly, and choose the language dictionary you want to use.

In terms of extending the reach of applications for users who are differently abled, Microsoft
works with more than 175 partners to create assistive software that enables Office to provide
screen readers, high-visibility color schemes, and special keyboards.

Coming Next

This chapter painted the big picture of Office 2010 changes, introducing you to the overall
design goals in this release. It also summarized changes to the Ribbon, introduced you to
Backstage view, and discussed enhancements to print and language functions. The next
chapter takes a closer look at the Office 2010 features that will help you express your ideas in
a lively and effective way—through words, images, numbers, and more.



Chapter 2
Express Yourself Effectively
and Efficiently

In this chapter:
B Understanding Your Audience
B How Visuals Help
B Adding Text Effects
B Adding Artistry to Your Images
B Working Font Magic in Word 2010 and Publisher 2010
B Creating Data Visualizations in Excel 2010
B Editing Video in PowerPoint 2010
B Communicating Visually in Access 2010
B Enhancing and Streamlining Communications in Outlook 2010

B Coming Next

People use Microsoft Office to do many, many things. Depending on the nature of your
work, you might create documents, design worksheets, prepare reports, develop and
manage databases, create and give presentations, e-mail clients and coworkers, gather
information, analyze information, and share information. And that'’s just Monday!

Chances are that many tasks you do in Office 2010 involve communicating ideas to others.
Those others might be peers, clients, board members, prospective customers, students,
and more. You need to be able to create, prepare, and share worksheets, charts, reports,
databases, Web pages, e-mail messages, and brochures that other people can view and
understand. And of course, once they understand what you're sharing, you want them to
give you the response you're hoping for—whether that's a new contract, an important sale,
startup funding, or accolades for a job well done.

Office 2010 includes a variety of new features and tools that can help you communicate your
ideas clearly, visually, and in ways your readers will understand. Framing both what you want
to show and tell is important and can help you make sure your points hit their mark. This
chapter gives you a tour through the various new features that will help you showcase your

13
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thoughts more creatively than ever, bringing more visual energy to the items you produce.
Specifically, this chapter introduces you to features that help you do the following:

B Improve the formatting of your Word 2010 text by adding special artistic effects such
as shadows, reflections, glows, and more.

B Take advantage of the professional typography capabilities available in many OpenType
fonts, such as ligatures and stylistic sets. Edit pictures within your document, worksheet,
brochure, or presentation by using the image-editing features in the various Office
2010 applications.

B Edit videos within PowerPoint 2010, customizing the length, formatting, and effects to
meet your needs.

B Create data visualizations that help your customers grasp the trends in your Excel 2010
data.

Understanding Your Audience

Beginning with the end in mind is a good approach for just about any document, worksheet,
presentation, notebook, and database you create in Office 2010. When you first begin a new
file, consider your answer to the following questions:

B Who will be reading or using this file?
B What will they expect to see?

B Do you have photos that support the points you're making in the document or
worksheet?

B Will you use special text effects to call attention to key points, headlines, or labels in
Word 2010?

B Will charts, diagrams, or screen shots help your audience understand what you want
them to do?

B How can you help your audience understand the ideas you're putting in front of
them—and what do you hope they'll do as a result? Do you want them to fill out a
form, subscribe to your magazine, purchase your product, or understand how much
your department has accomplished this year? Knowing what kind of response you want
from your communication—before you even begin—will help create the framework of
the whole process for you. And the visual elements you add along the way will be more
likely to take you closer to that goal.
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How Visuals Help

Not too long ago, most business reports weren't very exciting. They might have had a cover
page, a column or two, and maybe a page border. The title might have been in a larger font
(Times Roman, most likely), and the body text was probably your basic 10-point or 12-point
standard font. But it was just business communication, right? Better to focus on the facts and
leave the fancy stuff to the marketing brochures.

The affordability of color laser printers and the ability to design attention-getting materials
on the desktop have changed all that. Today we recognize that no matter what we produce,
our materials are competing for readers’ attention. And research shows us that documents,
presentations, notebooks, and worksheets that are clear, easy to read, and include visual cues
that help lead our eyes to the most important points capture our attention and reinforce key
concepts in the document or presentation.

By adding special artistic effects to text; formatting headlines, captions, and tables in an in-
viting way; and thinking through the way you use pictures, charts, diagrams, and more, you
can dramatically increase the power of your message and make sure your readers get the
point.

Benefits of Pictures in Communications

The images you add to your documents, worksheets, presentations, notebooks, and
e-mail messages serve several purposes. They not only add visual interest and give your
readers’ eyes a rest, they are also known to provide the following real communication
benefits:

B Pictures linked to written text increase attention and help recall.
B Pictures help improve your readers’ comprehension.
B Readers' emotional response to pictures can help or hinder communication.

B Readers with lower literacy skills show improved comprehension when
pictures are used in documents.

B Captions help readers make the connection between pictures and text.

B Pictures showing outcomes, actions, or processes can help readers know what
to do after reading a document.
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Adding Text Effects

What are your favorite formatting features in the different Office 2010 applications? Most

people use boldface text to make sure headings, row and column labels, and table headings

stand out. You might also use the styles in Word or Excel to apply the look you want to the

different elements in your file, make changes to font size or color, and occasionally use more

specialized text controls such as small caps and strikethrough.

Word 2010 includes a number of easy-to-apply text effects that help you add special artistic

touches to the text in your documents. Now in addition to using 3-D effects, you can add
glows, bevels, shadows, reflections, and outlines. (See Figure 2-1.) These text effects apply
directly to your text and can be included in styles you create. And they act like traditional
text when you check spelling or edit your document.

Tip Did you know Paste is one of the most frequently used tools in all of Office 2010? You
now have more control when you copy and paste items in your files; the Paste Options gallery
enables you to preview the changes before you paste. Chapter 4, “Create and Share Compelling

Documents with Word 2010," includes details on using Paste with Live Preview.
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Adding Artistry to Your Images

Great photos can be more than just nice-looking images when you apply special artistic
effects to the pictures you use in your files. Now Office 2010—specifically, Word 2010, Excel
2010, Outlook 2010, and PowerPoint 2010—includes a palette of artistic filters you can apply
to images in your documents. (See Figure 2-2.)
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FIGURE 2-2 Choosing artistic effects.

You can choose from a variety of effects that apply different filters to the selected im-

age, including chalk, watercolor, sponge, rain, and more. You can also use the new Remove
Background feature to remove an image from the foreground and place it on a different
background. This feature is great for product catalogs, or for any image in which you need
to spotlight a particular element without showing a background that might detract from the
central element you hope will catch the reader’s eye.

Figure 2-3 shows an image with various artistic effects applied. As you can see, each image
conveys a different feeling, which means it's communicating a different idea with each effect.
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Photo [no effect) Line Drawing Pencil Grayscale

FIGURE 2-3 With artistic effects, one photo can be used to communicate several different ideas.
When will you use artistic effects in the files you create? Here are just a few ideas:

B Use an artistic photo or treatment of your company logo to show that this year's annual
report demonstrates innovation and creativity.

®  (Create an effect viewers will remember by choosing not to show a product or place in a
realistic way.

B Capture your readers’ attention and communicate something new by modifying an
existing photo they will recognize.

Correcting and Recoloring Pictures

Of course, not all images you take on your digital camera or phone are ready to use just as
you've captured them. The lighting might be wrong in that product photo; the person might
be just slightly out of focus; the range of contrast in the picture of the new building might be
too great to show up well in print.

Although the Picture tools in Office 2007 went a long way toward giving you control over
the images you add to your files, they were limited in the range of changes they allowed.
You could adjust the picture by changing the contrast and brightness, recoloring the image,
applying styles and effects, or arranging the picture on the page. The Corrections tools in
Office 2010 give you a customizable palette of choices for brightness and contrast, and they
allow you to set your own standards for sharpening or softening images. This means you
can now insert and edit photos as you work in Word 2010, Excel 2010, PowerPoint 2010, and
Outlook 2010 without ever leaving the application.

Cropping also has received a makeover in Office 2010. Now when you choose the Crop tool,
the entire image is displayed in shadow behind your crop marks; you can then use the crop-
ping tool to zoom in on the part of the image you want by resizing the image, panning to
the area you want to capture, and cropping out the rest. The display makes it easy for you to
select only the part of the photo that you want people to see.
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Leaving the Background Behind

One of the great new artistic tools in Office 2010 is Remove Background, which lets you
pull the object of a photo from its background. This is a great technique when you're
preparing product information, introducing a new employee, or creating materials to
spotlight a key element you don't want your readers to miss.

To grab an image in the foreground and remove it from the background of your
photo, use the new Background Removal tool on the Picture Tools tab of Word 2010,
Excel 2010, PowerPoint 2010, and Qutlook 2010. Here's how:

1. Select the photo, click the Picture Tools Format tab, and click Background
Removal.

2. Drag the bounding box to include the areas of the image you want to display.
The magenta areas are those that will be removed.

3. Use the Remove Background tool in the upper left area of the Ribbon to mark
areas of the image you want to keep or remove.

4. Click Close Background Removal to complete the task.

Pretty neat, eh? Experiment with this feature to discover ways you can point your
readers’ attention to just what you want them to see in your images.

The new Color tools also have had a major overhaul: now you can choose from a wide
range of color management tools and make choices for saturation, tone, and an expanded
selection of color wash effects. (See Figure 2-4.)
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FIGURE 2-4 The Color tools in Office 2010 allow more choices for saturation, tone, and recoloring.

Color Effects Defined

If you're new to the whole landscape of picture editing, you might be wondering what
the new features in the Color tools of Office 2010 enable you to do. Here's a quick in-
troduction to the phrases and what they mean:

m  Color saturation controls the amount of color used in the picture—in other
words, how saturated the image is with the colors represented. A picture
with a Saturation of 0 percent is a black-and-white image; a picture with
a Saturation of 400 percent is flooded with color. (Use this option only for
special effects))

B Color tone enables you to choose the overall temperature for the image. The
underlying tone for the image ranges on a scale from "cool” blues (4700 K) to
"hot" oranges (11,200 K). Experiment with an image to test the range of tones,
and choose the look that best fits the overall design of your file.
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B Recoloring applies a color filter to the image, making it monochrome (in blue,
red, green, or purple, for example) and creating a special artistic look that can
fit the color scheme in the file you're preparing.

Working Font Magic in Word 2010 and Publisher 2010

Another new feature in Office 2010 that adds a touch of visual sophistication to the files you
create is support for OpenType typography. OpenType fonts are a type of scalable font de-
veloped by Microsoft and Adobe to provide an expressive font format that enables software
users to create files reflecting an increasingly diverse range of languages. Word 2010 and
Publisher 2010 now support the typography features found in some OpenType fonts, such as
working with ligatures and stylistic sets. Word 2010 and Publisher 2010 also include support
for Number Forms and Spacing. (The feature is called Number Styles in Publisher.)

A ligature is a character in typography that consists of two or more connecting letters; for
example, the letters fi are often set as a ligature. Ligatures were originally invented (back in
the dark ages when typesetters cast type in lead before inking them and printing pages) to
save space and reduce typesetting effort.

A stylistic set is a font displayed with a specific set of characteristics, enabling you to get

a subtly different look and feel for selected text even though you're using the same font
throughout a document. Gabriola, a new font in Office 2010, offers a variety of stylistic
sets you can try in your documents. Different stylistic sets might give you a whole range
of choices for that particular font, including whether you want to display serifs or not, how
characters with extenders are displayed, and much more.

To see your typography choices in Word 2010, click the dialog launcher in the Font group on
the Home tab, and then click the Advanced tab. The Ligatures setting enables you to choose
how you want the ligatures to be applied when they are available, and the Stylistic Sets
choice offers a list of available sets you can select for the current font. Figure 2-5 shows sev-
eral different stylistic sets selected for a headline in the Gabriola font. Take a close look at the
length and shape of the extenders on the letters h, k, and p as well as the spacing between
the characters to see the difference.
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FIGURE 2-5 Fine-tuning fonts in Word 2010.

Ligatures and stylistic sets work similarly in Publisher 2010. Here you can choose the
typographical controls from the Typography group in the Text Box Tools Format contextual
tab. (See Figure 2-6.)
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FIGURE 2-6 Choosing a stylistic set in Publisher 2010.
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Tip Publisher 2010 also includes a number of specialized font options, including stylistic alterna-
tives, and specialized number styles. You'll learn more about the steps involved in working with
fonts in Publisher 2010 in Chapter 10, "Create Effective Marketing Materials with Publisher 2010."

Creating Data Visualizations in Excel 2010

¥

If you work with numbers all day long, you're probably comfortable with a language many
other people struggle to understand. Equations and trend lines make perfect sense to you;
business intelligence is part of your language; numbers tell you what you need to know
about product status, market saturation, and potential return on investment. You build your
documents and presentations around these numbers.

But wait a minute! Could you please translate that for the rest of us?

Excel 2010 now includes simple but effective tools that will enable even the most advanced
numbers people to show the rest of us what the numbers mean in a language we can under-
stand. Take sparklines, for example. Newly added sparkfines are small graphical representa-
tions of data on your worksheets—small charts that can depict a trend and visually convey to
your audience what the values actually mean. Sparklines can show, for example, an increase
in enrollment for new webinars, a spike in sales related to a recent event, or a fall-off in hard
goods purchasing.

When you use sparklines to illustrate the data in your worksheet, you help those for whom
numbers might be a foreign language stop struggling with what it all means and enable
them to clearly understand your point. Figure 2-7 shows simple sparklines added to a column
on a worksheet to illustrate the data trend reflected in the displayed row.

The conditional formatting features in Excel 2010 have been improved and expanded with
new icon sets, data bars that are capable of showing negative values, and proportional dis-
plays in data bar sets. You can also control the formatting of data bars to get just the right
effect in the worksheets and documents you prepare.

Tip For more detail on using sparklines and making conditional formatting improvements to
your Excel worksheet, see Chapter 5, “Create Smart Data Insights with Excel 2010."
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FIGURE 2-7 Sparklines give you data snapshots in Excel 2010.

Editing Video in PowerPoint 2010

¥

It's no secret that seeing how something is done in video format is a simple way to learn a
new technique, whether you're changing the oil in your car, learning how to plant a rosebush,
or designing a new brochure in Publisher 2010. A video clip enables you to share with others
the "how to" as well as the "why" because you can explain the reasons for the action while
you're demonstrating the technique for those viewing the clip.

Are you ready to let your creativity out of the box? Take a look at the new video capabilities
in PowerPoint 2010. Now the video from your files is embedded by default, which means that
you no longer have to carry all your media files along whenever you copy, move, or share a
presentation. Because the video is embedded, you can edit the video directly in PowerPoint
without using any other video-editing software.

The video-editing features in PowerPoint 2010 enable you to shorten long video segments,
apply fade-in and fade-out settings, add bookmarks to help you quickly access important
points in the video or even trigger animation from key points in your video. Figure 2-8 shows
you several of the available video-editing capabilities in PowerPoint 2010.

Tip If you have online video you'd like to use in your PowerPoint 2010 presentation, you can easily
embed the code from the online video site right in your PowerPoint slide. To find out more about
how to do this, see Chapter 7, "Produce Dynamic Presentations with PowerPoint 2010."
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FIGURE 2-8 PowerPoint 2010 includes powerful video-editing and formatting tools that enable you to modify
video without leaving the program.

Communicating Visually in Access 2010

Maybe it's all about the data for you. You design elegant databases; you create new data
tables and forms. You know how to put together such a sophisticated query that it leaves
others in awe. When you need to communicate your ideas to others who aren't as comfort-
able with data as you are, chances are that you know what happens when other peoples’
eyes glaze over. They are no longer listening, which means they aren't following what you're
saying. How can you make sure they understand what your data is saying in a way that
makes sense? Access 2010 data visualizations can help.

Conditional formatting in Access 2010 now supports data bars, which enable you to depict
data visually so that your audience can understand your ideas. See Figure 2-9. In addition

to the traditional data bars, now you can set negative values for data bar display as well.
Improved tools in Access 2010 enable you to apply a greater range of conditional format-
ting to the tables and reports you create. Here are other ways you can add visual elements to
Access 2010:

B Include data bars, icons for minimum and maximum values, and more.
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B Display an image on the background of your reports by using the Background Image
feature in the Report Design Tools Format tab.
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FIGURE 2-9 Access 2010 lets you add data bars that help you compare data values at a glance.

Enhancing and Streamlining Communications in
Outlook 2010

One of the big changes you'll notice right away in Qutlook 2010 is that the Ribbon replaces
the menu and toolbars at the top of the main Outlook window. (See Figure 2-10.) Now all the
tools you need—including the new Quick Steps—are within easy reach and you can find the
right commands when you need them.

All the formatting capabilities—SmartArt graphics, styles, and Office themes—are available
for the e-mail messages you create. This means that even though the messages you create

compete for attention with the hundreds of messages your recipients receive, you can take
steps to make sure your messages are as compelling and inviting as possible.

Depending on the nature of the work you do, the feature that enables you to include screen
shots in the messages you send can be a big help. (See Figure 2-11.) If you help customers
find products online, support your staff through technical training, or assist users as they try
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Tip Setting up Outlook 2010 to send items to your mobile phone is as simple as clicking the File
tab to display Backstage view, choosing Options, and clicking Mobile. If you have an SMS Service
Provider, you can send calendar items, reminders, and messages to your mobile phone by sim-
ply choosing the options you want to set and clicking OK. If you don’t yet have an SMS Service

Provider, you can find one on Office.com.
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®  Work faster with Quick Steps. The addition of Quick Steps enables you to carry out
routine tasks with a quick click of the mouse. Now you can move a message to a

specific folder, reply to a meeting, or send a message to your team with one little click.

Simple.

FIGURE 2-10 The main window of Outlook 2010 now sports the Ribbon, offering the tools you need within
easy reach.

Not only can you make your e-mail messages look more attractive and inviting for those
you contact, but Qutlook 2010 gives you a number of ways to keep up with the mountain of

messages you receive every day. Here are a few of the key features that help you manage the
volume of mail you receive:

27

to find specific items on your Web site, including a screen shot can show readers what you're
talking about and help them understand an important process.
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B Conversation View enables you to view the most relevant threads of a conversation
and suppress redundant threads. Having the ability to remove redundant messages in
the conversation saves Inbox space and helps you manage the volume of e-mail you
receive.

B Easily manage and clean up threads and move on to more pressing tasks without
getting bogged down in messages that don't relate to the task at hand.

®  Easily manage your multiple e-mail accounts, whether you want to combine home and
work or any one of a number of Web-based e-mail accounts. Now you can bring them
all together in one place with Outlook 2010.
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FIGURE 2-11 With Outlook 2010, you can easily add and enhance pictures, screen shots, and more.

Coming Next

In this chapter, you learned about the range of features in Office 2010 that enable you to add
visual effects and enhancements to the ideas you share with others. You explored new and
improved features in Word 2010, Excel 2010, PowerPoint 2010, Outlock 2010, Access 2010,
and Publisher 2010. The next chapter gives you this same kind of big-picture view of the
collaboration features you'll use as you work with teams in your office or around the world.
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Collaborate in the Office and
Around the World

In this chapter:
B |t's All About the Teamwork
m  Benefits of Office 2010 Collaboration
B Stay in Touch with Your Team
B Co-Author Files Across Applications
B Use the Presence Icon to See Author Availability
B Using the Office Web Apps
B Sharing on the Road with Office Mobile

Depending on the type of work you do, you might work on your own most of the time,

or you might work as part of a larger group—or perhaps, several groups. Your groups might
come together to complete a specific project—for example, to produce a new marketing
plan—or they might work together over the long term, completing multiple projects.
Whether your need for collaboration is short term or ongoing, you'll find features in

Office 2010 that enable you to

B Work with others simultaneously on the same file.
B Connect instantly with others working on your document or presentation.
B Know when others are actively working in the document you are viewing.

m  Collaborate in real time with others working from their PCs, browsers, or phones.

It’s All About the Teamwork

As the world grows smaller and more accessible, our teams expand and grow. Today it isn't
unusual to have someone from another continent on your team—whether the home office
for your company is in the U.S,, the U.K,, India, or another Web-enabled place on the globe.
In a team context, we plan projects, assign tasks, share documents, work collaboratively on
files, resolve problems, and ultimately produce materials that further the missions of our
companies, reach customers, and accomplish the tasks we're asked to complete.

29
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What Teams Look Like Today

So how many of us are working in groups today? The exhaustive research data Microsoft
compiled shows that 52 percent of those surveyed currently work on two or more project-
based teams. Others responded that most of their work is done independently, but they
collaborate with others occasionally.

How do teams work collaboratively?

m  Surprisingly, many workers collaborate by e-mail, sending versions of documents back
and forth. This isn't the most accurate or most secure method of working collabora-
tively because file versions can be misplaced and a sensitive file might be vulnerable to
interception unless it's encrypted or sent only on the company intranet.

B Others collaborate via instant messaging (IM), discussing projects, making decisions,
and planning next steps.

B Still others use social networking tools to discuss items in a group, set up an event, and
more.

B Some businesses encourage the use of an employee portal or provide collaboration
software to facilitate teamwork.

B QOther ways to collaborate include face-to-face meetings (of course) as well as shared
blogs, wikis, SharePoint sites, and more.

Office 2010 makes collaborating a natural and intuitive process by bringing collaboration
tools into all the major applications. You can share your team document on SharePoint, share
OneNote notebooks, create Word and PowerPoint projects, and ask fellow authors questions
while you work.

Team Tasks and Methods

In most workplace environments, teams are made up of people who are brought together by
role, not by choice. This means you might be part of a group that is an interesting mix of per-
sonalities and talents. No matter how similar or how different team members might be, your
team will need to accomplish two primary goals to be productive and deliver what you came
together to create:

B You need to be able to communicate effectively.

B You need to find a way to solve problems.
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The content of each team's tasks might vary widely. One team might be organized to assess

the need for a human resources program; another team might come together to produce an
annual report. Still another team might be charged with planning, hosting, and evaluating a

national event.

Whatever the focus your work has or whatever the objective is you're working toward, you
need to be able to share information, connect with others, and coordinate your efforts.
Along the way, each and every team needs to discover how to work together most effectively
to get the job done.

A Quick Look at Group Process

American psychologist Bruce Tuckman studied group dynamics, and in 1965, he
proposed that every group goes through four stages:

B Forming is the stage in which the group comes together. During this stage,
the members get to know one another and begin the process of communicat-
ing. Some members might be polite and others might be anxious, but basi-
cally everyone is on his or her best behavior.

/Performing /

B Storming is the stage when team members begin evaluating their place in
the group and struggling to determine the overall work goals of the group.
Personalities might clash at this point as the group begins to carve out helpful
ways to interact.

B Norming occurs when the group members begin to settle into individual roles
that feel like a good fit for the group. The anxiety of testing roles and bound-
aries calms down, personality differences are less of an obstacle, and the lead-
ership of the group seems suitably established.

B Performing is the stage when the group finally comes together as a team.
The group has a shared vision of the final goal of the work and is able to
move productively toward that end.

In the 1970s, Tuckman added a fifth stage that he called adjourning, which involves
disbanding the group. This stage might bring anxiety for group members, but

it also offers closure if the group was convened to accomplish a specific goal or
complete a project.
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Benefits of Office 2010 Collaboration

No matter where your team might be in the group-formation process, the tools in

Office 2010 can help you communicate effectively, share questions and concerns, complete
project-related tasks, and speak each others’ languages. With the tools in Office 2010, you
can streamline the following team-related activities:

B Staying in touch no matter where you're working

B Creating shared folders that others can use to access project assets such as images,
logos, charts, documents, and more

B Working with more than one teammate on the same file at the same time

B Checking the online status of other authors of your shared document using the
presence icon

B Translating words and phrases easily as you work

Stay in Touch with Your Team

Office 2010 Professional Plus includes SharePoint Workspace 2010, a data-sharing workspace
that enables you to have access to all the files and data you need as you work with your
team. With SharePoint Workspace 2010 (shown in Figure 3-1), you can create a team work-
space that gives you access—both online and offline—to tasks, links, announcements, team
discussions, and document and picture libraries.
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FIGURE 3-1 SharePoint Workspace 2010 enables you to take your work offline and share your files and other
project resources with team members.
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Share Files in the Workspace

You can create new workspaces related to specific projects your team will be working on and
set up the elements you want to share. Because SharePoint Workspace 2010 is a true Office
2010 application, you can simply drag and drop the files you want to work on later offline or
make available to the team into the Documents library. (See Figure 3-2.)
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FIGURE 3-2 You can easily drag and drop files to a workspace to share items with the team.

The files are available whether you're offline or connected to the server; when a server
connection is established, features such as Check In and Check Out are enabled, and you can
navigate easily through the original site to sync, download, or review files.

Not only can teams share files, post announcements, and chat in real time in SharePoint
Workspace 2010, but team members can also post to a discussion board to carry on
conversations related to the project at hand. (See Figure 3-3.) A chat feature also is available
to allow team members to ask and answer quick questions as they work in the space.
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FIGURE 3-3 With SharePoint Workspace 2010, you can have conversations with teammates on topics related
to your shared project.

Share Files and Folders

SharePoint Workspace 2010 also enables you to create shared folders in your own system so
that you can exchange files easily with your server or share them with other people. By creat-
ing and sharing a folder with files related to your specific folder, teammates can access the
resources they need in the shared folder you created. This enables you to share files easily
without uploading them to your company's server space and also gives you an easy way to
organize and work with files you eventually check back in to the server.

Co-Author Files Across Applications

The new co-authoring feature, available in Word 2010 and PowerPaint 2010, is one of the
new collaboration features in Office 2010. Co-authoring is also available in the Excel Web
App. Now you can work collaboratively on a document at the same time others are working
in the file. You can edit files in real time, coordinating your changes, talking about revisions,
and reviewing the work of each person on your team.
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Tip Youalso can simultaneously edit a shared notebook that is stored on SharePoint or
Windows Live with others who are using OneNote 2010, OneNote Web App, and OneNote
Mobile 2010.

No matter how many people on your team are working together online at the same time,
each person can work on her respective section, and then changes are synchronized au-
tomatically when the file is saved or when the user logs on the next time. The names of all
authors are displayed next to the areas of the document they are editing. Additionally, a
pop-up list of available authors is available on the application status bar when the shared
document is active. (See Figure 3-4.)
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FIGURE 3-4 Co-authoring enables you to see who else is working on the current document.

Note Co-authoring requires Office Communicator 2007 R2 and Office Communications Server
2007 R2. For Office 2010 users in a business environment, SharePoint Workspace 2010 is also
needed for co-author capability. Home users can use Windows Live as the co-authoring platform
for file collaboration.
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Connect via Presence

The Presence icon is a new feature in Office 2010 that shows you the availability of team
members when you're working on shared documents. When you point to the icon, a contact
card expands, listing the ways you can contact that person. (See Figure 3-5.)

If you're using Windows Live for document sharing, you'll be able to send an instant message
to other authors working on the document. You'll also be able to schedule a meeting, add
the author to your Microsoft Outlook contacts, and work with Outlook properties. If you're
using Office Communicator R2, you'll have these choices and also be able to start a video
call, tag the contact for presence alerts, and add the contact to your Quick Contacts list.

Joanna 40 - X
Awailable - Free for next 8 hours
|| SR. PRODUCT MANAGER

e ® (- BB -
Department  Managed Business 2 Startyideo Call
Office 3/ E8 schedule a Meeting
Work X872 Tag for Presence Alerts
Mabile B Wiew MySite
Home Add to Quick Contacts r
E-mail &7 Add to Outlook Coptacts
Calendar Free for next 8 hours Look Up Outlaok Contact
Location Qutlook Properties

Contact Organization

FIGURE 3-5 When you click the Presence icon of a contact, the contact card for that person is displayed.

So how does Office 2010 know all this information about the various members of your team?

The Presence icon reflects online status information available in either Windows Live or
Office Communicator.

Microsoft Office Communicator 2007 R2

Microsoft Office Communicater 2007 R2 is an enterprise communications tool that

enables you to unify the various ways you communicate with others—by e-mail, instant
message, voice, or video.

Microsoft Office Communicator 2007 R2 requires Microsoft Office Communications
Server 2007 R2, which runs only on 64-bit systems. Communicator client does not
require a 64-bit computer.
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Using Office Web Apps

Today more and more of us are escaping the confines of the cubicle and venturing out to
work in unusual places—the corner coffee shop, classroom, convention floor, park bench,

or client office. Flexibility is good, but we also need an easy, secure, and reliable way to ac-
cess mission-critical documents and files. We need to review records, update reports, quickly
check the budget, get an estimate on reservations, and approve the finals on the four-color
report before it goes to the printer.

The new Office Web Apps enable you to access and work with your files anywhere in the
world you have Web access. (See Figure 3-6.) And if you don't have Internet Explorer, no
problem—Office Web Apps support Windows Internet Explorer 7 or later for Windows,
Safari 4 or later for Mac, and Firefox 3.5 or later for Windows, Mac, and Linux. That means
that whether you're logging in on a Mac, PC, or kiosk at a hotel or airport, you'll find the
same reliable Microsoft Office interface and be able to review, edit, and save the files that are
important for your work.
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FIGURE 3-6 Office Web Apps offer the consistent look and feel in an easy-to-use, light editing interface.
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Sharing on the Road with Office Mobile

Office Mobile 2010 (shown in Figure 3-7) lets you take Office with you wherever you go—
whether you're carrying your laptop with you or not. Using Office Mobile 2010, you can
easily check e-mail in Outlook Mobile 2010, organize your inbox, update schedules and tasks,
and even work on your favorite Office documents, all from your favorite smart phone.

The rich interface for small devices enables you to view and edit files from your mobile
phone. You can choose from a variety of display options, perform editing and formatting
operations, and send files to SharePoint Server 2010 or to your Windows Live account.
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; Taam lunch next week - whare to go? d
Lo
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FIGURE 3-7 The clear, easy-to-read Office Mobile interface makes it simple for you to read e-mail, work with
Office Mobile applications, and send and receive files.

Coming Next

The collaboration features in Office 2010 enable you to continue working with your favorite
applications in real time, no matter where you are or who you're working with. With
SharePoint Workspace 2010, you can keep your team headed in the right direction; using the
coauthoring features and the presence icon, you can work collaboratively on documents and
contact other authors in your shared documents. And Office Web Apps and Office Mobile
both help you access your files remotely so that you can keep things moving whether or

not you're able to be at your desk to do it. The next chapter kicks off Part Il of this book by
showcasing the new features available to you in Office Word 2010.
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Part Il

Hit the Ground Running

Each of the applications in Office 2010 offers new ways to communicate your ideas more
visually and effectively, features that enable you to collaborate easier than ever before,
and ways to access your work from anywhere, anytime. Whether you spend your time in
Office 2010 generating content, managing projects, or analyzing financial data, you will
discover new capabilities that streamline your tasks, add professional impact, and add
flexibility and creativity along the way.

This part of the book introduces you to the new features in each application and gives you
some hands-on experience with different elements so that you can get up to speed quickly
with this new release:

Chapter 4: Create and Share Compelling Documents with Word 2010
Chapter 5: Create Smart Data Insights with Excel 2010

Chapter 6: Manage Rich Communications with Outlook 2010
Chapter 7: Produce Dynamic Presentations with PowerPoint 2010
Chapter 8: Organize, Store, and Share Ideas with OneNote 2010
Chapter 9: Collaborate Effectively with SharePoint Workspace 2010
Chapter 10: Create Effective Marketing Materials with Publisher 2010
Chapter 11: Make Sense of Your Data with Access 2010
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Chapter 4
Create and Share Compelling
Documents with Word 2010

In this chapter:
m  Start Out with Word 2010
B Format Your Text
m  |llustrate Your |deas
B |mprove Your Text
B Co-Author Documents

B Access Your Documents Anywhere

What's the big story in Microsoft Word 2010? Think flexibility and freedom of expression.
Imagine working on documents in the quiet of your neighborhood coffee shop, collaborat-
ing with a coauthor who lives in Taipei, or doing a quick review on your smartphone before
you forward the document to a major client.

Word 2010 is designed to be simple to use and yet give you all the tools you need to create
sophisticated, professional documents that express your ideas clearly and well. The new fea-
tures enable you to work efficiently and collaboratively, in a consistent, familiar interface,
whether you're working on your computer, in your browser, or on your smartphone.

Additionally, you'll discover simplified ways for getting around in the document and an
expanded slate of tools that enable you to include great quality fonts and picture effects so
that your finished product looks as good as possible. This chapter introduces you to the key
new features in Word 2010 and encourages you to try a few techniques along the way.

Start Out with Word 2010

The Word 2010 window is designed to help you focus on the task at hand, whether you are
writing, formatting, editing, illustrating, securing, or sharing documents. The Ribbon (shown
in Figure 4-1) stretches across the top of the window, providing all the tools you need, just
when you need them. The status bar at the bottom of the window enables you to get current
statistics on the document as you work (for example, checking the number of words in the
file) and change views so that you can display the document in different ways.

41
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FIGURE 4-1 The Word 2010 window maximizes your workspace while providing tools across the top and
document information and views along the bottom.

Tip To display the Customize Status Bar list and add other information elements to the status
bar, right-click the status bar at the bottom of the Word window.

Get Familiar with the Word Ribbon

The Ribbon in Word 2010 makes it easy for you to find just the tools you need when you
need them. (See Figure 4-2)) Tabs contain tools related to specific tasks you want to com-
plete. The Insert tab, for example, includes the tools you need to add illustrations, links,
tables, and much more.
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FIGURE 4-2 The Ribbon offers just the tools you need, depending on what you're working on in Word.

Contextual tabs appear when you select a specific element in the document—for example,
when you click a picture, the Picture Tools contextual tab appears, as you see in Figure 4-3.
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FIGURE 4-3 Contextual tabs offer tools that relate to the selected object in the document.

One great feature common to all Office 2010 applications is the ability to customize the
Ribbon so that you can add your own tabs, putting together the tools you use most often in
the configuration that fits you best. You can create your own custom tabs or tab groups, and
move tools on the existing Ribbon tabs to create groups just the way you want them.

Tip You can hide the Ribbon easily and maximize your work area by pressing Ctrl+F1 or clicking
the Minimize The Ribbon button on the right side of the window above the Ribbon.

Find What You Need Easily with the Navigation Pane

The new Navigation Pane is a great addition to Word 2010. Combining the best of the Find
utility with Outline view and thumbnail displays, the Navigation Pane gives you multiple ways
to find what you're looking for in your document. Now you can move right to a section in
your document by clicking the heading you want (as shown in Figure 4-4), scroll through the
list of page thumbnail images, or enter a search phrase and choose from the list of results (as
shown in Figure 4-5).



Part Il Hit the Ground Running

M98 FLOL ken_EZ60 - Microsof Word (Technicsl Previen) = @ =
“_hom! Inzert Fage Layout Refarences Milings Reviewr Wiew =3 0
:l.l a m:_ [T & Ruter q [ @onerge 2 : El L3 Sidle by Side E‘ g
: ’[:l = 5 Griglines G e pages = i onaus Serolling —
Print | Full Screen Web  Outhine Draft Zoom  100% New  Arrange  Split ’ Swittch Macraz
\Layout| Reading  lLavout ] Mavigativn Parie S Page Witth | window Al SLVNA0W POIon | Windows [
Dacument View: Shaw Zoom Wind o Macroz

Navigztion L N R IR S N I R R R SRR ERY ;E

+ Uinkinsachuab—Tnsers, for sxaplo—are growps thet belp you fid ubar E

o nesd for & spect fictask. Inche Tnsers cab in Vord 2010, che orows

are Pages, Tables. Tlluscravdens, Links, Hesder & Fooser, Tew, md
Syabala.

Search Donment

3 |38 |E =

A doemarrow appears 5o She TAghT of Sons SEviNZ in areuns. Glicking

- The dwi-arrow digplay  gallery of opsicns yow ca select or a lise
4 Diferertisws ar tae .. g of widitional choicts tous Pigwre 431,

onewarkp | |2

Features that Fit Your V...

.

Cefice 2010..

4 Big Picure Changes in ..
Ret Fourloess Scar
Collbarate Eslyan.. | ||
Wedk Anpuber—zn., |

4 Bploing the Fiaben
AQuick Laok stthe .. H |
Contetualizing Teals | : = 1

4 Changesin the Offic.

(]

Customain..
4 The Hew BadkStage View |

Bdanaging Files in Bs. = ST

rcanlingd Minking | Figure I-¢ Galleries display visual exosples of cpsicms,

Languages and Acceszi.. B

Caming Hest i contextualizing Tools

| Pare of the thinking bahind the vencvation of the Office user interlace
rralved xaiting a greater miher of features mrallable Sousers with fewer

|

Microsaft Frass CONTIDINTIAL

Fage: 130113 | Wonds: 3,386 ‘:-; English 1U.5] | [EnE = s C——U -t

G2 PR

i

FIGURE 4-4 With the Navigation Pane, you can move easily through the document by clicking the heading of
the section you want to see.

The improved search features offered in the Navigation Pane enable you to find the content
you need, whether it is in the basic body text or headings of the document or whether it
appears in your document in the body text, headings, tables, graphics, footnotes, sidebars, or
comments.
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FIGURE 4-5 The powerful search capability in the Navigation Pane displays a clickable results list showing all
the places in the document your search word or phrase appears.
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Print and Preview in a Single View

If you are like most Word users, you print your documents on a regular basis. And using Print
Preview is part of the process, enabling you to make sure the overall page looks the way you
want it to look, the pictures are in the right places, and the headings are in the appropriate
spots. Word 2010 smooths out the printing process by combining the print and preview tasks
into a single step.

Now you can preview and print your document in Backstage view with literally a single click.
You can still change your print options, setting print quality, choosing the paper source and
size, and specifying the number of copies before you print. You can also page through the
document easily and shrink or enlarge the page view so that you can check all details easily
before sending the document to the printer.

Format Your Text

Word users typically spend quite a bit of time formatting documents. New features in
Word 2010 enable you to apply stylized effects to text, use high-quality fonts, and choose
just the right paste options for the task at hand so that your documents look professional
with just a little help from you.

Did You Know?

B Eighty percent of all documents use fewer than 20 styles.
B Word users include an average of 16 styles in each document.

B The most common formatting changes are font size, font face, and font color.

Step by Step: Printing and Previewing

Because the print and preview features are streamlined into one process in Word 2010,
you can easily review and print the file. Here's how to print and preview a document in
Backstage view:

1. Open a document or create a new document that you'd like to print. If you create
the file, save it before you prepare to print.

2. Click the File tab on the Ribbon. This displays the Word 2010 Backstage view.
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Click Print. The document appears in the Print Preview window to the right of the
Print options.
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Preview the document by clicking the Previous Page or Next Page controls in
the bottom left corner of the preview window. You can also change the size of
the page display by adjusting the Zoom control in the lower right corner of the
preview window.

Use the options in the center column to choose the print settings you want to
apply to the printed document. For example, you might need to select your
printer, specify the pages you want to print, or change from one-sided to
double-sided printing.

When the document in the preview looks the way you want your printout to
appear, click the Print button at the top of the center column.

Tip Before you print a long document or multiple copies of the same document, test print one
copy to ensure the format of the document and the page margins appear the way you want
them to.
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Apply Text-Formatting Effects

You'll find a number of features in Word 2010 that help you create a pleasing, professional
look for documents of all types. Document themes let you choose a consistent color scheme,
font style, and object format; Quick Styles give you a gallery of text styles to apply to your
text; and the Font and Paragraph groups in the Home tab enable you to make changes to
individual words, phrases, lists, and more in the documents you create.

Now Word 2010 gives you the ability to add special touches to the format of your text. You
might use a special text effect to create a compelling headline, make a product name stand
out, or create an attention-getting banner for a flyer or brochure. You'll find the Text Effects
tool in the Font group of the Home tab. Clicking it reveals a list of ready-to-apply text ef-
fects, as well as a collection of artistic effects (Outline, Shadow, Reflection, and Glow) that
enable you to fine-tune the look even more. (See Figure 4-6.)
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FIGURE 4-6 Text effects give you the tools to format headlines and text elements to make them stand out.
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Tip Even after you've applied a special effect to your text, you can continue to modify the look
by making additional choices in the Text Effects list. You might change the bevel style of the
letters, for example, or add a glow to specially formatted text.

Preserve Your Format Using Paste with Live Preview

How often do you copy and paste something in the documents you create? Microsoft re-
search shows that Copy and Paste are two of the most often-used features in Word 2010;
users might copy and paste as many as 300 times per month. Both procedures are simple,
requiring only that you select the item you want to copy, click Copy on the Home tab, put
the cursor where you want the item, and click Paste. Simple, right?

The challenge was that pasting the text or object sometimes had unexpected results,
depending on where users pasted the item and what type of item was being inserted in
the document. In fact, users undo paste operations more than any other in Office 2010.
To answer this challenge and provide consistently what users expect, Copy and Paste have
been improved in Word 2010. Now more than 400 clipboard formats are supported to
make copying and pasting as easy and as reliable as possible while you're working on your
documents.

Step by Step: Pasting Content Your Way
Use Paste with Live Preview to get just the paste results you want.
The variety of paste formats and the flexibility Word 2010 offers you when you paste

text and objects in your document results in more reliable formats and less tweaking
after the fact. And that means better efficiency and reliable results. Nice!

This example shows you how to use Paste with Live Preview so that you can get the
results you want when you paste content in your Word 2010 document:

1. With your document open on the screen, highlight and copy the text or object
you want to paste. Click Copy in the Clipboard group of the Home tab or press
Ctrl+C.

2. Click at the point in your document where you want to paste the copied item.



Chapter4 Create and Share Compelling Documents with Word 2010 49

3. Click the Paste arrow in the Clipboard group of the Home tab. A Paste Options
gallery appears as you see here:
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“ Home Insert
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' paste Options:
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Paste Special..

Il

Set Default Paste,.,

4. Point to each Paste icon to see a live preview of the way the item will appear in
your document.

5. Click your choice. The item is pasted in the document as you selected.

You can also display the Paste Options gallery by right-clicking in the document at the
point you want to paste the copied information. After you paste the content, Paste
Options are displayed near the paste location in case you want to make a change:

[ (Curl)~

Paste oplilll:ls:_

& =|a

Set Default Paste...

]

@ Tip Paste with Live Preview is available in all Office 2010 applications, and the selections
displayed under Paste Options in the gallery vary depending on the type of content you have
copied to the Clipboard. To display the Office 2010 Clipboard, click the dialog launcher in the
lower right corner of the Clipboard group in the Home tab.

lllustrate Your Ideas

With Word 2010, you don't need to switch back and forth between software programs to
include professional-quality images in your documents. Using Word’s illustration features,

you can easily apply special artistic filters to your photos or capture screen shots to include in
your documents.
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Apply Artistic Effects

The Artistic Effects in Word 2010 give you a variety of filters you can apply to your images
to produce a wide range of special effects. For example, you might apply the Pencil Sketch
effect to convert an image to an artistic black-and-white rendering, or use the Paint

Brush effect to create a dramatic image of a new product.

To apply an artistic effect, simply select the image in the document you want to modify.
The Picture Tools contextual tab is available. Click Artistic Effects in the Adjust group.

(See Figure 4-7.) Preview the different effects by pointing to the effect you want to see; the
image is displayed with that particular effect. Click the one you want, and it is applied to
the image.

Tip Office 2010 offers enhancements to SmartArt in Word 2010, Excel 2010, and PowerPoint 2010.
Learn about SmartArt’s new features in Chapter 5, "Create Smart Data Insights with Excel 2010."
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FIGURE 4-7 Artistic effects enable you to apply a variety of special filters to the figures in a document.
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Insert Screen Shots

Adding pictures of your screen can come in handy when you are preparing team documents,
sharing procedures with others, or writing a process to let others know how to work with a
specific document. No matter what you might want to capture on the screen, Word 2010
makes it easy for you to grab the parts you need and include them in your document.

When you click the new Screenshot tool, available in the Illustrations group of the Insert
tab, a gallery of screen-shot options appears. (See Figure 4-8.) The images in the gallery are
thumbnails of the various applications you currently have active on your system. To choose
one of the screen shots, click it; the image is added at the cursor position in your document.
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FIGURE 4-8 You can insert a screen shot of any window currently open on your system.

Step by Step: Adding a Screen Clipping
Grab just the portion of the screen you want to include in your Word 2010 document.

Suppose that you want to quickly clip a segment of a worksheet to include in the report
you're writing. You can grab a screen shot of the worksheet and add it to your docu-

ment by following these steps:

1. Open the document in which you want to add the screen shot, and click where
you want to insert the screen shot.

2. Open the worksheet you want to use for the screen shot.

3. Display the document again, and click the Insert tab. In the lllustrations group,
click the Screenshot arrow and choose Screenshaot Clipping.

4. The worksheet automatically displays. Click in the upper left corner of the area
you want to clip, and drag across the area to be included.
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5. When you release the mouse button, the area is clipped and inserted in the
document at the cursor position.
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Improve Your Text

The Word 2010 Spell Check is smarter than ever; now it takes context into account as it
checks your document. And the Word 2010 language tools make it easy to translate on the
fly when you work with colleagues around the world.

Catch More Than Typos with a Contextual Spell Check

Have you ever received a document that was spelled right but included words that were used
incorrectly? Words such as their and there or seen and scene can easily be misused in a docu-
ment, causing a disconnect for your readers and clouding your message. The Word 2010
enhanced spelling checker now evaluates the words you use for the context in which they
appear, which helps you ensure that your documents are as correct as possible.
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Tip You can have Word 2010 check for grammar and style in your document, which includes
searching for punctuation, usage, clichés, gender-specific words, and more. To change the gram-
mar settings, click the File tab and then Word Options, click Proofing, and then click the Settings
button in the Writing Style area.

Start Spell Check by dlicking the Review tab and clicking Spelling & Grammar in the Proofing
group. The Spelling & Grammar dialog box shows you one by one any issues that the checker
discovers so that you can enter changes as you go. The Dictionary Language setting enables
you to look up the word in another language to see whether the usage or spelling is correct.
(See Figure 4-9))

Spelling and Grammar: English (.3

Mok in Dictionary,

four-color books, and electronic, downloadable - Ignore Once
publications that focus on awareness, education,
enjoyment, and advocacy for green living and
earthcare ideas. Add to Dictionary

i | Ignare All

Suggestions:
=arth care

Change
Change Al

AutoCorrect

Dictionary language: |English (U.5.) E

[¥] Check grammar

FIGURE 4-9 Now you can check the spelling and usage of words and phrases in dictionaries from
other languages.

| g
[

Tip If your spelling checker doesn't seem to be working properly in Word 2010, make sure
you've set your default language and that Spell Check isn't disabled. Here's how: On the Review
tab, click Language in the Language group and choose Set Proofing Language. In the Language
dialog box, click your primary language and choose Set As Default. When prompted, click Yes.
Now make sure the Do Not Check Spelling Or Grammar check box is clear. If a check mark
appears, click the option to clear the box; then click OK.

Use Language Tools, and Translate on the Fly

Many people now work in teams that span not only cities but continents. When you are
working with peers in Europe, Asia, or other continents, language differences can present
challenges. Word 2010 now includes enhanced language features that help you stay in sync
with the global workplace. Now you can translate words and phrases on the fly, and develop
documents that offer ScreenTips and Help in a variety of languages.
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Translating in Real Time

Another language feature in Word 2010 enables you to translate text easily as you work in a
document. Using the Translation Language tools, you can choose to show side-by-side trans-
lations, display the full document in a Web-based translated view, or use the Mini Translator
toolbar to translate words as you go.

Setting up the translation tools is simple. In the Language group of the Review tab, click
Translate. A list offers you four choices:

B Translate Document

B Translate Selected Text

B Mini Translator

B Choose Your Translation Language

Start with the last item first if this is the first time you're using the Translation tools. When
you click Choose Your Translation Language, the Translation Language Options dialog box
appears so that you can choose the language you're translating from as well as the language
you're translating to. (See Figure 4-10.) Click your choice for each option on the Translate
Document tab; then choose the language you're translating to on the Mini Translator tab.
Finally, click OK to save your settings.

Translation Language Dptions
| Translate Document

Mini Translator

7;_{‘5 Translate your document

From: |English [U.5)

To: Portuguese (Brazil) lz‘

FIGURE 4-10 Set your translation languages using the Translation Language Options dialog box.

When you choose Translate Document, a dialog box appears alerting you that the docu-
ment will be translated by the Web site WorldLingo and displayed in your browser online.
To continue the operation, click Send and your document is translated and displayed in your
Web browser window.

To translate a specific phrase or paragraph, begin by highlighting the text you want to trans-
late; then click Translate and choose Translate Selected Text. The Research pane appears on
the right side of your document window, and the text you selected is translated, according
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to the language you selected. You can modify the settings by choosing new options in the
Research pane.

Finally, to translate words and phrases on the fly, you can use the Mini Translator tool. This
convenient little toolbar enables you to translate text as you go by simply hovering the
mouse over the word you want to translate. (See Figure 4-11.) This can help you review text
quickly and double-check your translations.
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FIGURE 4-11 The Mini Translator enables you to translate words, phrases, or blocks of text as you work.

Tip The Mini Translator tool also includes an audio feature that will read back the text you se-
lect in your document. Simply highlight the text you want to hear, choose Mini Translator in the
Translate list, and click the Play button on the Translator tool.

Co-Author and Share Documents

Word 2010 makes it easy for you to work collaboratively with others whether they work
down the hall or on the other side of the world. Co-authoring features in Word 2010 make

it possible for multiple authors to work on a file at the same time and contact each other

in the process. And using SharePoint Workspace 2010 or Windows Live, you can save to an
online workspace, communicate with coauthars, and keep track of changes in the file with-
out e-mailing multiple documents back and forth or running the risk of overwriting changes
another person on your team has made.

The co-authoring capabilities require SharePoint Foundation Services (for business clients)
or Windows Live (for personal use). When you post a document to your SharePoint
Workspace or Windows Live SkyDrive space and invite another author to share it with you,
you will be able to see indicators in the document when the other author makes changes.
(See Figure 4-12.) At each point the author makes changes, you see the author's name and
a presence indicator that shows you the author’s online availability.
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FIGURE 4-12 When you co-author a Word 2010 document, you can see who else is working on your shared
document at the same time.

Tip The instant messaging, presence, and voice call features require Office Communicator 2007
R2 and Office Communicator Server 2007 R2, Windows Live Messenger, or another instant-
messaging program that waorks with IMessenger.
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Overview: Introducing Presence

Presence technology is all about being able to reach team members whenever they are
present online. In Office 2010 Presence is available for systems running Microsoft Office
Communicator 2007 R2, enabling you to see at a glance which of your coauthors are
available online to answer questions, chat about your project, or talk about next steps.

Joanna 4 + X
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Department  Managed Business

Office 3645
wWork Hirz
Maobile
Home
E-mail
Calendar Free for next 8 hours
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Office 2010 applications that support presence display a small green icon beside a
person’s name in a status bar list when they are available for contact. When you hover
the mouse over the person’s name, a pop-up list of options for contact appears. You
can send an instant message, open a chat window, compose an e-mail message, or ini-
tiate a phone call by dlicking ene of the communication options. You can also click the
menu to display the contact’s full contact information and discover additional ways of
making contact.

Working with Shared Documents

You can easily add authors to documents you're working on and share files using SharePoint
Workspace 2010 or Windows Live SkyDrive. You first post the files you want to share and
invite authors to the SharePoint workspace or SkyDrive folder. Once you begin working with

the shared document, Backstage view gives you information about the shared file, as you see
in Figure 4-13.
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FIGURE 4-13 You can add the names of coauthors in Backstage view and check documents stored in the

shared workspace for the
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ments Anywhere

Picture this: You are rushing out the door to get to a meeting uptown. You had hoped to put
the finishing touches on the client report you need to share with the team, but because your
afternoon meeting ran long you were unable to finish it. Now you're on the train and have a
few minutes to spare. Luckily, you can access Word 2010 on the Web and wrap up those last

few details.
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Use Word Web 2010

By logging into Windows Live, accessing your SkyDrive folders, and opening a Word 2010
document you've posted there, you can access the familiar Word 2010 tools and features so
that you can complete your document on time. Log in to your account, choose SkyDrive (in
the More menu), and open your My Documents folder; then click the document you want
to work with. Click View to open the file. In the Word Web App window, you can simply re-
view the file (if you don't want to make any changes). Figure 4-14 shows the Word Web App
window.
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FIGURE 4-14 You can review the document, do light editing to it, and even print it from the Web.

If you click Open in Word, the Word Web App will ask for your Windows Live login informa-
tion. After you provide it, the document opens in Protected view. (Protected view is always
used when a file is downloaded from an Internet location.) Click Enable Editing to activate
editing mode, and the document opens in Word 2010. When you save the document,

the changes you made are synchronized with the online document with no further action

from you.
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Check Your Document with Word Mobile 2010

Need to take a quick look at a customer document before that important meeting? Or
perhaps you want to sign off on a report so that others on your team can share it right away.
With Word Mobile 2010, you can use the familiar Word 2010 experience to display and
search your document, make simple changes, and save and finalize the file.

With Word Mobile, you can easily open, view, edit, and copy and paste information in your
Word documents—using your smartphone. Spell Check and AutoCorrect are available to
help you make sure your edits are accurate.

The document formatting—even in tables, charts, and graphics—will be preserved on your
phone display, thanks to Office Mobile's Text Reflow technology. You can use all the familiar
formatting basics—bullets, numbering, fonts, paragraph formats, and more.

You can also send your document from your smartphone by e-mail to a friend or colleague
or post it to your SharePoint workspace.

Word Mobile 2010 is not part of Office 2010, but the software will be available at the release
of Office 2010 for phones using Windows Mobile 6.5 or later.



Chapter 5
Create Smart Data Insights with
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In this chapter:
B Start Out with Excel 2010
B Summarize Your Data Easily
B |llustrate Information Effectively
B Show PivotTable Data Your Way
B Work Anywhere with Excel 2010

Helping others understand the information you present—whether you work with words,
numbers, pictures, or media—is a key part of success in any business environment. The big
story in Microsoft Excel 2010 includes new features that help you convey your findings in
ways others can easily understand. Sparklines are small, cell-sized charts you can add to your
worksheet to provide a visual summary of the data in selected ranges; new icon sets and im-
provements to data visualization options give you greater variety in the way you present in-
formation; SmartArt and charting enhancements offer additional flexibility; and slicers enable
you to graphically slice-and-dice your PivotTable to display just the information you want to
show at any given time.

And Excel 2010 also includes new offerings for the high-end spreadsheet user: new
formulas, support for spreadsheets with millions (yes, millions) of rows, and the integra-
tion of SharePoint 2010 and Excel Services, which enables you to publish worksheets and
dashboards to your intranet or to the Web. This chapter touches on the top new features in
Excel 2010 and encourages you to give a few of them a try.

Start Out with Excel 2010

The Excel 2010 window offers you an open, visually inviting workspace that presents
everything you need to work with multiple worksheets, enter formulas and cell values, and
change the way you view information on the screen. Figure 5-1 introduces you to the various
elements in the Excel 2010 window.
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FIGURE 5-1 The Excel 2010 workspace gives you plenty of room onscreen while providing the tools you need.

Tip You can hide the display of the Ribbon to maximize your space onscreen by clicking the
Minimize The Ribbon button in the upper right area of the Excel 2010 window.

The Office 2010 Ribbon includes eight tabs, each with groups of tools related to a specific
focus: File, Home, Insert, Page Layout, Formulas, Data, Review, and View. For example, to add
a SmartArt diagram to the current worksheet, you click the Insert tab and choose SmartArt in
the Illustrations group. A group of SmartArt tools appears in the Ribbon in a contextual tab
to provide the tools you need for creating and customizing SmartArt. (See Figure 5-2.)

You'll find many of the new tools and enhancements in Excel 2010 on the Insert tab.
Specifically, the Screenshot tool in the lllustrations group, the Sparklines group, and the Slicer
tool in the Filter group are all new. The following sections introduce you to these features in
more detail.
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FIGURE 5-2 Contextual tabs display tools you need only when you are working with a specific item on your
worksheet.

Summarize Your Data Easily

Your worksheets enable you to organize, track, and calculate financial information over time.
An important part of making sense of the data you gather—and sharing what you find—in-
volves communicating the results in a way others can easily understand. Sparklines are small,
cell-sized charts that appear within your worksheet, giving readers a quick picture of what
the numbers on the worksheet mean. Because sparklines stay with your data (unlike a chart,
which might appear in a section of the worksheet some distance from the data it reflects),
they show clearly the relationship among the data values used to create them.

You can create three kinds of sparklines in Excel 2010. The program offers you the choice of
line, column, or win/loss sparklines:

B |ine sparklines show trends and changes in values over time.
B Column sparklines enable you to compare values.

B Win/loss sparklines enable you to analyze values in relation to a norm.
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Step by Step: Add Sparklines to Your Worksheet

Here's how to summarize your data easily with sparklines.

You can add sparklines at any point in your worksheet where you want to show data
trends, comparisons, or summaries. Here are the steps to add sparklines and customize
them to meet your needs:

1.

5.

6.

Open a worksheet or create a new worksheet in Excel 2010. If you are creating a
new worksheet, enter the data you want to use as the basis for the sparklines.

Click and drag to select the cells that include the data you want to show in the
sparkline.

Click the Insert tab, and click the type of sparkline you'd like to create: Line,
Column, or Win/Loss.

The Create Sparklines dialog box shows the range of cells you selected in the top
data field.

B9~ coffees] - Microsof Excel (Technical Preview)
File Home | insert | Pagelayost  Fommulas  Date  Review  \View

Filter Links Text Symbals

[
>
-
O.
=]
-
L
-
q
|
=
D[]

G | H

2009 Sales

Name

5 |HM1234  Ultra Roast PROS41  C
§ HM1235 BreskfastBlend PROSAL A | Choosethe data the you went 5850 3822 4202
7 HM1236 FrenchRoast PROSSL A i B o fes22 s 3a
8 HM1237 OrganicBlend AB7243 B 1509 00 4830
5 HMI1236 HouseBlend  PROS4L B | Choosswhere youwmant the spardines to be placed 1525 2340 2748 =l
10 HM1239  Sumatra ABT24D A Location Range: | $15 | 2311 2430 278
11 HM1240 Verona ABT43 A ose7 2803 2511
=

Dark Bean PROG4L

HIM1241

-

23, |
W 4 v ¥ Sheetl Sheatz ~‘Shests ¥3 4 [ vfi] |
Point | | S o0 i

Click in the Location Range field of the Create Sparklines dialog box, and then
click the cell on the worksheet where you want the sparkline to appear.

Click OK. The sparkline is added to the document.
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7. Click the elements in the Show/Hide group of the Sparkline Tools Design tab to

customize the appearance of the sparkline you added. As you click your choices,
new points are added to the examples in the Style gallery, as shown here:

=

HwY-¢-|s coffeesl - Microsoft Excel (Technical Preview)
m Homme Insert Fage Layout Farmulas Data Review Wiew Design

[7] High Point [2 First Point &, sparkiine Color »

w7 | e © -
? [ Lows Point [ 1ast Point " - [ Marker Calor -
Edit Line |Column Win/loss 3
Style

Data - | [¥] Megative Points [#] Markers
Sparkline Type Showt

. Click the Sparkline Color arrow to display the palette and set the color of the

sparkline.

. Click the Marker Color arrow to choose the color of the markers displayed on the

sparkline.

10. After you set the sparkline formatting options as you want them, you can copy

and paste the sparklines to other cells in the worksheet. Excel will update the
references to show the correct sparkline representation in the cell.

Note The formatting options for sparklines are group-based, which means that making changes
to one sparkline changes the format of all sparklines in the series. To change an individual spar-
kline (for example, to make the color of one sparkline stand out), remove it from the group by
clicking it and choosing Ungroup in the Group area of the Sparkline Tools tab.

Tip To delete an unwanted sparkline from the worksheet, click the sparkline, click Clear, and
then click Clear Selected Sparklines in the Group area of the Sparkline Tools tab.

lllustrate Information Effectively

Especially when they are reviewing large worksheets, people who are unfamiliar with the
data you're presenting might not be drawn instantly to the key points you want them to

understand. To help you spotlight important data elements on your worksheets, Excel 2010

includes a number of conditional formatting features. Here are a few of the elements that
draw readers’ attention to important data and help communicate what the data represents:

Icon sets display small icons in data cells that spotlight high, mid, and low values, for
example.

65

m Data bars enable you to show how values in a range of cells compare with one another.
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Call Attention to Your Data with lcon Sets

When you want to call attention to a specific range of cells in your worksheet, consider using
icon sets to do it. [con sets are small pictures that appear with the data in a cell to help the
reader evaluate what the value means. For example, a cell showing a low sales value might
display a red flag, while a cell showing a top sales value could display a green flag.

Excel 2010 includes a number of new features that enhance the capabilities of icon sets. New
icon sets include new ratings sets, such as stars and boxes, and you can customize the for-
matting and display choices for icon sets so that you can create exactly the display you want.

Step by Step: Use Improved Icon Sets to Highlight Data

You can spotlight key data values easily with icon sets.

Excel 2010 includes 20 icon sets in four categories: Directional, Shapes, Indicators, and
Ratings. Now you can easily format and customize the icon sets so that they show those
viewing your worksheet what's most important and why. Data bars now show gradients
relative to the values they display, and you can show both positive and negative values
in data bars. In short, you have more control over the visualizations you choose for your
worksheet data. Follow these steps to use an icon set to display worksheet values:

1. Open the Excel worksheet you want to use.

2. Select the individual cell or range of cells where you want to add icon sets.
3. Click Conditional Formatting in the Styles group of the Home tab.
4.

Click Icon Sets, and a list of icon sets appears, as you can see here:
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5. Click the icon set you want to apply to the selected cells.

6. To customize the icon set, select the cells, click Conditional Formatting in the
Styles group of the Home tab, and click Manage Rules.

7. In the Conditional Formatting Rules Manager, click Edit Rule. The Edit Formatting
Rule dialog box appears, as shown here:

Edit Formatting Rule EA==

» Format only kop or boktom ranked values
» Format only values that are above or below average

» Format enly unique or duplicate values
» Use a formula to determine which cells to Format

Edit the Rule Description:

Format all cells based on their values:

Format Style:  |1con Sets lz‘ Reverse Icon Order

Icon Style: [ Show Icon Only

Display each icon according to these rules:

Icon Yalue Type

when value is = lz‘ 67 Percent El
when < 67 and >= [=] |33 Percent ||
when < 33

8. You can change the display of an individual icon by clicking the down arrow to
the right of the icon you want to change and choosing a new icon.

9. Change the range of values represented by the icon by changing the Value and
Type settings for each icon.

10. Click OK to save your changes. The worksheet displays updates automatically.

Tip You can do much more with icon sets in Excel 2010. To learn more about the different ways
you can spotlight the data on your worksheets, see Microsoft Office 2010 Plain and Simple by
Jerry Joyce and Marianne Moon (Microsoft Press, 2010).
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Data Bar Improvements

Data bars offer another type of conditional formatting element in Excel 2010 that help you
analyze data values in a range of cells. Enhancements to data bars make it possible for you
to include negative values and apply formats that make the data bars easier to understand.
(See Figure 5-3.)
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FIGURE 5-3 Now in Excel 2010 you can add data bars that reflect negative as well as positive values.

Step by Step: Compare and Analyze Values with Data Bars

Data bars help you show at a glance how key data values compare to one another. You
can use data bars to display a range of values that can include both positive and nega-
tive numbers.

1. Select the range of cells where you want to add data bars.
2. Click Conditional Formatting in the Styles group of the Home tab.

3. Click Data Bars to display the list of data bar styles you can apply to the selected
cells, as shown here. As you point to each data bar style, the selected range
previews the choice. Click the style you want to apply.
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4. Add negative value capability by clicking Conditional Formatting again and

choosing Manage Rules.

5. In the Conditional Formatting Rules Manager, click Edit Rule. In the Edit
Formatting Rule dialog box, click the Negative Value And Axis button.

6. In the Negative Value And Axis Settings dialog box, select the fill color and axis
settings you want to apply to the negative value display. You can also set the axis

color.

Negative Value and Axis Settings )

MNegative bar Fill color

7 Apply same Fill color as positive bar

Megative bar border color

Border color: E

@ apply same border color as positive bar

Axis settings
Select axis position in cell to change the appearance of bars for negative values
@ Automatic (display at variable position based on negative values)
) Cell midpoint

) Mone {show negative value bars in same direction as positive)

#Auxis color:

7. Click OK to apply your changes. The data bars appear in the selected cells,

showing any negative values as you selected.
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Tip You can change the way the data bars appear in your cells by choosing either gradient or
solid fills. Additionally, you can customize the way the fills and borders look to create the best
look for the data displayed on your worksheet.

New SmartArt Enhancements

SmartArt diagrams give you a simple way to add professional diagrams to your worksheets,
documents, and presentations. Whether you need to create an image that links product
descriptions to the values on your worksheet, spotlights key initiatives your data reflects,

or helps new hires learn your sales tracking process, you can use SmartArt to organize and
depict your thoughts easily and effectively.

Excel 2010 adds a new set of SmartArt graphics to the mix, enabling you to choose from
additional layout styles and incorporate pictures easily in the diagrams you add to your
worksheet. Now expanded support for text gives you more flexibility for the descriptions you
provide so that you can let the image further explain the connections between worksheet
data and the images the diagram presents.

Use Slicers to Show Data Your Way

Using Excel 2010 you can track, analyze, and report on the information you gather about
your organization. Displaying the data you need and making decisions based on the insights
you gather is an important part of working effectively in Excel. Excel 2010 includes a new
feature called slicers, which enable you to slice your data easily and include only the elements
you want in the PivotTables and PivotCharts you create. Using slicers, you can easily add

and remove elements from the table display, which helps you compare and evaluate data
from different perspectives. What's more, you can use the slicers you create with multiple
PivotTables and PivotCharts to showcase your data consistently in a variety of scenarios.

Step by Step: Use Slicers to Segment Data Display
Use these visual controls to move data elements in and out of your PivotTable display.
1. First create the PivotTable you want to use with the slicer you create.
2. Click the PivotTable to select it.
3. Click the Insert tab, and click Slicer in the Filter group.
4

. Inthe Insert Slicers list box, click the field you want to use to slice the PivotTable
data. In the example shown here, Cost is used to select a specific data value to
display.
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5. Click OK. The slicer appears on the worksheet.

Cost

$3.00

[ $14.00

$16.00
$15.00

9

Row Labels [+|Sum of Qty

Breakfast Blend
French Roast
Houge Blend
Sumatra
Verona

Grand Total

1843
1254
780
250
925
5752

Tip You can attach a slicer you create to another PivotTable connected to the current worksheet
by clicking the slicer and choasing PivotTable Connections in the Slicer group of the Slicer Tool

Options tab. Select the PivotTable to which you want to add the slicer and click OK.
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Note You can easily change the look of the slicers you add to your worksheet by clicking the
Slicer Tool Options tab and changing the slicer caption, style colors and effects, button size and
format, and overall size of the slicer window.

Tip PowerPivot for Excel is a new add-in (previously called “Project Gemini”) available with Excel
2010 that supports extremely large worksheets of up to 2 gigabytes (GBs). PowerPivot enables
you to model and analyze data on worksheets that include literally millions of rows and to sort,
filter, and use table lookup functions on multiple tables in Excel 2010.

Work Anywhere with Excel 2010

Chances are that the worksheets you create are changed, shared, and improved over time.
Perhaps you start a draft and share it with your team, and each person takes responsibility
for updating a specific section for the final version. When all the pieces are finished, you can
review the finished version and save and distribute the file you've created. Along the way,
you check on worksheet changes, make suggestions, answer questions, and add data visu-
alizations, charts, and PivotTables that help showcase the results you want readers to under-
stand. Using both Excel 2010 Web App and Excel Mobile 2010, you have the ability to view
your worksheet from any point you have Web or phone access and make sure the worksheet
is developing according to plan.

Excel 2010 Web App

Using the Excel 2010 Web App enables you to view your worksheet using SharePoint
Workspace 2010 or Windows Live and work with your favorite tools and features to do light
editing, review content, and work collaboratively. The Web window, shown in Figure 5-4,
offers the consistent look and feel of the Excel 2010 interface and enables you to view, edit,
open, format, recalculate, search, and refresh the data connections in your workbook.

Tip In Excel 2010, Excel Services is integrated with SharePoint 2010, enabling you to share your
analyses with others in your organization. If you have SharePaoint Server 2010, you can share your
worksheet in Excel Services by clicking the File tab, and, in Backstage view, clicking Share. Finally,
choose Publish To Excel Services.
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Excel Mobile 2010 has been designed specifically to give you a simple, intuitive interface
even on your smartphone's small display. The fonts, bullet styles, and worksheet display make
it simple for you to navigate your worksheets and find what you need easily. What's more,
when you make changes to your worksheet using Excel 2010 Mobile, worksheet values are
recalculated instantly—no syncing required.

With Excel Mobile, you can easily create, view, and recalculate your workbooks, and you can
add charts as needed. The worksheet on your phone will support 140 different functions, so
you won't trade processing power for flexibility when you're crunching numbers on the road.
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FIGURE 5-4 Excel Web App enables you to view, edit, format, and work collaboratively in your worksheet.

Excel Mobile 2010.






Chapter 6
Manage Rich Communications with
Outlook 2010

In this chapter:
B Starting Out with Outlook 2010
B Managing Your Conversations
®  (Cleaning Up Your Messages
B Streamlining E-mail Tasks
B Coordinating Calendars
B |Improving the Look of Your Messages

B Keeping in Touch with Outlook Mobile

Communication is at the heart of everything you do. Whether you are finishing a report for

others to review, posting a new document for human resources, wrapping up a presentation
for the sales staff, or setting and scheduling appointments with clients, being able to stay in

touch with key people is a vitally important part of your daily activities.

Today's computer user receives close to 100 e-mail messages a day, and that volume is
steadily increasing. To manage so much e-mail effectively, you need to be able to separate
the necessary messages from the unnecessary ones. Microsoft Outlook 2010 includes a
number of new features that enable you to easily manage the messages you receive, track
important conversations, and automate your common messaging tasks. What's more, you
can stay up to date with all your friends and colleagues via social networks and communicate
in real time using instant messaging—all within Outlook 2010. This chapter introduces you to
the new features in Outlook 2010 that help you get control of your Inbox, communicate eas-
ily with your team, create and use group schedules, and access Outlook from your browser.
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Out with Outlook 2010

The Outlook 2010 window gives you all the tools you need for managing e-mail and working
with calendars, contacts, and tasks. The work area is divided into five separate panes (as
described in the following list and shown in Figure 6-1), each providing you with a different
way to work with the information you see:

B The Navigation Pane enables you to choose what you want to do. The top of the pane
displays favorite folders, the center shows all active folders in Outlook 2010, and the
bottom area enables you to choose the view you want to see.

B The Inbox (in Mail view) lists the e-mail messages you receive, arranged according to
your selection.

B The Reading Pane enables you to read the selected e-mail message without opening it.

B The To-Do Bar lists the calendar of the current month, appointments for the current
week, and your upcoming tasks.

B The People Pane shows you any social media information available for the person
sending the current message, and it lists files, appointments, and notes related to that
person.
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FIGURE 6-1 The Outlook 2010 window provides you with different ways to work with messages,

appointments, and tasks.
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Using the Outlook 2010 Ribbon

Outlook 2010 includes the familiar Ribbon, designed to give you just the tools you need for
the type of operation you're performing. The Ribbon offers seven tabs (File, Home, Send/
Receive, Folder, View, Add-Ins, and Conferencing), giving you specific tools to manage the
volume of messages, tasks, and appointments you create and receive. The Ribbon display
changes based on the view you display. For example, Figure 6-2 shows the Home tab when
Calendar view is active.

1E 9 |= Calendar - Microsoft Outlook (Technical Preview) = B 2
Hoime Send / Receive Folder e Ldd-Ins Conferencing [ o
e ;@ |§ I o | [ e ﬁ ﬁ.,= ?'—'1 '@s = share catendar Find a Contact
g5 E HERH | [ | ezovs) g
— == B =1 7 Publish Online (4 dtdress Book
New Mews Today MNext?7 Day  Work Week Month Schedule Open  Calendar E-mail ~
Appointment Meeting = Ttems * Days Week - Wiew  Calendar = Groups = | Calendar & Calendar Permissions

Mew GoTo 3 Arrange i | Manage Calendars Share Find

FIGURE 6-2 The Calendar view Home tab includes groups and tools for creating arranging, managing, and
sharing calendars.

Tip In Outlook 2010, you can easily customize the Ribbon to add new groups or organize tools
so that they are available just the way you want them. Click File, choose Options, and click the
Customize Ribbon category to change the way the Ribbon is displayed.

Setting Preferences with Backstage View

You'll also discover that Outlook 2010 shares Backstage view with the rest of Office 2010,
enabling you to add new e-mail accounts; medify your account settings; set up automatic
replies, rules, and alerts; and specify mailbox cleanup options. (See Figure 6-3.) Backstage
view makes it easy for you to view and change settings for one or maore e-mail accounts that
you use with Qutlook 2010.

Tip Want to use Outlook 2010 for your various e-mail accounts? Display Backstage view,
click Account Settings, and click Add Account to add your other communications connections
(including text messaging services) to Outlook.
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FIGURE 6-3 You can add e-mail accounts, set out-of-office replies, and more from Backstage view.

Managing Your Conversations

Conversation view is one of the big improvements in Qutlook 2010, enabling you to see at

a glance the important messages in a conversation thread. With Conversation view, you can
stay on top of changing information, make decisions in a flash, and opt out of conversations
that no longer require your input. In addition to gathering related messages in one conve-
nient thread, Conversation view makes it easy for you to categorize, remove, or clean up the
messages you don't need, which cuts down on the clutter in your Inbox.

When you open Outlook 2010, your messages are displayed in Conversation view by
default, with the most recent messages first. The Reading Pane shows the first message in the
selected conversation. (See Figure 6-4.)

In addition to viewing and responding to messages in Conversation view, you also can
organize your conversations to streamline your message-management tasks. For example,
you can choose the Move tool in the Actions group of the Home tab to tell Outlook to place
the current conversation in a specific folder. When you choose the feature Always Move
Messages In This Conversation, Outlook 2010 enables you to specify the destination folder so
that all messages related to the current conversation are stored in that folder automatically.
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FIGURE 6-4 Use Conversation view to track conversations and bow out when they no longer require your
attention.

Step by Step: Following E-mail Conversations

Follow these steps to use Conversation view in Outlook 2010:

1. When you first open Outlook 2010, Conversation view is displayed by default. If
you have changed to another view, return to Conversation view by clicking the
View tab and choosing Conversation in the Arrangement group.

2. Inthe Inbox area, click a conversation group you want to view. The group expands
to show the messages most relevant to the conversation thread, as shown here:

Search Inbox (Ctri+E) ,O.

Arrange By: Conversation| Newestontop = *

4 Today
3 Emailing: Edgar_and_Elliot U]
b Spiit conversation Latest message showr
17 = e
= L.. Kate

® |4 Katherine U]
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3. Todisplay all messages in the thread, double-click the first message in the
conversation. The list expands to show all the messages that have been sent in

this thread.

After you've read the conversation, you might want to organize it in any of the
following ways:

B Ignore further messages in this conversation by choosing Ignore in the Delete
group of the Home tab

B Clean up the conversation and remove redundant messages by choosing
Clean Up Conversation in the Clean Up selection of the Delete group (also in
the Home tab)

B Move the conversation to a specific folder by clicking Move and choosing the
selection you want in the Actions group on the Home tab.

Cleaning Up Your Messages

Many of the e-mail messages we receive on a daily basis are unnecessary, and yet because
of the volume of messages we receive we might not organize or remove them as soon as we
read them. Qutlook 2010 provides the Clean Up command to help you remove redundant
messages from your Inbox.

You will find the Clean Up tool in the Delete group of the Home tab. When you click the

tool, you are given the option of cleaning up the current conversation, cleaning up a specific
folder, or cleaning up the current folder and any subfolders it contains. Simply click the item
you want and Outlook 2010 displays a message box telling you that any redundant messages
removed will be placed in your Deleted Items folder. (See Figure 6-5.)

Clean Up Falder (]

4l redundant messages in the current Folder will be
(& moved to the Deleted Items Folder,

[ pon't show this message again

[ Settings ] [ Clean Up Folder ] [ Cancel ]

FIGURE 6-5 Outlook 2010 makes it easy for you to clean up conversations, folders, and subfolders and weed
out unnecessary messages.
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Streamlining E-mail Tasks

Most likely, you perform many of the basic Outlook tasks regularly: you check e-mail,
respond to e-mail, set appointments, schedule tasks, and track contact information. For this
reason, the designers of Outlook 2010 set out to save you time and streamline your tasks by
giving you the ability to do those tasks with a single click. Using Quick Steps, you can per-
form common tasks with a single click of the mouse button. For example, you might forward
a message to your manager, reply to a meeting, or send a team e-mail message with a single
click.

By default, Outlook 2010 includes a set of 10 Quick Steps available in the Quick Steps group
of the Home tab. (See Figure 6-6.) You can easily set up these Quick Steps to do what you
need them to do or create your own Quick Steps based on other common e-mail tasks.

_:] Move ko: 7 _ID Move to: 7
’3 Meeting Reply £ Forward: FYT -
i To Manager 2 Team E-Mail - 7

Quick Steps

FIGURE 6-6 Quick Steps enable you to complete routine tasks with a single click of the mouse button.
Table 6-1 introduces you to each of the Quick Steps that come ready to use in Outlook 2010.

TABLE 6-1 Introducing Quick Steps

Quick Step Description

Move to:? Prompts you to choose a folder, and gives you the option of Move To
Folder/Mark As Read

Forward: FYI Forwards the selected message, and adds "FYI." to the beginning of the
subject line

Team E-Mail Displays the Customize Quick Step window so that you can enter the
e-mail addresses of teammates and set up the feature

Reply & Delete Displays the Reply window, and deletes the existing message after you
click Send

Create New Enables you to create a new Quick Step

Meeting Reply Sends a meeting response to the sender

To Manager Automatically sends a message to your manager

Done Moves the current message to a folder you specify, and marks the

message as complete

Team Meeting Creates a new meeting request for your team
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Step by Step: Create a Custom Quick Step
Quick Steps were designed to simplify your common e-mail tasks. The following steps
show you how to create a new Quick Step to fit your needs:

1. Enter a new name for the Quick Step.

2. Inthe Actions area, click the down arrow to the right of Choose An Action, and
select the item you want to add from the displayed list, as shown here:

Edit Quick Step =

Ji Mame:
7 My Quick Step

Add actions below that will be performed when this quick step is clicked on,

Actions

Choose an Action X
_ 7

Filing
3 Move to folder

-y

25 Copy to Folder

X Delete message

X Permanently delets message
Change Status
=4 Mark as read
(¥ Mark as unread

! Set importance
Categories, Tasks and Flags
Categorize message
Clear Categories
Flag Message

Clear flags on message

g
-4 - 58 B8

-

Finish Cancel

3. Click Add Action.

4. Click the Shortcut Key arrow, and choose a shortcut key from the list if you want
to assign one.

5. Enter text to describe the action in the Tooltip Text text box.

6. Click Create.

@ Tip The Quick Contacts feature enables you to locate contacts quickly in Outlook 2010. In the
Find group on the Home tab, simply click in the Find A Contact box and type the first few char-
acters of the person’s name. If you are using Office Communicator, a list of contacts that match
the characters you typed appears toward the bottom of the To Do Bar. If you are not using Office
Communicator, when you press Enter, the Choose Contacts message box appears, listing all con-
tacts that match the characters. Choose the contact you want by clicking the name and clicking
OK. The person's contact record is displayed so that you can review or modify it and save it.
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Working with Presence and Social Media

@

When you are waorking collabaoratively, being able to tell when teammates are online and
available to answer a quick question is a definite plus. Outlook 2010 provides presence and
status information for your contacts so that you can easily communicate with others in real
time. When the green presence indicator shows you that a coworker is online, you can make
a quick call, start a video conference, or take a few minutes to meet virtually—communica-
tion that enables you to keep your project moving forward.

If you are working with Qutlook Web App or using Office Communicator, you will be able to
see the presence information in the Reading Pane and in the Contacts list. Hover the mouse
over a name in the message header to display a complete contact card with pictures and
contact information. (See Figure 6-7)
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FIGURE 6-7 Outlook 2010 includes presence information for your contacts in Outlook Web App and Office
Communicator.

Tip If you are using Outlook with Microsoft Exchange 2010, the MailTips feature enables you to
double-check the e-mail messages you send. MailTips alert you when you are sending messages
to contacts outside your office, replying to a large distribution list, or sending a message with
confidential information.
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The People Pane at the bottom of the Reading Pane shows you the sender’s profile picture
and gives you access to additional information about that person—her recent status update,
any files she sent you, upcoming relevant appointments, and more. You can sign up with
third-party social media sites and receive status updates and profile changes without ever
leaving Outlook 2010. (See Figure 6-8.)

FW: Doc for Co-authoring.doex

Kathering Murray [kmurray220@sbeglobal
Sent Wied 11442009 6:53 M
# katherine

] Message ®Docfor Co-authering.docx (37 KB)
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To: Kathering

Subject: Doc for Co-authoring, docx
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[ FOd0&.bmp (2307 KB)

FIGURE 6-8 Outlook 2010 incorporates social media features that enable you to stay in touch with friends
and colleagues through social media.

Coordinating Calendars

One of the challenges to keeping a team moving in the right direction involves finding a
time to meet when everyone can attend. The new scheduling features in Outlook 2010 make
viewing, updating, and sharing calendars easier than ever. And you can easily create Share
groups so that all scheduling information for your team is kept together in one easy-to-
understand view.

Viewing Group Schedules

The new Schedule view enables you to easily combine a number of calendars on the screen
at one time. This makes setting appointments simple and enables you to coordinate the free
and busy time your group needs to get things done.
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Step by Step: View Calendars in Schedule View

You can easily view the calendars of everyone on your team using Schedule view:
1. First, make sure that others on your team have shared their calendars with you.
2. Click Calendar.

3. In the Home tab, click Schedule View. The display shows the calendars that you
have permissions to view, along with busy and available times, as shown here:
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Create a Calendar Group

If you are part of a team that works together regularly, you might want to create a calendar
group so that you can easily view all schedules together. You can create a calendar group
by clicking Calendar Groups in the Manage Calendars group on the Home tab. If you want
to save the group of calendars in the current view as a calendar group, click Save As New
Calendar Group. If you want to select a new set of calendars and create a group, choose
Create New Calendar Group. With either selection, the Create New Calendar Group dialog
box appears. (See Figure 6-9.) Type the name you want to use for the group, and click OK.
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Create News Calendar Group

Type a name For the new calendar group

FIGURE 6-9 Create a calendar group to display all schedules for your team.

After you create the calendar group, the group name appears in the navigation pane on the
left side of the calendar window. (See Figure 6-10.) You can hide the display of the group
when it's not needed by clearing the check box; to redisplay the calendar group, select the

check box again.
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FIGURE 6-10 After you create a group calendar, Outlook 2010 adds it to your Calendars list.

Improving the Look of Your Messages

Now you can apply the professional designs available in Office 2010 themes to the e-mail
messages you create and send. Outlook 2010 includes dozens of themes you can apply to the
messages you send to clients, peers, friends, and family. When you apply an Office theme to
your message, the colors and fonts that are part of that theme are reflected in the styles you
choose to format the text in your message. Later if you choose to change the selected theme,
the styles you use will also change automatically to reflect the new styles.
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The Office themes also are consistent throughout all your Office 2010 files, which means that

you can coordinate the files you send so that the message you send can have the same look
and feel as the files you attach to it.

Step by Step: Applying Office Themes

Adding an Office theme to your e-mail messages is as simple as point and click. Here's
how to do it:

1. Open the message to which you want to apply the theme.
2. Click the Options tab.

3. Click Themes. The Themes gallery appears, as shown here:
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4. Hover the mouse over themes you want to preview.

5. Click the theme you want to apply to the message.

Note You can choose different fonts and colors from those offered by a specific Office theme,

but if you later change the Office theme applied to the message, the fonts and colors you
changed will not be updated automatically.
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Keeping in Touch with Outlook Mobile

In today's mobile world, many people are accustomed to checking e-mail, receiving text
messages, and updating their calendars online. Now, using your Windows Mobile smart-
phone, you can use the high-quality phone display to view your messages in Conversation
view, selecting and moving messages using touch technology, and get online access to your
calendar, contacts, tasks, and more.

@ Tip Let Outlook 2010 know which types of alerts you want to receive on your smartphone by
clicking File, choosing Options, and clicking the Mobile category in the Outlook Options dialag
box. Select the appropriate check boxes if you want Outlook to send calendar summaries and
reminders to your smartphone. Additionally, you can arrange to forward Outlook items to your
phone or find a text-messaging service provider and set up your phone for Short Messaging
Service (SMS) messaging.

Outlook Mobile is also available to Microsoft Exchange customers as part of the standard
licensing agreement.
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Produce Dynamic Presentations with
PowerPoint 2010

In this chapter:
B Starting Out with PowerPoint 2010
B Editing and Formatting Video
®  Creating and Working with Animations
B Enhancing Your Presentation with Transitions and Themes
B Adding Sections to Your Presentation

B Managing and Sharing Your Presentation

Imagine this: You're in a crowded board room waiting for your chance to present new ideas
to a prospective client. You and your team have been working on this presentation for weeks.
The content is just right—the approach hits the mark, and you've even added custom video
clips and animations to spotlight key ideas you want the client to remember.

PowerPoint 2010 gives you the ability to add and edit video in your presentation, edit
pictures on your slides, enhance animations, choose from among improved transitions,

add great narration, compare and merge presentations, and much more. The collabora-
tive features in PowerPoint 2010 enable you to easily work on your presentations with a
team, communicate in real time with coworkers, and access your files anywhere—using your
browser window or your smartphone.

Starting Out with PowerPoint 2010

The PowerPoint 2010 window gives you a simple, intuitive interface that provides all the tools
you need for building effective, professional presentations. The PowerPoint Ribbon offers
tabs that include tools specific to each of nine different tasks: File, Home, Insert, Design,
Transitions, Animations, Slide Show, Review, and View. The PowerPoint work window dis-
plays Slide view by default, which shows your current slide in the largest area of the window,
along with a segment for notes and a panel that will show all the slides you create in the
presentation. (See Figure 7-1.)
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FIGURE 7-1 The PowerPoint 2010 window provides the tools for creating the current slide, adding notes, and

working with all slides in your presentation.

You display Backstage view in PowerPoint by clicking the File tab. The Backstage view gives
you the controls you need to work with the presentation file you're creating. (See Figure 7-2.)
Commands in Backstage view enable you to optimize the media you include in your presen-
tation, set permissions for your co-authors and teammates, control version information, and

prepare the file for distribution.

Additionally, you use Backstage view to create new presentation files, print slides and
handouts, set PowerPoint options, and choose how you want to share the presentation.
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FIGURE 7-2 Backstage view enables you to set preferences for your PowerPoint files and compress and
optimize the media files you use.

O

Tip If you are working with Office Communicator, you will be able to add and view authors in
the right panel of the Info display in Backstage view. If you are using Windows Live to share your

presentation, you can add authors in Backstage view but presence information will not display.

Editing and Formatting Video

Video is the big story in PowerPoint 2010. It's no secret that video is everywhere—whether
you are interested in filming your own video clips to demonstrate a new product or service
or want to include a video from the Web for a little visual interest, you can easily incorporate
video into your PowerPoint presentation.

Now when you add a video to your presentation by choosing Video from File in the Media
group of the Insert tab, the file is embedded into the presentation itself, which makes

packaging and

presenting a snap.
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Tip If you choose Video From Online Video Site, PowerPoint displays a dialog box so that you
can paste the embedded code from the site onto the slide. Using this process to include video
does not embed the file, however; it simply creates a link to the video online. This is an important
distinction to remember if you are presenting in a place that does not have an Internet connection.

The video editing features available in Video Tools Playback enable you to trim the video
without ever leaving PowerPoint. (See Figure 7-3.) When you've captured more video than
you need for the current presentation, having the ability to cut the clip down to size without
leaving PowerPoint is a great timesaver. You can also change the fade in and fade out val-
ues, adjust the volume, and set playback options using the editing tools in the Video Tools
Playback tab.
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FIGURE 7-3 You can easily trim your video in PowerPoint 2010 to select the best segment for your
presentation.

PowerPoint also includes video styles you can apply to the video clip in your presentation.
When you apply a style, the format remains in effect while the video plays. For example, if
you choose the Reflected Perspective Right Video Style, which angles the video slightly to the
right, the entire video clip will play at that angle.
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Tip PowerPoint also shares the picture editing tools available throughout Office 2010. Simply
click a picture in your presentation and the Picture Tools Format tab appears, offering you tools
for making picture corrections, changing the color, applying artistic effects, applying picture
styles, and much more.

Step by Step: Adding and Editing Video
Follow these steps to add and edit video in PowerPoint 2010:
1. Display the PowerPoint slide where you want to add the video.
2. Click the Insert tab, and click Video in the Media group.
3. On the File tab, click Video.
4

. In the Insert Video dialog box, select the video file you want to add and click
Insert. The video is placed on the slide.

5. Click the Video Tools Edit tab, and click Trim Video. Drag the beginning and end
markers to the place you want the video clip to begin and end, as shown here:

Trirn Video ==

hummingbird01_July06.MPG Duration: 00:06.784

00:13.063

{

00:06.276 |+ E @ @ 00:13.063 &

Start Time End Time

6. Test the video by clicking the Play button. Adjust the markers as needed.
7. Click OK to save your settings.

8. Change the Fade In and Fade Out settings to change the way the video begins
and ends.

You can continue to make changes and play the video by clicking the Play button
in the video player on the slide.
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Tip Now you can add precision to your slides by using the dynamic alignment guides. These
guides appear automatically whenever you drag an object on the slide, helping you align the
object with other elements on your slide.

Creating and Working with Animations

¥

PowerPoint's improved animation features enable you to animate objects on your slide,
spotlighting key points and adding movement to your presentation. The animations in
PowerPoint 2010 are now more realistic, creating the effect of smooth movement for the

animations you create. (See Figure 7-4.)
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FIGURE 7-4 PowerPoint 2010 now includes improved animations you can add to virtually any object on
your slide.

Tip PowerPoint 2010 includes a number of new transitions that enable you to control the way
your slides advance. The transitions you choose are important because they convey the over-
all tone of your presentation—slow or fast, blocks or fades, sweeps or subtle dissolves—each
transition contributes to the overall effect you're creating.
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When you add an animation to your slide, the Trigger tool becomes available in the Custom
Animation tab of the Animations tab. Using the Trigger feature, you can add a bookmark to
trigger the animation you want to play on the slide.

PowerPoint also includes the Animation Painter, which enables you to apply animation
settings to other objects on your slide. This feature is similar to the Format Painter, which
enables you to choose format settings to apply to other text in your document.

Step by Step: Adding an Animation

Here's how to add an animation to your slide in PowerPoint 2010:

1. Display the PowerPoint slide where you want to add an animation.
2. Click the object you want to animate.

3. In the Animations tab, click Add Animation in the Custom Animation group. A
gallery of animation options appears.

4. Point to different animations to see how the animation looks on the slide. Click
the style you want.

5. You can customize the animation by choosing the options at the bottom of the
Add Animation gallery.

After you add the animation, you can fine-tune the animation's behavior by using
the tools in the Animation, Custom Animation, and Timing groups. After you
make changes, use Preview to view your changes.

@ Tip PowerPoint 2010 also includes improved narration features, which means that you now can
record voiceovers that you play back during your slide show. To try the narration feature, connect
your microphone and make sure it's working; then click Record Slide Show in the Set Up group of
the Slide Show tab.

Enhancing Your Presentation with Transitions and
Themes

If you've been using PowerPoint for any length of time, you've no doubt already discovered
slide transitions. Transitions give your presentation a professional touch by fading, dissolving,
wiping, or panning one slide into another. PowerPoint 2010 introduces great new transitions
to help you capture and keep the attention of your audience. (See Figure 7-5.) The new tran-
sitions are easy to find and apply; and you can preview the different effects until you find
just the transition style you want. You can apply transitions to a single slide or to all slides,
and you can customize the transition by specifying the duration of the transition, deciding
whether to apply a transition sound, or choasing transition effects.
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FIGURE 7-5 PowerPoint 2010 includes new transitions you can apply to your slides.

Step by Step: Applying Transitions
Here's how to apply slide transitions in PowerPoint 2010:

1. Open the presentation to which you want to apply the transitions.

2. Inthe Transition To This Slide gallery, click the transition you want to try.
3. Experiment with other transitions until you find the one you want to use.
4,

Click Effect Options to display the additional choices for the transition you se-
lected, and choose the effect you want.

5. If you want to add sound to the transition, click the Sound arrow and choose the
sound you'd like to add.

6. Inthe Duration field, set the number of seconds you want to allow for the transi-
tion to be completed.

7. If you want to apply the transition settings to all slides in the presentation, click
Apply To All
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Adding Sections to Your Presentation

Now in PowerPoint 2010 you can organize your presentation into sections to enable you to
navigate through your slides in the way that fits your content best. Suppose, for example,
that your presentation introduces your audience to a new program being offered through
your human resources department. As you begin the presentation, you discover that the
group has previously seen an introductory presentation that covers all the material you intro-
duce in section one. Because you have organized your presentation in sections, you can easi-
ly jump to section two of your presentation and continue with the information your audience
hasn't seen, without missing a beat. (See Figure 7-6.)

Goto Slide

Goto Section Default Section
Section two
Screen ' . a

Help

End Show

FIGURE 7-6 Create sections and use them to navigate easily during the presentation.

Working with sections also enables you to organize long presentations so that you can work
with them easily while you're creating and editing your work. When you add a section—by
clicking the first slide in the section you want to create, clicking Section in the Home tab, and
choosing Add Section (as shown in Figure 7-7)—the Slides view changes to highlight the new
section. Additional controls enable you to rename, collapse, expand, and remove sections

easily.
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FIGURE 7-7 Add sections to your presentation to better organize and navigate longer slide shows.
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Managing and Sharing Your Presentation

Because it's likely that you will be collaborating with others on the presentations you create,
PowerPoint 2010 makes it easy for you to manage, compare, merge, and share presentations.
This reduces the likelihood that you'll have multiple versions of the same file in circulation
and enables you to keep the project moving by communicating with other authors easily
while you work.

Merging Presentations

If you are combining changes that several reviewers have made in a single presentation, the
Compare tool in PowerPoint 2010 can simplify the process of putting it all together. The
Compare tool helps you see which changes have been made in the presentation and create
one merged file that reflects the latest version of the shared file.

The compared view shows the changes made among the versions and provides the
Revisions panel to help you see where the changes were made and what they entailed.

(See Figure 7-8.) You can click the small note icons on the slides to display information about
the specific changes made to the elements on the slide.
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FIGURE 7-8 PowerPoint 2010 compares and displays changes among versions of the file.
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Step by Step: Comparing Presentations

Follow these steps to use the compare and merge feature in PowerPoint 2010:

1.
2.

Open the presentation that you want to compare to another version of the file.
Click the Review tab, and click Compare.

In the Choose File To Merge With Current Presentation dialog box, navigate to
the folder with the file you want to use.

Select the file and click Open.

5. PowerPoint displays the merged file and shows the Revisions pane to list the

changes between the versions. Click a change in the Details pane to display a
pop-up list of changes to that element.

Select the check boxes of changes you want to keep. Repeat this step for all
changes in the presentation.

To save the merged file, press Ctrl+S. To discard the changes, close the file with-
out saving.

Tip PowerPoint includes co-autharing capability for users who work with SharePoint Workspace
2010 or Windows Live. Co-authoring gives you the ability to work collaboratively with authors

on the file. You can share the file by clicking the File tab to display Backstage view and then
clicking Share. You can enter author information in the Related People area of the Info panel

in Backstage view. If you are using Office Communicator, you can send an instant message to
another author while you work on a slide, which enables you to ask and answer questions in real
time while you work.

Broadcasting Your Presentation

PowerPoint 2010 enables you to broadcast a presentation to others at remote locations
whether or not they have PowerPoint installed on their computers. The Broadcast Slide Show
feature works with SharePoint Server 2010 or Windows Live. You simply choose Broadcast
Slide Show in the Start Slide Show group of the Slide Show tab and click Start Broadcast. (See
Figure 7-9.) The broadcast service sends your remote audience members the link to your pre-
sentation so that they can log in using their Windows Live account and participate directly.

Note Broadcasting your presentation in this way displays the visual portion of your
presentation only; no audio is transmitted. If audio is necessary for your presentation, you might
want to set up a conference call so that participants can hear your narration, ask questions, and
participate in the presentation.
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FIGURE 7-9 Broadcasting a slide show.

PowerPoint 2010 gives you the choice of sending an e-mail message or an instant message
to the people who want to view the presentation. When others receive the link, they can
simply click it to join the presentation in real-time. (See Figure 7-10.)
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FIGURE 7-10 Others can view your broadcast presentation in real time whether they have PowerPoint or not.
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Printing Presentation Notes

If you have written a script or presentation notes that you want to have available in your pre-
sentation, you can print them easily using Backstage view. Simply click the File tab to display
Backstage view, and click Print. In the Print display, select the Full Page Slides setting in the
Other Settings area. A pop-up gallery of print layouts appears. (See Figure 7-11) Click Notes
Pages, and then click the right arrow below the preview document to page through your
notes.

Tip PowerPoint also includes the Create Handouts In Microsoft Word feature to enable you to
save your notes, along with the representative slides, to a Word document. To save the notes
to Backstage view, click File to display Backstage view, click Share, and click Create Handouts In
Microsoft Word. Finally, click Create Handouts.
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FIGURE 7-11 You can easily print your presentation notes by choosing Notes Pages in the Print settings.
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Save Your Presentation as a Video

Another new feature in PowerPoint 2010 makes it easy for you to save your presentation as

a video and share it with others. Click File to display Backstage view, and click the Share tab.
Then click Create A Video to display the available video options. Table 7-1 shows your choices
for the level of video quality.

TABLE 7-1 Video quality for presentations

Used For Resclution Quality Frames Per Second
Computer & HD Displays 960 by 720 High 30
Internet & DVD 640 by 480 Medium 24
Portable Devices 320 by 240 Low 14

After you choose the video quality, click the Use Recorded Timings And Narrations option. A
range of options enables you to disallow timings and narrations, set new timings and narra-
tions, preview the current settings, or use the existing settings. Click the Create Video button
to start the process, and PowerPoint saves a video as a .wmf file. (See Figure 7-12)
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FIGURE 7-12 Create a video of your PowerPoint presentation.
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Work with the PowerPoint 2010 Web App

As part of the access-anywhere approach available in Office 2010, you can use the
PowerPoint Web App to view and edit presentations from your Web browser. The PowerPoint
Web App offers a limited set of editing tools in the familiar Ribbon interface (shown in

Figure 7-13); you also can work collaboratively with other authors using the PowerPoint Web
App and display your presentation in full-screen view.
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FIGURE 7-13 PowerPoint Web App displays your presentation in the familiar Office interface.

Using PowerPoint Mobile 2010

PowerPoint Mobile 2010 enables you to view your presentation slides in the familiar Office
interface designed for the simplicity of a small mobile screen. You can use PowerPoint Mobile
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2010 to review your presentation notes, easily work with slides using Slide Manager, and
page through the slides you're presenting. And in the live presentation, you can also use
PowerPoint on your smartphone to advance your slides remotely.

Tip If you use a Tablet PC or another device with tablet features, you can take advantage of the
better inking features in PowerPaint 2010. A greater variety of inking tools—including a large
collection of pens and expanded inking options—are available for you to use. You'll find the
inking features in the Review tab of your tablet-enabled device.



Chapter 8
Organize, Store, and Share Ideas
with OneNote 2010

In this chapter:
B Starting Out with OneNote 2010
B Capturing Notes Easily
B Working with Linked Notes and Task Notes
B Finding Just the Notes You Need
B Sharing Ideas Effectively

B Accessing Your Notes Anywhere

Are you a big note-taker? Do you scribble ideas on backs of envelopes, sticky notes, scraps of
paper, and pieces of napkins? Taking notes is a good practice—and it just might turn out that
one of those notes will have the perfect answer to a problem down the road. But if you can't

find what you've scribbled later, chances are that your inspiration will go to waste.

Microsoft OneNote 2010 is the electronic equivalent to a handy notebook, with a twist:

the program is designed to capture text, links, Web content, video and audio clips, articles,
drawings, and more—in whatever way you collect them. Whether you prefer to doodle your
ideas, speak into a microphone, scribble cryptic notes, or clip pieces of Web pages, OneNote
makes it easy to pull all that content together in one searchable place where you can find it
easily later. And as you continue to amass ideas that fascinate you, you can easily find and
incorporate those sparks of inspiration into your current projects.

The new features in OneNote 2010 make it easy to collect notes from Microsoft Office 2010
applications such as Word, PowerPoint, and Outlook and print the notes to your OneNote
notebook. You can also share your notebooks and track changes by author, version, recent
changes, and more. So even though you work collaboratively, you can still separate the great
ideas from the good ideas. The search feature in OneNote is now better than ever and in-
cludes an expanded search pane, which enables you to see at a glance all the occurrences of
the search phrase that appear in your notebook.

The OneNote Web App enables you to access your notebooks from any place you have
access to the Web, and OneNote Mabile makes it possible for you to review and do simple
editing in your notebook using your smartphone. As you begin to use OneNote regularly to
collect your thoughts and plans, you'll realize that more and more of your great ideas are
actually making it into the work you do in Office 2010.
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Starting Out with OneNote 2010

The OneNote 2010 window gives you a great range of flexibility in the way you work with
the notes you create. Each tab in the Ribbon offers tools related to a specific note task:
File, Home, Insert, Share, Draw, Review, and View. (See Figure 8-1.) The various areas of the
OneNote window enable you to work with the notes you create in different ways:

B The Navigation Bar enables you to move easily among your notebooks. You can click
the expand button at the top of the Navigation Bar to display a list of all notebooks
and the pages they contain.

Section tabs give you a simple way to store different types of information in your
notebook. You can create subpages and sections within each section and rename the
section tabs to fit your needs.

B The page tabs display the titles of existing pages in the current section. You can click
page tabs to move among pages in a section easily.

B The OneNote page collects your notes in any way you want to enter them. Simply click

anywhere and type, write, or draw, or add a voice, video, or file object.
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FIGURE 8-1 The OneNote 2010 window gives you access to your notebooks, unfiled notes, and much more.
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Capturing Notes Easily

The whole idea behind OneNote is that you need one central location where you can gather
all your notes—in whatever form—so that you can organize, share, and use them easily. You

might insert pieces of interviews, maps to locations, clips of video, photos of preducts, meet-
ing notes, articles, and anything else that provides you with the information you need for the
projects you're creating.

Today everyone suffers from information overload in one way or another, and we all find
ways to do our best to manage the data that comes our way. Developing a smart, fast meth-
od of organizing your notes helps you be more efficient and bring an even greater range of
resources to your work. One Note 2010 includes several features that make it simple to create
and work with the information you capture in your notebooks.

Using OneNote as You Work

Chances are that as you work on a specific document, worksheet, or presentation—ar even
as you're composing an e-mail message or surfing the Web—ideas are occurring to you that
relate to the task at hand. If you're editing a report, for example, you might think of a site
you visited last week that had some interesting statistics about the topic you're reviewing.
Using OneNote, you can make a note to yourself to look up that site when you're finished
editing. And you can make the note right alongside the work you're doing in Word.

The Dock To Desktop feature in OneNote lets you easily position OneNote in a reduced-size
window alongside other open applications. This means you can take notes—or refer to notes
you've already taken—while you're working on a document, worksheet, or presentation, To
dock OneNote to your desktop, click the Dock To Desktop tool in the Quick Access Toolbar in
the top left corner of the screen. The OneNote window shrinks to the current note page only,
as you see in Figure 8-2.

When you're ready to expand the OneNote window to full screen view, click the Full Screen
icon in the Quick Access Toolbar. To return the Navigation Bar, section tabs, and page tabs to
the display, click the View tab and click Normal View.

@ Tip Although there's no hard-and-fast rule for the way your notes are supposed to look in your
own personal notebook, using specific styles on your note headings can help you find the in-
formation you need easily when you're scanning through the pages. You can now apply Quick
Styles to your note headings by selecting the text (or clicking where you want the style to begin)
and clicking the style you want in the Styles group on the Home tab.
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FIGURE 8-2 You can use Dock To Desktop mode to keep a OneNote page open alongside your other
application or browser window.

Tip One new feature in OneNote 2010 enables you to recover notes you've previously deleted.
To restore deleted notes, click the Share tab, and in the History group, click Notebook Recycle
Bin to open the bin so that you can open the notes you want to preserve.

¥

Create Notes Anywhere

For OneNote 2010 to be a hub for all the notes you collect, the program needs to work
seamlessly with your other Office applications. Perhaps you finished a presentation and real-
ize after the fact that you can use it as the basis for another project you'll be working on next

month. You can save the presentation in your OneNote notebook for that project with just a
few simple clicks.
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You can use the Print command in either Word 2010 or PowerPoint 2010 to send an entire
file—in living color—to the OneNote notebook you select. You can then clip sections, graph-
ics, notes, or slides; leave the entire file as is; or use the content in other documents or note-
books you create. This technique is simple, reusable, and smart—putting your content within
easy reach for you to use in other projects down the road.

Step by Step: Printing a File to OneNote 2010

Here's how to incorporate an entire file in your OneNote 2010 notebook:

1. Open the PowerPoint presentation or Word document you want to add to your
OneNote notebook. (This example uses a PowerPoint presentation, but the pro-
cess is the same for either application.)

2. Click the File tab to display Backstage view.
3. Click Print. In the Printer area, click Send To OneNote 2010, as shown here:
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4. Click Print. The Select Location In OneNote dialog box appears, as you can see

here:
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OneMote Options),
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5. Click the expansion button to the left of the

the file.

notebook to which you want to add

6. Click the section or page where you want the article to be placed, and click OK.
The entire file is inserted on the page you selected.

Working with Linked Notes and Task Notes

OneNote 2010 offers the Linked Notes feature in Word 2010, PowerPoint 2010, and Internet
Explorer 8. Suppose that you are writing a report in Word 2010 and you want to check some-
thing in the notes you took at the last team meeting. While you're working in the document,
click the View tab and then click Linked Notes. The notebook you used to gather ideas for
this document opens automatically in a panel along the right side of the Word window.
OneNote automatically saves a link to the file or Web page you are reviewing so that you
can easily return to the source of your notes later. When the OneNote window is open, you
can add, edit, move, search, or organize your notes; copy them into the Word document; or
simply check what you wanted to review and close the file.
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Note The Linked Notes feature does not appear automatically in the Internet Explorer toolbar.
To open a OneNote page while working in Internet Explorer 8, click Tools and choose Linked

Note from the Tools menu.

The first time you use the Linked Notes feature with a new file, OneNote 2010 will display the
Select Location In OneNote dialog box so that you can choose the notebook, section, and
page you want to use with the current application. Expand the notebook to display the sec-
tions and pages; then click the OK button and the OneNote page appears in a small window

along the right side of your work area.

Tip Linked Notes works only with OneNote 2010, so if you have saved your notebook to be
compatible with OneNote 2007 users, you will need to convert the notebook to OneNote 2010
in order to use Linked Notes. A dialog box will prompt you to change the notebook properties if

Linked Notes is not currently available for your file.

OneNote 2010 is also available in Outlook 2010, enabling you to easily capture notes on
project-related tasks you create for yourself or for members of your team. To send the Task
Notes you create to a OneNote 2010 notebook, simply create and save the task; then click

OneNote in the Actions group of the Task tab. (See Figure 8-3.)
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FIGURE 8-3 You can easily send task information to a OneNote notebook.
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Finding Just the Notes You Need

If you're like most people, a percentage of the notes you take never make it into any kind of
practical use. Why? Chances are that a number of your good ideas simply get lost—stuck in
a coat pocket somewhere, left in your other briefcase, or forgotten on the table of the res-
taurant. With OneNote 2010, you capture all your information in one easy-to-navigate place,
which means you can always retrieve what you need easily using OneNote's powerful search
tools.

In OneNote 2010, the search features have been expanded so that they now go through all
types of content—including video clips, embedded objects, and more. The search navigation
pane appears as you begin to type a search word or phrase, showing you all the places in

your notes where the search characters appear. (See Figure 8-4.)
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FIGURE 8-4 The expanded search pane instantly shows results as you begin to type your search phrase.

You can customize where OneNote searches information in your notebooks by clicking the
Finished: All Notebooks (Change) link at the top of the search pane, and if you want to keep
the Search Results Pane open alongside the work area, click the Open Search Results Pane
link at the bottom of the search pane.
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Sharing Ideas Effectively

One of the great things about OneNote is that it serves as a creative catch-all for any type

of information you gather related to a specific project, idea, or event. No matter what your
team is working on, team members can save text notes, diagrams, sketches, audio clips, video
clips, Web links, and even doodles to the pages in your shared notebook.

OneNote 2010 includes a number of new sharing features that help you recognize easily who
has added what—and when. You will be able to search through the notebook by author,
highlight the changes you haven't read, check note versions, and much more. You'll find all
the tools you need for working with shared notebooks on the Share tab. (See Figure 8-5.)
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FIGURE 8-5 The new Shared Notebook features in the Share tab enable you to track the changes in the
notebook that are made by your team.

Creating a Shared Notebook

To create a new shared notebook in OneNote 2010, click the Share tab and click New Shared
Notebook in the Shared Notebook group. Backstage view appears, with Network Notebook
selected. Enter a name for the new notebook, and click Browse to select a location for the
notebook. Finally, click Create Notebook to add the new shared notebook to your files.

@ Tip After you've created a notebook, you can invite others to share the notebook with you by
displaying the Info page of Backstage view. All notebooks are listed, showing the title of the
notebook, the Settings button for each notebook, as well as the location of the notebook file and
the sharing status of the notebook. To display the properties for the notebook, click the Settings
button and click Properties.
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Finding Entries by Author

Suppose that you've been discussing a new idea for a video clip with one of your team-
mates, and she mentions that she posted the link to a video she liked on a page in your
shared OneNote notebook. How can you find the note she added to the file? The Find By
Author tool in the Shared Notebook group on the Share tab enables you to sort entries first
by person and then by date, showing the most recent posts first. In this way you can find the
author’s name, read the description of the addition as well as the date, and then click the one
you want to display it in the OneNote page view. (See Figure 8-6.)

[N]| = HEl ™ |= Links for reference - Microsoft OneMote (Technical Preview) = & =
m Home Insert Share Draw Review e & 0
L = B G- L) )
sl ' \
3w 8 8RB &
Email | Mest Markas  New Shared Share This Recent Find by Hide Page  Motebaok
Page Unread Read= Notehook MNotebook Edits~ Author Authers  Versions « Reayele Bin <
E-mail Unread Shared Notebook History -
> e RaaE Links " ze | Search All Motebooks (Ctil +F) O « || Search Results > X
y [ — i3 thanges by Author
3 “Links P ] [IewEage v Search This Noketook [=]
= e i Links for reference [} by pster B
= uesday, October 13, 2002 e
= 606 FM 4 Katherine
u & ) web research 10f14/2009
] Links for reference 10/13/2009
= htt://ww w.reportband.goy ] Doves ressarch L0f132009
E hittp/f v w kedwp state ks.us/news Hunting/bl gratory-Birds/DovesDove-
z Banding-Study
= http: /v w. wild ifedepartment. com/mourningdov ebandingproject. htm
=
2 http v w. outdooral sbama.com/hurtingfarticles fdov ebandupedate cfm
g
5 Narth America Bird BrandingLaboratory
- hittp: vew . prre, usas, gov/hbl
= Bird banding data are useful in both research and management
£ projects. Individual identification ofbirds makes possible
g studies of dispersal and migration, behavior and sodial
2 structure, life-span and survival rate, reproductive success and
< population growth
KTy | \
|
&n MIGRATION
L CORRIDORS
(3
) Click here toview a larger version of this map
= : ] - -~
) Dispersal and Migration 5

FIGURE 8-6 Find By Author enables you to display all entries made by author, date, and description so that
you can move easily to the note you need.

Working with Page Versions

One of the challenges in working with multiple authors on a notebook is that it can be
difficult to tell which version of the page you're viewing. Are you adding your notes on the
most recent version of the page? OneNote 2010 includes the Page Versions feature to help
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you determine that you're working on the most recent page available so that you can be sure
all changes are incorporated in the page you're viewing. Simply click the Share tab and click
Page Versions in the History group. (See Figure 8-7.)
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FIGURE 8-7 Displaying page versions enables you to review the content added to your pages and make sure
you're working with the most current page.

Tip You can also use page versions to undo changes that were made inadvertently. You can
return the page to an earlier version, and changes will be merged and synched automatically.

Accessing Your Notes Anywhere

Following the work-anywhere trend set by the other applications in Office 2010,

OneNote 2010 enables you to add, update, and share notebooks on the Web or access and
make changes to your notes using your Windows Mobile smartphone. The OneNote Web
App enables you to view, share, and edit your notes pages; you can easily add notes, edit
existing notes, and capture links, screen shots, files, and more. Additionally, OneNote Mobile
fits the OneNote 2010 interface to the small smartphone display, enabling you to review,
update, and work with your notes while you're on the go. When the product is available,
you will be able to set up OneNote Mabile to work with your Windows Mobile smartphone
by clicking File and choosing Options in Backstage view. Click the Advanced tab and scroll
down to the OneNote Mobile settings. Click the Install OneNote Mobile button to install the
mobile version of OneNote 2010 and set up the software for your smartphone.






Chapter 9
Collaborate Effectively with
SharePoint Workspace 2010

In this chapter:
B What Can You Do with SharePoint Workspace 20107
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B Setting Workspace Preferences
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B Checking Files In and Out
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B SharePoint with InfoPath and SharePoint Business Connectivity Services

B Using SharePoint Workspace on the Go

When you need to send a document to a teammate for review, what do you usually do?
Most people attach a document to an e-mail message and click Send. This works—some-
what inefficiently—for a file two people share, but what happens when you have six or eight
people on your team? You could conceivably have multiple versions of the same file moving
back and forth through e-mail; how will you know when you are working on the most recent
version of the file?

SharePoint Workspace 2010 takes all the guesswork out of collaboration by providing
you with an easy-to-use workspace in which you can post files you want to share, hold
discussions, chat in real time, and check files in and out. You can synchronize files with
SharePoint Server 2010, ensuring that your document libraries, InfoPath forms, and other
files are current and up to date. SharePoint enables you to work with your files—and each
other—as you collaborate in real time to complete your shared projects.
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And for those times when you want to work with files stored on the server but won't be able
to maintain your server connection while you work, SharePoint Workspace 2010 works with
SharePoint Server 2010 to enable you to take content offline so that you can do the work
you need to do and upload the files when you reconnect. Taking your content offline is a big
benefit when you're on the road, because you can ensure you're working with the most re-
cent version of the file and integrate your changes automatically when you log back into the
server. In the meantime, you can lock the file so that other users won't inadvertently make
changes that can be overwritten later.

What Can You Do with SharePoint Workspace 2010?

SharePoint, as the name implies, is all about sharing—sharing files, sharing discussions, shar-

ing folders and workspaces and contacts. SharePoint Workspace 2010 is the next incarnation

of Microsoft Office Groove, which is available both as part of Office 2010 and as a standalone
product. Because sharing files and information is a flexible process that can take many forms,
you can work with SharePoint Workspace in a number of ways:

B Create a SharePoint workspace to create a personal copy of the server workspace on
your PC and store files you need to work on. If you use SharePoint Server 2010, this
enables you to take your content offline and synchronize it again later.

B (Create a Groove workspace to collaborate with team members (who may or may not
have access to SharePoint Server 2010) so that you can share files, folders, discussions,
and more.

B Create a shared folder in your workspace so that you can give other users or computers
access to the files stored there.

SharePoint Workspace 2010 gives you the space to collaborate with your team easily and
naturally. In your team workspace, you can share documents, have discussions, chat in real
time, set appointments, leave notes for each other, and much more.

Note SharePoint Workspace 2010 is available only in the Microsoft Office 2010 Professional Plus
version. SharePoint Server 2010, which is required for the check-in and check-out features, will be
available in the first half of 2010.
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Starting Out with SharePoint Workspace 2010

When you first start SharePoint Workspace 2010 from the Windows Start menu, the
Launchbar opens on the left side of the window, along with a pop-up list displaying any
unread files that have been added to the workspace since you last logged in. (See Figure 9-1.)

The Launchbar lists any workspaces you currently belong to and also enables you to view and
work with your Contacts list.

|£||‘ + Launchbar-K.. o B =
(=]
L File | Home Wiew @& 0
B X Delete
L) 0
&3 Add Contact
New Search
= 2 Mark Read =
Workspaces Actlons
' Active
Unread
©5E-Learning Author Resources
%5 Office2010_Product_References
Read
@} Project files
Inuitstion for “Katherine Murray” from Kathetine Murrsy” (371372008 345 P
| =] Wharkspaces @ *Files" in *E-Leaming Author Resources" has unresd dat,
| 83 contacts “ *File Undate Log"in "E-Learning Author Resources” has unread data.
@ “Calendar”in "E-Learning Author Resources” has unread data.

FIGURE 9-1 SharePoint Workspace also lets you know if your workspaces have any unread files.

To display a workspace, double-click the name of the workspace in the Launchbar. The
workspace window uses the familiar Ribbon you see in other Office 2010 applications.
(See Figure 9-2.) The default tabs include the File, Home, Workspace, and View tabs.
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FIGURE 9-2 The SharePoint Workspace 2010 window gives you what you need to work collaboratively with
your colleagues.

The work area is divided into three areas. On the left side of the work area is the Content
panel, where you can choose the type of content you want to view in the space. The Content
area might show Files, Meetings, Calendar, Discussion, Notepad, Pictures, or other categories,
depending on the features that are used in the workspace.

Tip You can add tools to the Content area by clicking the Workspace tab and clicking Add in the
Tools group.

What About Groove?

If you used Microsoft Office Groove in Office 2007, you are already familiar with the
workspace concept and know how it can be used to collaborate with team members far and
near. In Office 2010, Groove has been renamed as SharePoint Workspace 2010, so you'll find
similar functionality with some major improvements.

You can still create Groove workspaces in SharePoint Workspaces 2010 so that you can
collaborate with team members who don't have access to SharePoint Server.
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And now, with SharePoint Server 2010, which will be available in the first half of 2010, you will
be able to download the files or folders you need so that you can work on files while you're
offline and then synchronize the file versions when you connect to the server once again.

Step by Step: Adding a Workspace
You can create a SharePoint or Groove workspace easily from the Launchbar.
Here's how:
1. In the SharePoint Workspace 2010 Launchbar, click New in the Workspace group
of the Home tab.

2. Choose one of the following options:

B SharePoint Workspace, which creates a workspace on your computer

that enables you to download files from the SharePoint Server and work
on them offline

B Groove Workspace, which creates a classic Groove workspace so that
you can save files and work collaboratively with your team

Shared Folder, which enables you to create a new folder you can share
with others

3. If you selected SharePoint Workspace, enter the server location of the space you
want to copy, as shown here:

New SharePoint Werkspace
Sync to SharePoint Workspace
Create 3 synchronized copy of a SharePoint site on your computer.

¥ou should only sync from sources that you trust,
Learn more about what you can do with a SharePoint work space

Select a ShareFoint Site:

Name Location
My ShareP oint Sites
__', | My Site hitp:/foffice:80/personal

Location: Enter the location of 3 SharePaoint site or select 3 site from ab ove |

Configure.. QK
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4. If you chose Groove Workspace, click Options and make sure 2010 is selected in
the Workspace Version field (as shown here). Click Create.

MNew Groove Workspace

Mame: New'Workspace

Workspace Wersian: [2010 vl

5. If you chose Shared Folder, enter a name for the new folder and click OK. In the
Select A Folder For Sales Report dialog box, choose whether to create the folder
on your desktop, in another location you specify, or to use an existing folder.
After you make your choice, click OK.

Tip SharePoint workspace synchronizes only your changes, which means the entire file doesn't
need to be copied each time you sync your files, which saves time and preserves bandwidth.

Setting Workspace Preferences

Backstage view in SharePoint Workspace 2010 provides you with various ways to set the
preferences for different program features. (See Figure 9-3.) The Info tab enables you to
choose your preferences for the following elements:

B Change Online Connection Settings lets you choose the way the various workspaces
and communication options in your workspaces are synchronized. You can also choose
to pause the workspace or work offline.

m  Alert Me To Workspace Changes enables you to customize the way in which your
workspace alerts you when changes are made to the site. You can set the Alert level,
review roles and permissions, and set download preferences.

B Manage Account Settings makes it easy for you to set account preferences, including
whether you want SharePoint Workspace to launch when Windows starts up, how
you want your online presence to be displayed, and how you want folders to be
synchronized.

B  Manage Messages And Contacts displays your message history, including all messages
you've sent and received, and it enables you to work with all contacts who have access
to the workspace.
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FIGURE 9-3 Use Backstage view to set your workspace preferences.

Accessing Your Files Seamlessly

One of the great new features SharePoint Workspace 2010 offers is transparency. Now when
you use SharePoint Workspace 2010, you can open the files in your SharePoint and Groove
workspaces as easily as you open a file on your desktop.

To move directly to your workspace folders without launching SharePoint Workspace 2010,
click the Windows Start button and click your user name. Locate the Workspaces folder,

as shown in Figure 9-4. Open the Workspaces folder by double-clicking it and then move
directly to your workspace to find the files you need.
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FIGURE 9-4 You can access your workspace files from the folders on your computer.

Simplified Searching

Another natural integration between your SharePoint and Groove workspaces occurs in the
indexed Windows search function on your computer. Now when you search for a word or
phrase by clicking the Windows Start button and typing the phrase in the Search field, the

list of results displays any results found in the files in any of your workspaces. (See Figure 9-5.)

Tip You can synchronize any shared folder on your computer simply by right-clicking the folder
and clicking Shared Folder Synchronization. Choose the Start Synchronizing option from the
menu to begin the process.



Chapter 9 Collaborate Effectively with SharePoint Workspace 2010

- Results from a shared folder in SharePoint Workspaces 2010

FEE=]

\ﬂ & s Launchbar - K., = B
Home | View OQ [J s project fites
i K Detere - - -
B File Edit View Tools Help
£ Add Contact . >
e Search ro et <Q EncryptFile gy Decrypt File u, * Open/Close PSD
Wiarkspqces Actions Shared Folder Synchrenization x Organize »
-
Fhd synchionization Tasks 2/ It Favorites
Fof Mew Workspace
< Adtive (8] Project files ] [% Recently Changed
(@) Project files ” o Public
Udread B Katherine Murray B Desktop
& Downloads
Docufnents (2) =
@7 Web research i Libraries
=
etting Started with OneNote i Jocuments
; Musi
Micrdsoft OneNote (1) fh L
&l Pictures
@ el research E Videos
Micrgsoft Qutlook (1)
i3 YechNet Flzsh: More Windows 7 Planning and Deployment Res... o ) Homegroup
Fites gy
‘E.J REO6 | , 12 items
] rB01

7 Search Everywhere

T
Resource mznagement x|

| Shut down | » |

A=)

gl

|

n

v | 42| se

E=R
Name
TRED
) RB03
5 RB04
&) Roos

reh prejec... 0 |

] Ra0s
¥ rB09
) RB10
) RB11
#] rB12

Too0em | |
10/22/2009 |

D

FIGURE 9-5 The indexed search feature includes results from your SharePoint and Groove workspaces.

Checking Files In and Out

Keeping your files straight is one of the challenges of working with other authors on shared

documents. SharePoint Workspaces 2010 enables you to check files in and out of SharePoint
Server 2010 so that you can ensure that your work isn't being duplicated—or overwritten—
by others working on the same file.

Note To use the check-in and check-out features, you must have access to SharePoint Server
2010, which will be available in 2010.
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You can work with files easily in SharePoint Workspace 2010 by clicking Files in the Content
pane and then selecting the file you want to check out or in. In the Home tab, click Check
Out or Check In. The file is marked so that other users on SharePoint Server will see the
availability of the file and, if it is checked out, be blocked from accessing it.

When you check the file back in, your changes are synchronized and the file is made
available to your teammates once again.

Tip You can move back to the original SharePoint Server site by clicking the breadcrumb trail
in SharePoint Workspace 2010. This gives you instant access to folders, files, libraries, and other
assets on the server site.

Synchronize Your Data from SharePoint Server to Your
Workspace

If you want to save files or folders to your PC-based workspace so that you can work

on them whenever and wherever you choose, you can download the content from
SharePoint Server 2010. Simply open your SharePoint Server 2010 site, click Site Actions,
and choose the Sync To Computer option. Click OK in the SharePoint Workspace 2010
dialog box to begin the download.

Connecting with Your Team Instantly

The Groove workspace you create in SharePoint Workspaces 2010 enables you to share files,
discuss projects, plan meetings, and much more. With a Groove workspace, you can work
collaboratively without having access to SharePoint Server 2010.

You can display and work with contact information in two different places in your SharePoint
and Groove workspaces. In the Launchbar, you can click Contacts at the bottom of the dis-
play to display all Active, Online, and Offline contacts who have access to the current work-
space. In a workspace, scroll through the Members areas in the bottom left corner of the
window.

You can tell which contacts are currently online by the small presence icon that appears to
the left of the contact's name. A green icon indicates that the member is online; yellow in-
dicates that the member is busy; red means the contact is unavailable. If a presence icon is
gray, the contact is not currently online.

When you find a member you want to contact, click the person’s name to display a contact
card. By default, a small contact card appears, as you see in Figure 9-6. You can expand the
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contact card to show more information—including department, phone numbers, and other
relevant information such as organization and workspace roles—Dby clicking the Expand
Contact Card button in the lower right corner.

11 12
18 19
Katherine Murray = X
“““ Active in Warkspace
Members
InWorkspace | = =~ v— Expand Contact
@ Katherine Murray 25 26 Card
nline e
Invige to Workspace: lore
-Erjer name or e-mail-
= Chat
|— Presence icon L E-mail L View More Options

FIGURE 9-6 The contact card initially shows a select group of contact options, but you can expand the card
to show more information.

The different option tools in the contact card enable you to send the contact an e-mail mes-
sage, begin an instant message session, make a phone call, or set up a meeting. Additionally,
with Office Communicator 2007 R2, you can share video, share your desktop, and send files.

You can also open an instant messaging window by double-clicking the contact's name in
the Members list. You can send the message to one or many team members and attach files
to the message if you like. (See Figure 9-7.)

“=] Send Message - Microsoft SharePoint Workspace (Te..
Erom: Katherine Murray
To: Kay v Add More..,

Message:

Did wou have your meeting today? Yhat did Sara say about
the deadline for draft 27

Attachments: Remowe

FIGURE 9-7 Send an instant message to one of your contacts online in the current workspace.
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Note To see the online presence and social contact information of others on your team, you
need to be using Office Communicator 2007 R2.

SharePoint with InfoPath and SharePoint Business
Connectivity Services

SharePoint Server 2010 makes it simple for you to work with the variety of business appli-
cations and services you need on a daily basis—and to do that naturally, online or offline.
Now SharePoint Server 2010 supports InfoPath forms, which means you can add, delete, or
edit data and data records on your forms and trust that they will sync automatically with the
forms and data on the server.

Additionally, users who use SharePoint Business Connectivity Services can count on using
line-of-business data in SharePoint and know that it will synchronize seamlessly with both
their line-of-business system and SharePoint Server.

For both InfoPath and SharePoint Business Connectivity Services, after the data is synchro-
nized, the information will also be available in SharePoint Workspace 2010.

Using SharePoint Workspace on the Go

SharePoint Workspace 2010 will also be available in a mobile counterpart (sold separately
from Office 2010) after the final release of Office 2010. With SharePoint Workspace Mobile
2010, you will be able to open your workspaces, look through your files and folders, and
review and modify your files in a special Office screen designed for your smartphone.

After you view, edit, and save your documents, you can easily sync them back to the server
with a single touch on your phone. This process makes it easy for you to work with your
workspace files anywhere and anytime you need them.
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Create Effective Marketing Materials
with Publisher 2010

In this chapter:
B Starting Out with Publisher 2010
B Creating and Using Templates and Building Blocks
B Creating Precise Layouts
B Enhancing Typography with OpenType Features
B Working with the Improved Color Palette
B Previewing and Printing Publications
B Preparing for Commercial Printing

B Sharing Publisher Files

How do you create your marketing materials today? If you are spending a big portion of your
budget outsourcing four-color postcards, brochures, newsletters, and more, you can do the
job closer to home with Publisher 2010 and save money, time, and effort. What's more, you
can create and save reusable content—called building blocks—that you can insert in future
materials, which helps you ensure that your messaging stays consistent no matter what kinds
of materials you create.

Improvements in Publisher 2010 make it easier than ever to create new files using both
built-in and community-submitted templates. New layout tools help you align objects, place
captions, and position elements on the page in accurate and aesthetically pleasing ways. You
can also spruce up your photos with artistic effects, improved editing tools, and support for
OpenType features such as ligatures and stylistic sets.

Starting Out with Publisher 2010

The Microsoft Publisher 2010 window gives you plenty of room to work on screen, while
keeping the tools you need within reach. (See Figure 10-1.) The Ribbon includes seven tabs—
File, Home, Insert, Page Design, Mailings, Review, and View—and each tab contains groups
of tools related to the tab topic. On the Insert tab, for example, you'll find Picture in the
lllustrations group, enabling you to add pictures to the current page with just a few clicks of
the mouse.
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FIGURE 10-1 The Publisher 2010 window includes the Ribbon and the Page Navigation pane.

The Publisher window also includes a scratch area surrounding the entire publication. The
scratch area enables you to place objects partially off the page so that you can create bleeds
(photos, backgrounds, or other graphical elements that print all the way to the edge of the
page). In Publisher 2010, you can choose to hide or display the scratch area so that you can
see the overall design, including bleeds, as well as the page as it will appear when printed.

Collapse and Expand Page Navigation Pane

The Page Navigation pane along the left side of the window displays thumbnails of the pages
in the current document, which enables you to get a sense of the document flow and over-
all layout at a glance. You can use the Page Navigation pane to scroll through the different
pages in your document, checking text flow, placement of illustrations, format of headings,
and other parts of the design.
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If you want to increase the amount of space available for the current page, you can collapse
the Page Navigation pane, which reduces the size of the displayed thumbnails. To expand the
pane, simply click the Expand button at its upper-right corner.

Use the Mini Toolbar

Now Publisher 2010 also includes the Mini Toolbar, a set of text-formatting tools that appears
when you select text in your document. When the Mini Toolbar first appears, it is transparent;
when you point to the toolbar it becomes solid, as Figure 10-2 shows. If you move the mouse
pointer away from the toolbar, it disappears altogether. In this way, the tools are within reach
if you need them, but they fade away if you don't.

Sales ()9

Frank\mGnthlc%v W~ A A
m— n s uEA-&-Z

FIGURE 10-2 The Mini Toolbar displays formatting tools when you select text.

Tip If the Mini Toolbar doesn't appear automatically when you select text in your document,
you can turn the feature on by clicking File and choosing Options. On the General tab, click the
Enable The Mini Toolbar option.

Creating and Using Templates and Building Blocks

Publisher 2010 offers dozens of built-in templates you can use to create letters, newsletters,
brochures, business cards, calendars, labels, and much more. When you choose to create a
new publication based on a template, you can use one of the templates installed with the
software or access templates available online in the Publisher community. (See Figure 10-3))

In addition to using templates to start your publication, you can add predesigned elements
to your pages by choosing from a gallery of page parts, known as building blocks. Building
blocks are available in the Page Parts tool in the Building Blocks group of the Insert tab.
(See Figure 10-4.)
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FIGURE 10-3 You can choose to begin a new publication based on an installed or online template or create
your own design on a blank page.

Tip A building block is a part of a page that you might want to use regularly in your publications.

By default, Publisher includes headings, pull quotes, sidebars, and stories in the Page Parts
gallery of the Building Blocks group on the Insert tab. You can insert the building blocks as
they are and then customize them to fit your publication, or you can create your own Page
Part and then save it as a building block. Either way, the building blocks feature can save
you time and effort and help you provide a consistent look and feel among the various
publications you create.
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FIGURE 10-4 Page Parts can save you time and add a professional touch to your page design.

Step by Step: Creating a Building Block
Here's how to create a new building block in Publisher 2010:
1. Open the Publisher document you want to use.

2. Create and select the element you want to save as a building block. Hint: You

might want to save a page heading, report title, pull quote, table, or other
often-used element.

3. Right-click the element you selected and choose Save As Building Block.
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4. In the Create New Building Block dialog box, shown here, enter a title and

description.

Create New Building Block

Title: Sales 09
Description:
Gallery: Page Parks

[¥] showi in Gallery
Category: General
Keywords:  |title, report]

Date created:
Type:

10/27/2009
Text

]

[ ==

Sales 02

5. Click the Category arrow, and choose the category that best applies to the type
of element you've created.

6. Click OK to save the building block.
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Creating Precise Layouts

Publisher 2010 also includes dynamic layout guides to help you position elements precisely
on the page. Guides appear automatically as you drag an object—text, picture, or shape—on
the page. Turn on the display of guides by clicking Guides in the Show group of the View tab.

Vertical and horizontal guides help you ensure you're positioning elements so that they
align with other objects on the page. Guides appear and disappear as you drag the ob-
ject so that they take up space on-screen only in the areas where you need to use them.
(See Figure 10-5.)
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FIGURE 10-5 Publisher 2010 provides dynamic guides that help you place objects on the page.

Enhancing Typography with OpenType Features

Both Publisher 2010 and Word 2010 are now able to make use of OpenType features such
as ligatures and stylistic sets in the fonts that offer them. Ligatures are a combination of two
letters shown typographically as a single character in some fonts. For example, the letters
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fi in some typefaces are placed close together and shown as a single character. This type of
text control is used most often in high-quality typography work.

Similarly, stylistic sets offer a variety of appearances in the selected font. The Typography
tools are found on the Text Box Tools Format tab, which appears when a text box is selected
in your Publisher document. Figure 10-6 shows some of the stylistic sets available for the
Gabriola font.
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FIGURE 10-6 Publisher 2010 enables you to take advantage of professional typography features available
with some OpenType fonts.

In addition to ligatures and stylistic sets, Publisher 2010 also supports number styles,
stylistic alternates, and swash features. Figure 10-7 shows the primary Typography tools, and
Table 10-1 provides a description of each one.

ASpropCap~  ahe StylisticSets

23 Number Style :J§ Swash
ﬁ Ligatures = AU Stylistic Alternates ~
Typography

FIGURE 10-7 Publisher 2010 offers different OpenType features you can apply to fonts that support them.



Chapter 10 Create Effective Marketing Materials with Publisher 2010 137
TABLE 10-1 Typography features in Publisher 2010

Tool Description
Ligatures Enables you to choose whether to use ligatures in the document (and,
if so, what kind)
Number Style Sets the appearance of numerals in the selected font in the current
document
Stylistic Alternates Offers alternate characters you can use in the text in your document
Stylistic Sets Displays a gallery so that you can choose the format style of the
selected font
Swash Works as a toggle, and turns on or off decorative text elements
Tip Publisher 2010 also includes Paste with Live Preview, which enables you to preview the way
an object will look before you paste it in your Publisher document.

Working with the Improved Color Palette

Publisher 2010 updated its color palette to include elements that help you keep a consis-
tent look and feel throughout the materials you create. Now you can stay true to the color
scheme you selected and apply a variety of tints, shades, and gradients to the text and
shapes on your pages. You'll find the new palette on all border and fill tools—for example,
Figure 10-8 shows the color palette that appears when you click the Shape Fill tool in the
Shape Styles group of the Drawing Tools Format tab.
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Scheme Colors

?Iiillllu

Standard Colors
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Mo Fill

More Fill Colors...
Sample Fill Color
Picture...

Gradient L4

Texture Lo

EREEN

Patterm...

FIGURE 10-8 The improved color palette now displays color scheme selections and expanded color choices.
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Previewing and Printing Publications

The Print feature in Publisher 2010 now enables you to preview, adjust, and print all in the
same screen in Backstage view. (See Figure 10-9.) When you click the File tab and click Print,
you see the current page of your open publication, complete with the page margins, headers
and footers, and more. You can easily choose the print options you need—for example, se-
lect the printer you want to use, choose the print layout and paper style, and select whether
you want to print as an RGB color publication or a composite black and white.
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FIGURE 10-9 The Preview And Print interface in Publisher 2010 enables you to make last-minute changes and
print, all from the same screen.

Have you ever printed a double-sided report only to find out that the image on the back of
the page made the text on the front hard to read? Publisher 2010 includes a backlight fea-
ture that enables you to see through the page on double-sided publications so that you can
avoid that kind of situation in the future. When you choose two-sided printing in the print
options, the Decrease Transparent View and Increase Transparent View tools appear at the
upper-right corner of the preview window. (See Figure 10-10.) To change the transparency
and display the back of the page while you're looking at the front, drag the Transparency
slider to the right. You can also turn the page and view the transparency from another
perspective using the Front and Back tools at the bottom of the preview area.
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FIGURE 10-10 The Transparency tools become available when you choose two-sided printing.

Tip Before you finalize your design, be sure to run the Design Checker to identify and correct
design problems in the publication. You'll find the Design Checker on the Info tab of Backstage
view.

Preparing for Commercial Printing

Publisher 2010 includes expanded support for the four-color process and spot color printing,
including CMYK composite postscript and Pantone colors (both PMS and the new Pantone

GOE color system). You'll find the tools you need to prepare a file for commercial printing by
clicking the File tab to display Backstage view. Click Info, and click Commercial Print Settings.

Commercial Print Settings enables you to choose the color model you want to use, work

with the embedded fonts in your publication, and manage the registration of the document.
(See Figure 10-11.) When you're ready to finalize the file, click File and in Backstage view, click
Share and choose Save For A Commercial Printer.
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FIGURE 10-11 Commercial Print Settings enable you to prepare your publication for professional printing.

Sharing Publisher Files

You can share the files you create in Publisher 2010 in various ways. You can e-mail pages
from within Publisher, create a PDF/XPS document, publish the document as HTML, save the
piece for a commercial printer, or save the publication for another computer. You'll find these
options in the Share tab of Backstage view.

Tip Before you send your Publisher document by e-mail, you can preview it by clicking File
to display Backstage view and choosing Share. Click E-mail Preview to display a version of the
document as it will appear to the recipient.
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Make Sense of Your Data with
Access 2010

In this chapter:
B Starting Out with Access 2010
B Using Application Parts
B Applying Office Themes
B Adding New Fields
B Showing Data Bars and Conditional Formatting
B Creating Navigation Forms
B Designing Access 2010 Macros
B Working with Access 2010 and the Web

Whether you wark daily with large, sophisticated databases or occasionally create small
data tables to meet a specific need, Microsoft Access 2010 enables you to gather, organize,
analyze, report on, and share your data easily and effectively. New and improved features
in Access 2010 simplify the steps to creating a database by enabling you to add application
parts that include ready-made tables and forms. You can also use Quick Start fields to insert
commonly used fields and add calculated fields to build data analysis directly into your data
tables.

On top of the simplified tasks involved in creating and analyzing your data, Access 2010
includes new data visualizations—including new data bars and improved conditional format-
ting—that can tell the story of your data at a glance. You'll also find plenty of Web support in
Access 2010. With little effort, you can create a Web database and publish your data online
so that it's always available at any point you have Web access.

Starting Out with Access 2010

The first thing you'll notice as you begin to work with Access 2010 is that the application has
the friendly and familiar Office interface that is common to other Office applications you
might use. The Ribbon includes five tabs—File, Home, Create, External Data, and Database
Tools—that offer sets of tools organized according to the data tasks you'll be performing.

141
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In addition to these five tabs, Access 2010 displays the Table Tools contextual tabs (Fields and
Table) when you work with a data table. (See Figure 11-1)
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FIGURE 11-1 The Access window is designed to make it easy for you to work with the data objects and views
you need.

Below the Ribbon, the Access window is divided into two main windows. The All Access
Objects pane on the left side of the screen lists the various elements—tables, reports, forms,
and more—in your current database. To open an object, you double-click it in the All Access
Objects pane; the item then opens in the work area on the right side of the window. You can
have many open objects in Access at one time, and you can change the current display by
clicking the tab of the object you want to see.

Tip You can change the elements displayed in the left pane by clicking the arrow to the right of
the pane heading. You can choose to display objects by category or by group. Click the option
you want to display and the pane changes accordingly.
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Along the bottom of the Access window you find controls that enable you to move through
records in the current data table, search for information in the database, or choose the view
you want to use to work with your data.

In addition to the flexible, easy-to-navigate user interface, Access 2010 offers behind-the-
scenes features that help you manage your data files. Backstage view pulls together all
the tools you need to create, share, and set preferences for the various files you create.
(See Figure 11-2))
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FIGURE 11-2 Use Backstage view to work with the files you create in Access 2010.

Using Application Parts

Designing every database you create from scratch takes a lot of time and effort, and now
with Access 2010 there's no need to reinvent the wheel every time you create a new data
table. Using the application parts in Access 2010, you can add ready-made forms and tables
to your Access database. By default, Access 2010 includes a number of blank, predesigned
forms as well as Quick Start tables (Comments, Contacts, Issues, Tasks, and Users) you can
add to your database.
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Step by Step: Adding an Application Part

Follow these steps to add an application part to your Access database:

1. Open the database you want to use.
2. Click the Create tab.

3. Click Application Parts. The gallery appears, as shown here:
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4. Click the application part you want to add to your database, and the form or
table you selected is inserted in the All Access Objects pane on the left side of the
work area.

Tip You can easily search for Access templates to use as the basis for a new database from
Backstage view. Click File to display Backstage view and then click New. Click in the Office.com
Templates box, and type a word or phrase indicating the type of template you'd like to find.

Applying Office Themes

Now you can apply the professionally designed Office themes—which include color scheme,
font selections, and styles—to your forms and reports in Access 2010. (See Figure 11-3.) This
level of consistency enables you to create a similar design for all the documents you create
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in Office 2010. For example, suppose you're putting together a lengthy sales report that
spotlights key products, provides sales data by region, and includes case studies showing
the ways in which your preducts are being used by your customers. Using the same Office
theme, you can prepare the case studies in Word 2010, the financial data in Excel 2010, and

the sales reports by region in Access 2010.

Home Create External Data Database Tool:
Al ' ]
| ] cotors ~ E_zu X Totals » L\E “

VIEW \TMEMES [A]Fonts - GFDUD 3 Hide Details

@~

Views | In his Database

All Tabl| las

Tablel |

==

Built-In =

Aa (8 ] 2]
w[aag [ WA 2]
Aa ] [Aa 71l Aa ‘W Aau
as ] [As ] [2

@ Browse for Themes...
EJ  save Current Theme..,

EEEEQ
o
[*%]
—l

FIGURE 11-3 Office themes in Access 2010.

Step by Step: Applying an Office Theme
Here's how to apply an Office theme in Access 2010:
. Open the database you want to use in Access.
. Open the form or report to which you want to apply the theme.

a
2
3. Click the Home tab.
4

. Click Views, and choose either Design View or Layout View.
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5. Inthe contextual Design tab, click Themes in the Themes group.

6. Preview a theme by pointing to it; the report or form display shows you how the
theme will look when it is applied to your data.

7. Click the theme you want to use, and it is applied to the form or report.

Adding New Fields

New field features in Access 2010 enable you to reduce the amount of time you spend set-
ting common fields in your databases by using Quick Start fields, and they help you expand
your data processing power by adding calculated fields to your tables.

Adding Quick Start Fields

New Quick Start fields in Access 2010 enable you to add fields you use regularly to your
data tables with a simple click of the mouse. Instead of adding Address, City, State, ZIP, and
Country codes one by one, for example, you can click the Address Quick Start field to add
all the fields in one click. Access 2010 includes nine Quick Start fields by default: Address,
Category, Name, Payment Type, Phone, Priority, Start And End Dates, Status, and Tag.
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To add a Quick Start field to your data table, open the data table you want to use and click
to select the field to the right of the place you want to add the field. In the Table Tools Fields
tab, click More Fields in the Add & Delete group. Scroll down to the bottom of the list to find
the Quick Start fields, and click the one you want to add to the data table. (See Figure 11-4)
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FIGURE 11-4 Find the Quick Start fields in the More Fields list.

Each Quick Start field you add has preset field options already included. For example, when
you add the Payment Type Quick Start field, the added field includes Cash, Credit Card,
Check, In Kind, and Debit selections as part of the field. You can customize the field to in-
clude the selections you want by right-clicking the field and choosing Edit List Items. In the
Edit List Items dialog box (shown in Figure 11-5), you can modify, remaove, or add values to
the list by clicking and typing the new entry. Click OK to save your changes.

Tip What should you try first in Access 2010? Jeff Conrad, author of Microsoft Access 2010 Inside
Out (Microsoft Press, 2010), recommends these three things:

B Publish and share your database to Access Services, and view your forms and reports in a
Web browser.

Try the new navigation form to see how simple it makes creating a navigation system.

B Attach data macros to table events, and create named data macros to incorporate more
business logic in your data tables.
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FIGURE 11-5 You can easily edit the list items included in a Quick Start field.

Inserting Calculated Fields

Another new field feature in Access 2010 enables you to easily create and store calculations
that enable you to analyze your data. You can then apply the calculated field throughout
your database as needed. To add a calculated field to your data table, click More Fields in the
Add & Delete group of the Table Tools Fields tab. Then choose the field type for the type of
calculated field you want to create, and Access 2010 displays the Expression Builder dialog

box so that you can choose the elements, categories, and values to use in the calculation.
(See Figure 11-6.)
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[Field3)-[Field 10)

Expression Elements

£ 1ablel

\ 2
;) Functions

Expression Categories Expression Yalues

Constants
L0 Operators

FIGURE 11-6 Add calculated fields to your data table.

Tip You can change the expression you've used to create a calculated field by right-clicking the
field label in the data table and choosing Modify Expression. In the Expression Builder dialog
box, modify the calculation as needed and click OK.
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Showing Data Bars and Conditional Formatting

Not everyone can lock at a table full of data and know instantly what it means. Some of

us need a little help interpreting facts and figures in a table or on a report. For this reason,
Access 2010 includes data visualization features that enable you to include data visualizations
in your tables and reports that will help your readers understand what your data means.

Data bar visualizations are helpful when you want to compare data among the records

in your report. For example, if you want to compare the projected workshop with the
actual attendance data, you can let data bars show you where your marketing efforts were
successful and where they fell short. (See Figure 11-7)
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FIGURE 11-7 Data bars work with numeric fields, enabling you to visually contrast the data you're reporting.

Tip Conditional formatting is easier in Access 2010, thanks to the addition of the Conditional
Formatting Rules Manager. Now you can create new rules that specify conditions for the
conditional formats and preview the effects of your changes before you apply them.
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Creating Navigation Forms

When you're working with forms and reports in Access 2010, you can simply drag fields to
where you want them to create just the type of layout you want. Access 2010 also includes a
new Navigation Forms gallery, with a number of layouts you can customize to make it easy
for others to find the forms and reports they want to view in your database.

To create a navigation form, click the Create tab and choose Navigation in the Forms group.
(See Figure 11-8.) Click the navigation form layout you want to use, and then drag the re-
ports and forms you want to include from the All Access Objects pane to the navigation area
of the new form. Those reviewing your information will be able to click the name of the form
or report to display the data in the Access 2010 window.
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FIGURE 11-8 Use the Navigation gallery to choose the layout of the navigation form you want to create.

Designing Access 2010 Macros

Although the word macros might make your eyes glaze over if you're not interested in
automating the data logic and processing in your database, two improvements in Access
2010 offer good news to macro aficionados. First, new data macros enable you to add data
logic to the actual table of data rather than requiring you to work at a form level. And the
enhanced Macro Designer is now more intuitive than ever, providing a look and feel that

enables you to build macros easily by dragging items where you want them to appear and
arranging them in the proper sequence. (See Figure 11-9.)
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FIGURE 11-9 The improved Macro Designer in Access 2010 makes it easy for you to build macros by selecting
and dragging the items you need to the location you choose.

Working with Access 2010 and the Web

One of the major stories in Office 2010 is the ability to access your files—documents,
presentations, worksheets, notebooks, and databases—anywhere you have access to
the Web. Access 2010 enables you to create a Web database so that you can use it with
SharePoint Server 2010 to publish your entire database—including tables, forms, and
reports—and view it in a browser window.

Create a Web database by starting in Backstage view. Simply click File, choose New, click
Blank Web Database, and click Create. You can then create the database as usual, adding
data tables, forms, and reports. When you are ready to publish your database to the Web,
return to Backstage view by clicking File and then click Share. Choose Publish To Access
Services, and type the necessary information for the SharePoint site that will post the file.

Tip Before you post your database to the Web, be sure to run the Compatibility Checker to look
for any data items or settings that won't function properly online. The Compatibility Checker is
found in the Share page of Backstage view.
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Adding Web Controls

Another great Web feature included in Access 2010 makes it possible for you to incorporate
Web content in the database you are creating. This might enable you, for example, to
provide live access to Web 2.0 content from within your database.

Display the form on which you want to add the Web Browser control, and then, in the Home
tab, click View and then Layout View or Design View in the Views group. In the Controls
group, choose Web Browser, and then click and drag at the point you want the control to
appear. When you release the mouse button, the Insert Hyperlink dialog box appears so that
you can enter the Web page or choose the item you want to include in the Web Browser
control. After the element is added, you can resize the object as needed in the Access
window by simply dragging the corner or side of the object. (See Figure 11-10.)

@ Tip Now it is easier to add databases to your Trusted Documents list. When you open a
database created by someone else, a Message Bar appears at the top of the Access 2010 window.
Macros are automatically disabled until you indicate that the database is a Trusted Document. To
enable the full functionality of the database, click Enable Content.
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FIGURE 11-10 Incorporate Web content in your database using the Web Browser control in Access 2010.
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Using Access 2010 with SharePoint

If you work with SharePoint Server 2010, additional Web features are also available to you in
Access 2010. First, you can take a Web database into offline mode so that you can continue
to work on the data as needed; the next time you connect to the Web, any changes you
made to the offline data are automatically synchronized with the database on the server. You
can also synchronize your data manually by clicking File to display Backstage view, and in the
Info page, clicking Sync All.

You also have the ability to save your database to SharePoint Workspaces 2010 so that you
can access your data using your Web browser or smartphone.

Gathering Data with InfoPath 2010

Microsoft InfoPath is a forms-creation and data-gathering tool included with Office
2010 that helps you collect and consolidate the data you need and then share that data
with colleagues in a variety of ways. (See Figure 11-11)
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FIGURE 11-11 InfoPath offers a collection of templates you can use as the basis for your forms, or
you can begin with a blank form and create your own.
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InfoPath includes a variety of form templates you can use as the basis of the new forms
you create, or you can choose to start with a blank form and add the fields yourself.
InfoPath 2010 enables you to create professional forms by dragging fields where you
want them to be and arranging them in a way that makes sense for your data. You can
also add pictures and buttons to your forms, guarantee accuracy by running the Spell
Checker, include ScreenTips to prompt people filling out your forms, and share forms
easily using SharePoint Server 2010 and SharePoint Workspace 2010. Also, thanks to
integration with SharePoint Workspace 2010, users can complete the forms you create
online or offline.

InfoPath Filler makes it easy for users to open and complete the forms you create. You
set up the way you want users to submit completed forms by choosing to receive the
form by e-mail, have the data sent to a SharePaint library or SharePoint server, or use
Web services to gather the information. You can also include your InfoPath 2010 forms
in Outlook 2010 messages, which makes it possible for you to collect information by
e-mail and store it in the database or SharePoint library you specify.
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Next Steps with Office 2010

Now that you have explored the new features in each of the core Office 2010 applications,
this part of the book helps you answer the question, “What next?” Because Office 2010 is an
integrated suite of applications, you can use the programs together gracefully to get more
out of the files you create and share. This part also spotlights the security measures you'll
find in Office 2010 and introduces various ways you can learn more about the programs and
increase your own proficiency.

You'll find the following chapters in this closing part of First Look: Microsoft Office 2010:

B Chapter 12: Putting It All Together
B Chapter 13: Security in Office 2010
B Chapter 14: Training Made Easy
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Chapter 12

Putting It All Together

In this chapter:
B Using Excel 2010 Data with Word 2010
B Sharing SmartArt Among Office 2010 Applications
B Dragging Word 2010 Content to PowerPoint 2010
B Mail Merging Word 2010 Documents in Outlook 2010
B Sharing Access 2010 Data with Other Office Applications

B Scheduling a Meeting from a Shared Document

One of the great benefits of working with the Office 2010 suite is that no matter which
applications you use most often, they all have a similar look and feel. This means that even
if you use PowerPoint 2010 only when you need to make a presentation to the board, or
you use Publisher 2010 only when you need to create business cards, you can find your way
around the programs easily using the familiar Ribbon and Backstage view.

Office 2010 enables you to share your work among applications—and among colleagues—
more easily than ever before. A number of integrated features make it simple to use what
you create in one application seamlessly in another. That saves you time and effort, and it
guarantees consistency throughout your creations no matter what kinds of final files you
create and share. The examples in this chapter provide just a few of the ways you can share
your data among applications—take the time to discover how you can share what you create
in an application to get more from your work in Office 2010.

Using Excel 2010 Data with Word 2010

Once upon a time, to include worksheet data in your documents, you needed to create a
table and enter the values by hand. We've come a long way since those early days, thankfully,
and Paste with Live Preview makes it easy not only for you to copy and paste (or drag) your
worksheet information into your document, but to paste it just the way you want it—with or
without formatting. (See Figure 12-1.)
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FIGURE 12-1 Choose the way you want data to be pasted in your document.

The paste options provide you with a variety of choices that control the way the informa-
tion is inserted into the document. Table 12-1 explains the various paste options shown in
Figure 12-1.

TABLE 12-1 Paste options

Description

Pastes the copied information using the same formatting options
that were applied in the source document

Tool Name

Keep Source Formatting

Pastes the new information into the document using the styles
existing in the receiving document

Use Destination Styles

Preserves the formatting of the original document, but links the
data to the original file so that changes will be reflected in the
pasted information if you update the source document

[Z= Link & Keep Source
=a@ Formatting

== Link & Use Destination

=) Uses the style formatting in the receiving document by
155 Styles

maintaining a link to the original file so that the data is updated
if you change the original document

1 Picture Pastes the information as a picture object in the document

| Keep Text Only Pastes the data as text only, with no applied formatting
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Tip Inthe Paste Options list, you can click Set Default Paste to display the Advanced options and
specify the default pasting styles you want to use in the current application.

Sharing SmartArt Among Office 2010 Applications

@

SmartArt in Office 2010 has been enhanced to provide new support for pictures as well as

additional layouts for you to use in the different Office applications. More good news is

that you can create a SmartArt diagram once—

in, for example, Word 2010—and use the
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same diagram in Excel, PowerPoint, Outlook, OneNote, and even Access. Figure 12-2 shows
a drag operation where a SmartArt diagram is dragged from Word 2010 to an Excel 2010

worksheet.
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FIGURE 12-2 Drag SmartArt from Word to Excel.

Tip Youcan also save a SmartArt diagram as a picture in one of four formats (PNG, GIF, TIFF, or
WMP) so that you can easily post it in Web content, import it into a layout program, or use it in
any other application that works with standard graphics files. Note, however, that the picture file
you save will not have the interactive diagramming features that are available when you work
with the SmartArt diagram in your Office 2010 applications.
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Dragging Word 2010 Content to PowerPoint 2010

Depending on your creative style, you might be more comfortable drafting your ideas in
Word and then porting them into PowerPoint. You can easily create your outline, paragraphs,
or bulleted lists in a Word document and then drag it into PowerPoint. (See Figure 12-3)
Again, Paste with Live Preview comes into play.

After you place the content in PowerPoint 2010, you might still have some basic format-
ting to do to fit the right content on the right pages, but the process is much faster than
retyping the information you need. You can also drag notes from Word into the Notes area
of your PowerPoint slides and then print the notes pages (with text and slide images) from
within PowerPoint 2010.
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FIGURE 12-3 Drag an outline from Word to PowerPoint.
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Mail Merging Word 2010 Documents in Outlook 2010

Suppose that you want to send a new e-mail catalog list to all your customers. Rather than
beginning in Word 2010, drafting your document, and then connecting a contact list you
exported from Outlook 2010 and saved in Excel 2010, you can do the whole process in two
simple steps:

1. Create the document you want to send in Word 2010.

2. Mail merge the document with your Outlook contacts and send it via e-mail.

Nice, right? The new mail merge feature in Outlook 2010 enables you to easily create mail
merge projects you can use to send form letters, mailing labels, envelopes, and catalogs.
(See Figure 12-4)) To find the Outlock Mail Merge feature, click Contacts at the bottom of the
navigation pane on the left side of the Outlook 2010 window and then click Mail Merge in
the Actions group of the Home tab. The Mail Merge Contacts dialog box opens, offering you
a collection of options you can use to set up your merge.
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FIGURE 12-4 Use the Outlook Mail Merge feature to simplify mail merge projects.
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In the Document File area of the Mail Merge Contacts dialog box, you can create a new
document or choose Existing Document and click Browse to navigate to the document you
created in Word. Click Open to add the file to the Mail Merge Contacts dialog box, and, after
adding the contact data file, click OK to start the merge.

Sharing Access 2010 Data with Other Applications

Although the features that enable you to use Access data with other Office 2010 applica-
tions aren't new in this latest release, the program makes it easy for you to share your Access
data with files and messages you create in Excel 2010, Word 2010, Outlook 2010, and even
OneNote 2010. You'll find the tools you need in the External Data tab of the Access 2010
window. (See Figure 12-5.)

Save as Create a

text file PDF file Export to an Access database
@' =] = Dptabase? ; Database|(Access 2007) - Microsoft Access
Home Create External Data Database Tools Fields Table
:'_31 _'—\'2 |A_—-E] _E,:"‘j o rext File :U:j =e= il === === == LJ (B} Access = gl
= & ¢ A el & . e = ]
= & e 1= XL File %/ S s $H ea _Jerd Merge o=
Saved Excel Access ODEBC Saved  Excel Text HML PDF  E-mail Create Manage
Imports C Database & ;I More = Ewnorts File File orxps i More - E-mail Replies
Import & Link l Ecrum l Collect Data
Save Create Export Use as data
as anXML  as source for Word
Excel data e-mail mail merge

workbook file

FIGURE 12-5 Share Access 2010 data with Excel, Word, Outlook, and OneNote 2010.

You can easily use portions of your Access data in other applications as well. Suppose that
you're reviewing your customer database and you see that several customers haven't been
contacted in more than a year. You can make a note to yourself in your OneNote notebook
to follow up with those customers by simply dragging the highlighted names and e-mail
addresses to your To Do notebook. Or you can create a task in Outlook and assign the fol-
low-up calls to someone else on your team. By simply dragging the content, or cutting and
pasting it (using Paste with Live Preview), you can share the data in ways that enable you to
follow through on action items that might otherwise slip your mind.
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Scheduling a Meeting from a Shared Document

And of course one of the biggest stories in Office 2010 is the ability you now have to share
your files, in real time, from within core applications. For example, if you co-author a Word
document and notice that one of your ce-authors is working on the document while you're
editing it, you can send her a quick instant message to ask a question about the file.

To contact co-authors while you work on a document, click the File tab and then click Info in
Backstage view. In the Author area on the right side of the view, double-click the name of the
co-author you want to contact. The contact card appears, listing various ways you can reach
the co-author. (See Figure 12-6.)
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FIGURE 12-6 Contacting a co-author from within a shared document is a great new feature in Office 2010
applications.

When you click Schedule A Meeting, an Qutlook appointment window appears so that you
can schedule the time and the format for the meeting. You can set up a Live Meeting, sched-
ule a conference call, or invite your co-author to a face-to-face meeting at a location you
specify. (See Figure 12-7)
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FIGURE 12-7 Schedule a meeting on a shared document.

Meeting scheduling is of course just one aspect of the various ways you can communicate
with co-authors who share your documents. You also can send an instant message to anyone
on your team whose presence shows them to be available; you can launch a video call or
voice-over-Internet call (if your communications client allows this). And, when instant contact
isn't an option, you can always send an e-mail message.
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Security in Office 2010

In this chapter:
B Understanding Security in Office 2010
B Opening Files Safely
B Working with Protected View
B Password Protecting a File
B Limiting File Changes
B Setting Role-Based Permissions
B Recovering Unsaved Versions

B Working with the Trust Center

How many attached files do you receive via e-mail every day? How often do you open
documents sent to you by people you don't know? How many times in a week do you
forward files along to coworkers for review or correction? Do you regularly trade files with
others both inside and outside your organization?

This chapter introduces you to the security features in Office 2010. Today it's more important
than ever to ensure that the files you send and receive are secure, and for this reason, Office
2010 includes new security features that add layers of protection to the files you create and
share. Although much of the file checking that goes on is an invisible part of the process, you
can control many levels of protection in Office 2010 applications, specifying who you want to
have access to your files and what kinds of actions they can perform.

Understanding Security in Office 2010

Security in Office 2010 is focused on safeguarding your files, and Microsoft has accomplished
that by making Office 2010 more resilient to attack. Office 2010 has a new security workflow
with multiple layers that Office documents go through during the File Open process. This
whole security effort is designed to be invisible to you as a user, so you won't notice any
delays or dialog boxes when you open files you need to use.

165
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Opening Files Safely

One of the vulnerabilities in previous versions of Office occurred in the file-opening process
when a user went to open a file from a previous version of an Office application. Because
hackers often design malicious files that masquerade as previous file types, this left user files
unprotected when users worked with legacy formats.

The first line of Office 2010 defense includes a new Open File Validation process that checks
to ensure files from previous versions of Office match the required format before the files will
open. This process occurs behind the scenes, but you can open files confidently knowing that
if the files open, they've already passed the Office validation check. If the system finds any-
thing that poses a risk—perhaps an unrecognized file format—the system prompts you with
a Protected View message at the top of the document window. (See Figure 13-1.)

IE: H9-0|= FirstLook_ch03_final (2) (Protected Wiew) - Microsoft Word (Technical Preview) o B 2
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-
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FIGURE 13-1 Protected View lets you know that the file is potentially unsafe.

The Open File Validation process now checks every file to validate the legitimacy of the file
type before the file will open in your Word, Excel, or PowerPoint window. This process is
transparent to you—you won't experience any delays in opening files or have to interact with
any dialog boxes in the process.
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If you choose, however, you can specify how you want the various applications to handle the
files as they go through the Open File Validation process. You can display the File Blocking
settings by clicking the Click For More Details link in the Message Bar when Protected View

displays a message, or you can follow these steps to open the Trust Center and display the
File Blocking settings in your current application:

Click the File tab.

In Backstage view, click Options.

1.
2.
3. In the Options dialog box, click the Trust Center category.
4. Click the Trust Center Settings button.

5.

In the Trust Center, click the File Block Settings category. The File Block Settings window
appears, as shown in Figure 13-2.
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File Type Open Save
Add-ins T
‘Word 2007 and later Documents and Templates 1 |l
ActiveX Settings OpenDocument Text Files A )
Word 2007 and Ister Binary Documents and Templates s ]
Macro Settings . .
Ward 2003 Binary Documents and Templates m
Protected View Word 2003 and Plain XML Documents (& [}
‘Word XP Binary Documents and Templates A
Message Bar -
Word 2000 Binary Documents and Templates I}
File Block Settings Bl wWord 97 Binary Documents and Templates B
Word 95 Binary Documents and Templates ¥l
Privacy Oiptions i e
Word 6.0 Binary Documents snd Templates ¥
Wotd 2 and earlier Binary Documents and Templates il
Wieb Pages [} (]
RITF Files = B
Plain Text Files B B
Legacy Converters for Word A B
Office Open XML Converters for Word H B
Open behavior for selected file bypes:
) Do not open selected file types
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*) Open selected file types in Protected Yiew and allow editing
Restore Defaults ]

FIGURE 13-2 You can tailor the way applications open files from different formats.

By default, the file types with no check marks are opened in the application; they are not
blocked or displayed in Protected view. The action selected in the Open Behavior For
Selected File Types list that appears below the file types shows you what action is taken if a
file type is selected. Table 13-1 explains a little more about each of these behaviors.
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TABLE 13-1 File block behaviors

Setting Description
Do Not Open Selected File Types The selected files are blocked and will not be
opened.

Open Selected File Types In Protected View The selected file is opened in a safe mode that is
protected from other files and processes.

Open Selected File Types In Protected View The selected file type is opened in safe mode, but
And Allow Editing the user is allowed to edit as normal.

Working with Protected View

When you see the Protected View message in your application window, the file you tried
to open has either been blocked or has been determined to be in a file format flagged for
blocking. If you still want to see what's in the file or find out if it is from a source you trust,
you can open the file in Protected View.

Protected View is a safe mode that enables you to display a read-only view of the document.
The file is opened in a protected space called a sandbox, where the file cannot affect your
other files or system data. After you determine that the file is acceptable, you can click Enable
Editing to open the file normally.

You also can change the way Protected View is used when questionable files are opened. The
settings for Protected View are available in the Protected View category in the Trust Center.
(See Figure 13-3))
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ActiveX Settings |i Enable Protected View ror Tiles 10Czted in potentially unsare 10Cationg

[#] Enable Frotected Yiew for Cutlook attschments
Mzcr Settings
Proterted e Data Execulion Prevention

Message Bar [#] Enable Data Execubion Prevention mode (&)
File Block semtings

Pritacy Cptions

[ cancel

FIGURE 13-3 You can change the Protected View settings used to protect your computer.
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Password Protecting a File

169

Although you've been able to add passwords to your Word, Excel, and PowerPoint files for a
while, in Office 2010 the password encryption rules have been changed to account for pass-
word strength as well. You set an encrypted password for your file using Backstage view, as

you see in Figure 13-4.

Tip You can also set the password during the Save As process by clicking the Tools button,
choosing General Options, and typing the password required to open the file. If you plan to

share the file with others, you can type a separate password that you share with co-authors to

enable modification and file sharing.
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FIGURE 13-4 You can set an encrypted password for your document.
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Note that when you set an encrypted password for your Word, Excel, or PowerPoint file, the
password cannot be recovered if you forget the password later. For this reason, you should
keep a copy of your passwords in a safe place you can access easily.
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Limiting File Changes

In addition to ensuring the files you open and work with are trustworthy, you also need to be
able to set parameters for the types of modifications that can be made to the file by others
who work with the file as well. Each of the Office 2010 applications includes protection fea-

tures that enable you to set safeguards at the file level. You'll find all the protection features
in Backstage view, in the Info category.

Excel 2010 enables you to set several levels of protection for the current worksheet. In the

Info category of Backstage view, you can choose one of the following options to limit the
changes that can be made to the file:

B Protect Current Sheet displays the Protect Sheet dialog box, which enables you
to create a password other users must enter in order to modify the worksheet.
Additionally, you can choose the actions you want to allow users to complete, such as
format cells, insert columns, and delete rows. (See Figure 13-5)

B Protect Workbook Structure lets you safeguard the structure of the workbook—or the
Excel window—by prohibiting others from adding new worksheets, for example.

ProtectSheet
[J] Protect worksheet and contents of locked cels

Password to unprotect sheet;

allow all users of this worksheet to:
[EdSelect locked cells
|¥|Select unlocked cells
[ | Format cells
[ | Format columns

| Format rows
|| Insert columns
|| Insert rows
[ Insert hyperinks
[ Delete columns
|| Delete rows -

FIGURE 13-5 Excel 2010 enables you to limit the changes you want other users to make in the file.

»

m

Word 2010 offers several levels of restrictions that enable you to set the level of changes that
can be made in a specific document. (See Figure 13-6.) These features, which were also part
of Word 2007, allow you to limit others' changes in the following ways:

B Formatting restrictions limit users to changing styles used in the document.

B Editing restrictions enable you to specify whether you want users to view the file as

read-only, or whether you will allow them to enter tracked changes, enter comments,
or complete forms.

In addition to these two main restrictions, Word 2010 enables you to choose the parts of the
document and indicate which users have the necessary permissions to edit those parts.
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FIGURE 13-6 Word 2010 file protection enables you to block or restrict editing by type of task or by person.

PowerPoint enables you to restrict others’ ability to copy, edit, or print content in
your PowerPoint presentation. You can also mark a file as final so that others can view—but
not modify—the file.

@ Tip Word, Excel, and PowerPoint all give you the option of adding a digital signature to your
document to verify a document’s integrity. The digital signature feature in each of these applica-
tions requires a signature service from a third-party vendor. You can begin the process by click-
ing the Add A Digital Signature option in the Protect selection of the Info tab, and a prompt will
offer you the option of finding a signature service online.

Setting Role-Based Permissions

Another way to limit the access others have to your documents is to restrict permissions

by role. The Restrict Permission By People option in the Protect settings in the Info tab (in
Backstage view) of Word, Excel, and PowerPoint enable you to choose the group of people
who you want to give access to your document. For example, in Figure 13-7, Unrestricted
Access is still applied to the current file, but you can choose another setting to connect to
your organization'’s rights management system, which defines the roles and permissions in
your system. By default, choosing one of these options displays the introductory page of
Information Rights Management, which is a free service from Microsoft that enables you to
authenticate the credentials of others who work with your files.
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FIGURE 13-7 You can set multiple levels of protection in your files, including restricting permissions to a file.

Recovering Unsaved Versions

O

The process of retrieving unsaved copies of recent files might not be a security issue in terms
of defending against data loss or attack, but having the ability to easily retrieve these copies
can help you avoid a major headache if you forgot to save a file with business-critical data.
Now Office 2010 applications enable you to recover unsaved versions of files you've worked
on and retrieve the information you need.

You can find the recovered versions in Backstage view, in the Info category. Click Manage
Versions to display the list of options. (See Figure 13-8.) Click Recover Draft Versions to
display the Open dialog box, which lists any available previous versions of the file.

Tip You can also display unsaved documents from the Recent category. Scroll to the bottom of
the Recent Documents list, and click Recover Unsaved Documents. Double-click the file you want
to view in the Open dialog box.
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FIGURE 13-8 You can recover unsaved drafts and work with versions in Backstage view.

Working with the Trust Center

The Office Trust Center was introduced in Office 2007 and has been expanded and improved
in Office 2010. The Trust Center enables you to choose your specifications for the way in
which files are opened, shared, and protected, and it enables you to create lists of trusted
publishers, documents, and locations that don't have to be authenticated each time you
receive a document from them.

Display the Trust Center by choosing File and selecting Options in Backstage view. In the
Options window, click Trust Center at the bottom of the category list, and click the Trust
Center Settings button. (See Figure 13-9) Table 13-2 lists each of the categories in the Trust
Center and explains how you can use those options to safeguard your files.
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FIGURE 13-9 Displaying Trust Center settings.

TABLE 13-2 Office 2010 Trust Center

Category
Trusted Publishers

Description

Enables you to create a list of publishers you trust so that any content
you receive from the publisher is opened freely without restriction.

Trusted Locations

Trusted Documents

Gives you the ability to create a list of trustworthy locations—for
example, shared folders and SharePoint workspaces.

Creates a list of documents you have specified as trusted. After a
document is marked as trusted, macros and all content is enabled
automatically.

Add-ins

ActiveX Settings

Enables you to specify whether any application add-ins must be signed
by a trusted publisher.

Lets you choose whether ActiveX controls will be allowed to play in
regular mare or in safe mode. You also set the level of restriction for the
running of the controls.

Macro Settings

Protected View

Sets whether macros are automatically disabled or enabled.

Enables you to choose the situations in which Protected View is used.




Category Description

Message Bar Lets you show or hide the Message Bar.

File Block Settings Gives you the ability to choose whether specific file types are blocked
from being open or saved.

Privacy Options Lets you set privacy options for the current file, run the Document
Inspector, and set translation and research options.

By default, Office 2010 is set to provide a safe, reliable experience for you as you open

and share the files you create. For most settings—including ActiveX Settings and Macro
Settings—leaving the options set to the optimal level will ensure better protection for your
files and system.






Chapter 14

Training Made Easy

In this chapter:
B Getting Help in Office 2010
B Finding What You Need on Office Online
B Take Your Learning to the Next Level with Microsoft eLearning

®  Continue Learning with Microsoft Press Books

Now that you know about all the new and improved features you'll find throughout
Office 2010, your next step is to begin working with the program, exploring your favor-
ite applications, creating new documents and presentations, and sharing what you create.
As your experience with the program grows, you might want to learn about the specific
applications in greater detail.

Whether you learn best fram books, articles, or online courses, you'll find that many
resources are available to help you learn more about Office 2010. This chapter gives you a
quick introduction to a few Help changes in Office 2010 and introduces several of the key
resources available that will help you expand your Office 2010 experience.

Getting Help in Office 2010

As you get to know the various Office 2010 applications, you'll notice right away that the
familiar tooltips are still there to help you learn about the tools and window elements.

(See Figure 14-1.) The Office 2010 Help button is also in the same place it occupied in earlier
versions of the program—on the far right side of the screen, just above the Ribbon.

The Help tab in Backstage view is a new feature that brings together all your program
information into one convenient window. In the Help window, you'll find information that
will help you get product information, access program help, and find what you need to get
technical support. (See Figure 14-2)
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FIGURE 14-1 Tooltips provide you with information about specific elements in Office 2010 application
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FIGURE 14-2 The Help tab in Backstage view enables you to get support, access help, and find program
information.
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You can use the information in the Help tab of Backstage view to do the following things:

B Activate your software.

B Take a tour of basic program features.

B Check for program updates.

m Search for information in Microsoft Office help.
B Change program options.

m Contact Microsoft Support.

The product information in the right side of the Help window shows you all the programs
you have activated, and it also lists any software you are currently using for a specific trial
period. This information will be helpful if you need to call technical support at some point
and will help the technician diagnose any problems you are having with the software.

Tip If you miss the good, old-fashioned About window that was available in previous versions of
Office, you can display it by clicking Additional Version And Copyright Information on the right
side of the Help tab in Backstage view.

Whether you click Microsoft Office Help in the Help tab to display the Help system or you
click the Help button in the right side of the application window, the results are the same: the
Help window appears. (See Figure 14-3.) Using the Help system is a simple process. It's similar
in appearance to previous versions, but the Office 2010 Help system pulls information from
www.office.com, so you always have access to the most recent help information.

You can enter a word or phrase in the search box or click a category that reflects what you
want. The Help window lists specific articles that relate to your selection. Click the item you
want to view and, after reading it, answer the question “Was this information helpful?” by
clicking Yes, No, or | Don't Know. A comment box appears so that you can add a note about
your experience.

Tip Microsoft does use the information you enter to make changes in the Help system, so if you
have a suggestion about how the help system can be improved, share it.
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FIGURE 14-3 The Office 2010 Help system connects automatically to Office.com so that you have access to
the most recent help articles available.

Finding What You Need on Office Online

Another great resource—whether you want to complete online tutorials or download tem-
plates, clip art, or presentations for training—is Office Online. (See Figure 14-4.) In April 2009
alone, more than 131 million unique users visited Office Online (www.office.microsoft.com),
downloading more than 500,000 training presentations and logging more than 4 million
visits to the training center.
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FIGURE 14-4 Office Online offers a variety of downloads, tutorials, articles, and links to additional resources
and partner sites.

On Office Online, you can do the following:

B Find information about each of the Office 2010 applications.
B Visit resource centers for small business or home users.

B Take a tour of key Office 2010 features.

B Check for available updates for your Office 2010 programs.
B |earn about the different Office 2010 suites and servers.

B Find Webcasts, podcasts, demonstrations, and more information related to the
Office 2010 applications.

B Get links to Microsoft Office product support.

B Download templates, service packs, clip art, and more.
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Take Your Learning to the Next Level with
Microsoft eLearning

When you're ready to take your learning to the next level by exploring applications in depth,
you can take any one of a number of online learning courses at Microsoft eLearning
(www.microsoft.com/learning). These online learning courses give you a convenient way to
work at your own pace, prepare for an exam, and earn certifications.

Some of the learning courses are clinics that offer interactive games and self-tests, demon-
strations, and hands-on virtual labs. You can create your own learning plan with Microsoft
elearning and save the courses in a queue to complete as you have time. Courses can be
completed online or downloaded (with a free downloadable viewer) so that you can com-
plete them offline on your own computer. (See Figure 14-5)) At the time of this writing, new
courses are planned for Microsoft eLearning that provide an overview of Office 2010 and
walk you through key features in a number of the core applications.

Microsoft |Lear.‘|ing

7

Introduction to Enhancements in Microsoft Dffice Communications Server 2007 R2

¥ 4 Clinic Overvigw
Wodule Tip Module Introduction

4 Navigation Overvisw ! ) )
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4 Clinic Information
Clinic Information
Introduckion ko Enhancements in

Microsoft Office Communications
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Clienks and Devices in Office
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2007 R2

Features of Conferencing in
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Server 2007 R2

. Enhancements in Mobiity

" and Office Commuricator
‘Web Access 2007 R2

_ New Features of Yoice in

" Office Communicstions
Server 2007 R2

Module Summary

» Glossary

Dene

FIGURE 14-5 Microsoft eLearning offers more than 1000 online learning courses that can help you learn

@ “~__ Transeript -

rmay affect your productivity. To help you manage your communications effectively, Office
Communications Server 2007 has introduced new dlients such as Microsoft Office
Communications Server 2007 R2 Attendant that can help you handle a large volume of calls,
Moreaver, enhancements such as desktop sharing that allows you to share your entire deskiop
and programs, and improvements in audio, video, and Web conferencing help you collaborate
better.

Some of the main improvements in mobility have been the Single Number Reach feature that
helps you stay connected through & single number and support for Java clients. Microsoft Office
Communicator Web Access 2007 R2Z now includes new features such as customization and audio
conferencing capabilities, Additionally, new call management features such as call delegation
provide better call handling and call routing facilities,

Module Objectives

After cormpleting this moduls, you will be able ta:

Describe the new features in Office Communications Server 2007 R2Z clients and devices.
Describe the new features in conferencing in Office Communications Server 2007 R2.
Describe the enhancements in mobility and Office Cormmunicator Web Access 2007 RZ in
Office Communications Server 2007 RZ.

Describe the new features of voice in Office Communications Server 2007 R2,
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more about applications and prepare for projects and certification.
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Continue Learning with Microsoft Press Books

In addition to the online and in-program offerings you can use to learn more about Office
2010, you'll find a number of great books that can help you master the various applications.
Whether you're a new, experienced, or expert user, chances are that Microsoft Press pub-
lishes a book that will speak to you. Here's a list of the upcoming Office 2010 books that will
be available after the launch of Office 2010:

Office 2010

Microsoft Office 2010 Plain & Simple

Microsoft Office 2010 Step by Step

Microsoft Office 2010 Inside Out

Microsoft Office 2010 Step by Step Home & Student

Access 2010

Microsoft Office Access 2010 Step by Step
Microsoft Office Access 2010 Inside Out

Excel 2010
Microsoft Office Excel 2010: Data Analysis and Business Modeling
Microsoft Office Excel 2010 Inside Out
Microsoft Office Excel 2010 Step by Step
Microsoft Office Excel 2010 Plain & Simple

PowerPoint 2010
Microsoft Office PowerPoint 2010 Step by Step
Microsoft Office PowerPoint 2010 Plain & Simple
Beyond Bullet Points: Using Microsoft Office PowerPoint 2010 to Create Presentations That Inform, Motivate, and Inspire

Project 2010

Microsoft Office Project 2010 Inside Out
Microsoft Office Project 2010 Step by Step

Outlook 2010

Microsoft Office Outlook 2010 and OCS Inside Out
Microsoft Office Outlook 2010 and LiveMeeting Step by Step

Microsoft Office Outlook 2010 Plain & Simple
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SharePoint 2010

Microsoft Office SharePoint 2010 Inside Out

Microsoft Office SharePoint Designer 2010

Microsoft Office SharePoint 2010 Step by Step

Microsoft Office SharePoint Designer 2010 Step by Step
Word 2010

Microsoft Office Word 2010 Step by Step

Microsoft Office Word 2010 Plain & Simple

Micresoft Office Word 2010 Inside Out

Visio 2010

Microsoft Office Visio 2010 Step by Step
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Katherine Murray has been writing about technology since the mid-1980s, which means she’s
seen a lot of menu bars, nested dialog boxes, and new user interfaces over the years. A big
fan of the changes in Office 2007, Katherine was excited to learn about the new directions

in Office 2010 that enable her to write in coffee shops, access her chapters via the Web, and
trade notes with editors in real time. Katherine has written more than 50 books about tech-
nology since 1988 and specializes in Microsoft Office technologies, but she's fascinated by
any technology that enhances the way we communicate and work together.



More Resources For

Office 2010

Microsoft Learning provides a wealth of resources for every learning style—whether
self-study, interactive, or classroom. As we get closer and closer to the release of Microsoft®
Office 2010, we will continue adding learning resources to our site to help you get ready:

microsoft.com/learning/en/us/training/office.aspx

Check back often to see our newest offerings!

Official Microsoft E-Learning

If you learn best independently, Official Microsoft
E-Learning courses provide a convenient and
effective way to learn online, anytime.

Coming soon:

* What's New in Microsoft Office 2010

* What's New in Microsoft Excel= 2010

* What's New in Microsoft Outlook® 2010
* What's New in Microsoft Word 2010

* What's New in Microsoft PowerPoint® 2010

To see our full catalog, click here.

Or select "E-Learning” from the "Training Options”

available at: learning.microsoft.com

Microsoft Press® Books

Microsoft Press will publish books covering Microsoft
Office programs and suites in our three most popular
series. Choose the right one for you:

Plain & Simple
For beginners and visual learners. Your easy, colorful,
SEE-HOW guide!

Step by Step

For beginning to intermediate users. The smart way
to learn and practice the skills you need—one step
at a time! Includes ready-to-use sample files.

Inside Out

For intermediate to advanced users. Hundreds of
timesaving solutions, troubleshooting tips, and
workarounds. Conquer your software—from the
inside out!

microsoft.com/mspress
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